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About the Documentation

IN THIS SECTION

Documentation and Release Notes | xi

Documentation Conventions | xi

Documentation Feedback | xiv

Requesting Technical Support | xiv

Use this guide to configure Policy Enforcer component of Junos Space Security Director. Policy Enforcer
integrates with Sky ATP to provide centralized threat management and monitors your software-defined
secure network.

Documentation and Release Notes

To obtain the most current version of all Juniper Networks® technical documentation, see the product
documentation page on the Juniper Networks website at https://www.juniper.net/documentation/.

If the information in the latest release notes differs from the information in the documentation, follow the
product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject matter experts.
These books go beyond the technical documentation to explore the nuances of network architecture,
deployment, and administration. The current list can be viewed at https://www.juniper.net/books.

Documentation Conventions

Table 1 on page xii defines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware
damage.

Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page xii defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type
the configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms

No alarms currently active

Represents output that appears on
the terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997, BGP Communities
Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft
titles.

Italic text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

Configure the machine’s domain
name:

[edit]
root@# set system domain-name

domain-name

Represents variables (options for
which you substitute a value) in
commands or configuration
statements.

Italic text like this

• To configure a stub area, include
the stub statement at the [edit
protocols ospf area area-id]
hierarchy level.

• The console port is labeled
CONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configuration hierarchy
levels; or labels on routing platform
components.

Text like this

stub <default-metric metric>;Encloses optional keywords or
variables.

< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between the
mutually exclusive keywords or
variables on either side of the symbol.
The set of choices is often enclosed
in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamic MPLS
only

Indicates a comment specified on the
same line as the configuration
statement to which it applies.

# (pound sign)

community name members [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Represents graphical user interface
(GUI) items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of
menu selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback so that we can improve our documentation. You can use either
of the following methods:

• Online feedback system—Click TechLibrary Feedback, on the lower right of any page on the Juniper
Networks TechLibrary site, and do one of the following:

• Click the thumbs-up icon if the information on the page was helpful to you.

• Click the thumbs-down icon if the information on the page was not helpful to you or if you have
suggestions for improvement, and use the pop-up form to provide feedback.

• E-mail—Send your comments to techpubs-comments@juniper.net. Include the document or topic name,
URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical Assistance Center (JTAC).
If you are a customer with an active Juniper Care or Partner Support Services support contract, or are
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covered under warranty, and need post-sales technical support, you can access our tools and resources
online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies, review the JTACUser
Guide located at https://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Productwarranties—For productwarranty information, visit https://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day, 7 days a week,
365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online self-service portal called
the Customer Support Center (CSC) that provides you with the following features:

• Find CSC offerings: https://www.juniper.net/customers/support/

• Search for known bugs: https://prsearch.juniper.net/

• Find product documentation: https://www.juniper.net/documentation/

• Find solutions and answer questions using our Knowledge Base: https://kb.juniper.net/

• Download the latest versions of software and review release notes:
https://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:
https://kb.juniper.net/InfoCenter/

• Join and participate in the Juniper Networks Community Forum:
https://www.juniper.net/company/communities/

• Create a service request online: https://myjuniper.juniper.net

To verify service entitlement by product serial number, use our Serial Number Entitlement (SNE) Tool:
https://entitlementsearch.juniper.net/entitlementsearch/

Creating a Service Request with JTAC

You can create a service request with JTAC on the Web or by telephone.

• Visit https://myjuniper.juniper.net.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see
https://support.juniper.net/support/requesting-support/.
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Juniper Networks Connected Security Overview

The Juniper Networks Connected Security provides end-to-end network visibility, allowing enterprises to
secure their entire network, both physical and virtual. Using threat detection and policy enforcement, an
Juniper Connected Security solution automates and centrally manages security in a multi-vendor
environment.

The Juniper Connected Security solution is comprised of the following components:

• A threat detection engine—Cloud-based Sky ATP detects known and unknownmalware. Known threats
are detected using feed information from a variety of sources, including command control server and
GeoIP. Unknown threats are identified using various methods such as sandboxing, machine learning,
and threat deception.

• Centralized policy management—Junos Space Security Director, which alsomanages SRX Series devices,
provides the management interface for the Juniper Connected Security solution called Policy Enforcer.
Policy Enforcer communicateswith Juniper Networks devices and third-party devices across the network,
globally enforcing security policies and consolidating threat intelligence from different sources. With
monitoring capabilities, it can also act as a sensor, providing visibility for intra- and inter-network
communications.

• Expansive policy enforcement—In a multi-vendor enterprise, Juniper Connected Security enforces
security across Juniper Networks devices, cloud-based solutions, and third-party devices. By
communicating with all enforcement points, Juniper Connected Security can quickly block or quarantine
threat, preventing the spread of bi-lateral attacks within the network.

• User intent-based policies—Create policies according to logical business structures such as users, user
groups, geographical locations, sites, tenants, applications, or threat risks. This allows network devices
(switches, routers, firewalls and other security devices) to share information, resources, andwhen threats
are detected, remediation actions within the network.

With user intent-based policies, you manage clients based on business objectives or user and group
profiles. The following are two examples of a user intent policy:

• Quarantine users in HR in Sunnyvale when they’re infected with malware that has a threat score
greater than 7.

• Block any user inMarketing when they contact a Command and Control (C&C) server that has a threat
score greater than 6 and then send an e-mail to an IT administrator.

Using user intent-based policies allows network devices (switches, routers, firewalls and other security
devices) to share information, resources, and when threats are detected, remediation actions within the
network.

Unlike rule-based policies, which can contain several rules, you can define only one set of parameters
for each user intent-based policy defined on a device.
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Benefits of Juniper Networks Connected Security

• Management and visibility - Enables you to view traffic across the network, dynamically deploy security
policies and block threats. Juniper Connected Security manages the entire network infrastructure as a
single enforcement domain, thereby providing enforcement points across the network. Uses machine
learning and datamining tools to offer effective threat management while producing detailed data access
and user activity reports.

• Comprehensive security - Ensures that the same security policies are applied across all of the devices
in the network. It extends security to each layer of the network, including routers, switches, and firewalls.

• Protection from advanced malware - Provides automated offense identification and consolidates the
threat intelligence with threat hunting activities to simplify and focus attention on the highest priority
offenses.

• Automated policy or enforcement orchestration - Provides real-time feedback between the security
firewalls. Reduces the risk of compromise and human error by allowing you to focus on maximizing
security and accelerating operations with a simple, concise rule set.

• Scalability - Supports up to 15,000 devices.

• Third-party integration - Provides APIs to integrate with the ecosystem partners for capabilities such
as cloud access security, network access control, and endpoint protection, and additional threat intelligence
feeds.

RELATED DOCUMENTATION

Understanding Juniper Connected Security for VMware NSX Integration (Micro-segmentation via vSRX
Integration with NSX Manager and Junos Space Security Director)

Policy Enforcer Overview | 18

Policy Enforcer Components and Dependencies | 27

Policy Enforcer Overview

Policy Enforcer, a component of the Junos Space Security Director user interface, integrates with Sky ATP
to provide centralized threat management and monitoring to your Juniper connected security network,
giving you the ability to combine threat intelligence from different solutions and act on that intelligence
from one management point.

It also automates the enforcement of security policies across the network and quarantines infected
endpoints to prevent threats across firewalls and switches. Working with Sky ATP, it protects against

18



perimeter-oriented threats as well as threats within the network. For example, if a user downloads a file
from the Internet and that file passes through an SRX Series firewall, the file can be sent to the Sky ATP
cloud for malware inspection. If the file is determined to be malware, Policy Enforcer identifies the IP
address and MAC address of the host that downloaded the file. Based on a user-defined policy, that host
can be put into a quarantine VLAN or blocked from accessing the Internet.

Figure 1 on page 19 illustrates the flow diagram of Policy Enforcer over a traditional SRX Series
configuration.

Figure 1: Comparing Traditional SRX Customers to Policy Enforcer Customers
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Supported Topologies

Policy Enforcer supports the following topologies:

• Client to Layer 2 switch to Layer 3 SRX (IRB)

• Client to Layer 2 switch to Layer 3 switch (IRB)

• Client to Layer 2/Layer 3 switch (IRB)

RELATED DOCUMENTATION

Juniper Networks Connected Security Overview | 17

Policy Enforcer Components and Dependencies | 27

Policy Enforcer Configuration Concepts | 32

Sky ATP Overview | 23

Policy Enforcer Installation Overview | 43

Using Guided Setup for Sky ATP with Juniper Connected Security | 141

Using Guided Setup for Sky ATP | 148

Benefits of Policy Enforcer

Most enterprise computer security revolves around creating awall around the perimeter of an organization.
See Figure 2 on page 21.

20



Figure 2: Perimeter-Defined Security Model

With this perimeter oriented security, networks are built with an inherently trusted model where the
applications or users connecting to a network (for example, VLAN) can fundamentally talk to each other
and network security solutions like firewalls and Intrusion Prevention Systems (IPS) are deployed in the
perimeter to provide security. Firewalls are often configured with all possible rules in an effort to prevent
unknown malware, application and network attacks from penetrating the enterprise. This architecture is
based on amodel where it is assumed that “Everything already inside the network is fundamentally trusted”
and “Everything outside the network is untrusted” so the perimeter is the location where all security
controls are deployed.

This architecture is consistent across data centers, and campus and branch configurations. Unfortunately,
there are flaws to this security architecture. They don’t help in protecting against internal threats. Despite
the popularity of firewalls, the sophistication of applications and malware in recent years has found a way
to circumvent perimeter defenses. Once inside the enterprise, these threats can easily spread; where
someone’s infected laptop or desktop couldmake Enterprise networks a botnet army and become a source
of internal and external attacks. Enterprises can protect against internal threats by deploying multiple
layers of firewalls, but that requires careful planning since it is difficult to take all internal traffic through
a separate layer of firewalls.

The security framework become a highly fragmented approach due tomultiple administrators, management
systems and reliance on a lot of manual coordination among different administrators and systems:

• There is a network security team that manages security policies on perimeter firewalls primarily to
manage external threats.

• There is a network operations team, that typically manages security policies by using network and
application isolation to protect against internal attacks and unauthorized access.

• Then there is third team, an IT team, that manages end-points such as laptops, desktops and application
servers to make sure that they have the correct security posture.
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In contrast, Policy Enforcer and Juniper Connected Security, see Figure 3 on page 22, simplifies network
security by providing protection based on logical policies and not security devices. Policy Enforcer does
provide perimeter security, but it’s no longer just protecting the inside from the outside. The fact that
somebody is connected to the internal network does not mean that they can get unrestricted access to
the network. This model is fundamentally more secure because even if one application on the network is
compromised, companies can limit the spread of that infection/threat to other potentially more critical
assets inside the network.

Figure 3: Policy Enforcer and Juniper Connected Security

Policy Enforcer is a model where the information security is controlled and managed by security software.
New devices are automatically covered by security policies, instead of having to identify it’s IP address as
with other models. Because it’s software-defined, environments can be moved without affecting security
policies and controls already in place. Other advantages include:

• Better and more detailed security—By providing better visibility into network activity, you can respond
faster to cyber threats and other security incidents. Threats can be detected faster by leveraging threat
intelligence from multiple sources (including third-party feeds) and the cloud. A central control lets you
analyze security challenges without interfering with standard network activity and to distribute security
policies throughout your organization. For example, you can selectively block malicious traffic while
allowing normal traffic flow.

• Scalability and cost savings—A software-based model allows you to quickly and easily scale security up
or down based on your immediate needs all without having to add or subtract hardware that is expensive
to buy and maintain.

• Simpler solution—Hardware security architectures can be complex due to the servers and specialized
physical devices that are required. In a software model, security is based on policies. Information can be
protected anywhere it resides without depending on its physical location.
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RELATED DOCUMENTATION

Policy Enforcer Overview | 18

Sky ATP Overview | 23

Using Guided Setup for Sky ATP with Juniper Connected Security | 141

Using Guided Setup for Sky ATP | 148

Configuring Sky ATP with Juniper Connected Security (Without Guided Setup) Overview | 157

Sky ATP Overview

Sky ATP is a cloud-based solution that integrates with Policy Enforcer. Cloud environments are flexible
and scalable, shared environments. They can help ensure that everyone attached to the cloud can benefit
from new threat intelligence in near real-time. Your sensitive data is secured even though it is in a
cloud(shared) environment. Security administrators can update their defenses when new attack techniques
are discovered and distribute the threat intelligence with very little delay.

Sky ATP offers the following features:

• Communicates with firewalls and switches to simplify threat prevention policy deployment and enhance
the anti-threat capabilities of the network.

• Delivers protection against “zero-day” threats using a combination of tools to provide robust coverage
against sophisticated, evasive threats.

• Checks inbound and outbound traffic with policy enhancements that allow users to stop malware,
quarantine infected systems, prevent data exfiltration, and disrupt lateral threat movement.

• Provides deep inspection, actionable reporting, and inline malware blocking.

• Provides feeds for GeoIP, C&C, allowlist and blocklist, infection hosts, custom configured feeds and file
submission.

Figure 4 on page 24 lists the Sky ATP components.
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Figure 4: Sky ATP Components

Table 3 on page 24 briefly describes each Sky ATP component’s operation.

Table 3: Sky ATP Components

OperationComponent

C&C feeds are essentially a list of servers that are known command and control
for botnets. The list also includes servers that are known sources for malware
downloads. See “Command and Control Servers Overview” on page 290.

Command and control (C&C) cloud
feeds

GeoIP feeds is an up-to-date mapping of IP addresses to geographical regions.
This gives you the ability to filter traffic to and from specific geographies in
the world.

GeoIP cloud feeds

Infected hosts indicate local devices that are potentially compromised because
they appear to be part of a C&C network or exhibit other symptoms. See
“Infected Hosts Overview” on page 288.

Infected host cloud feeds

Lists you customize by adding IP addresses, domains, and URLs to your own
lists. See “Custom Feed Sources Overview” on page 240.

Custom Feeds

An allowlist is simply a list of known IP addresses that you trust and a blocklist
is a list that you do not trust.

Allowlist and blocklists
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Table 3: Sky ATP Components (continued)

OperationComponent

Performs malware analysis and threat detection.Malware inspection pipeline

Inspects files, metadata, and other information.Internal compromise detection

RELATED DOCUMENTATION

Sky ATP Realm Overview | 190

Using Guided Setup for Sky ATP | 148

Configuring Sky ATP (No Juniper Connected Security and No Guided Setup) Overview | 189
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Policy Enforcer Components and Dependencies

The Policy Enforcer management interface is a component of Junos Space Security Director and requires
the following to be configured and deployed:

• Junos Space Platform—Junos Space is a comprehensive network management solution that simplifies
and automates the management of Juniper Networks switching, routing, and security devices. Junos
Space can be installed as a VIrtual Appliance (virtual machine) on a larger server or as a hardware device
using the Junos Space Network Appliance.

• Security Director—Junos Space Security Director provides centralized and orchestrated security policy
management through aweb-based interface. Security administrators can use Security Director tomanage
all phases of the security policy life cycle for every SRX Series physical and virtual device. Security
Director is a software module that installs on the Junos Space Platform.

• Policy Enforcer—Policy Enforcer itself is installed on a VM and uses RESTful APIs to communicate with
both Security Director and Sky Advanced Threat Prevention (ATP). Policy Enforcer contains two
components:

• Policy Controller—Defines the logical grouping of the network into secure fabric, automates the
enrollment of SRX Series devices with Sky ATP, and configures the SRX firewall policies.

• Feed Connector—Aggregates the cloud and customer feeds and is the server for SRX Series devices
to download feeds.

• Sky ATP—Sky ATP employs a pipeline of technologies in the cloud to identify varying levels of risk, and
provides a higher degree of accuracy in threat protection. It integrates with SRX Series gateways to
deliver deep inspection, inline malware blocking, and actionable reporting.

Sky ATP’s identification technology uses a variety of techniques to quickly identify a threat and prevent
an impending attack, including:

• Rapid cache lookups to identify known files.

• Dynamic analysis that involves unique deception techniques applied in a sandbox to trick malware
into activating and self-identifying.

• Machine-learning algorithms to adapt to and identify new malware.

• SRX Series device—SRX Series security gateways provide security enforcement across all network layers
and applications. Users can be permitted or prohibited from accessing specific business applications and
Web applications, regardless of the network ports and protocols that are used to transmit the applications.

Figure 5 on page 28 illustrates how the components in the Policy Enforcer Deployment Model interact.
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Figure 5: Components of the Policy Enforcer Deployment Model

Figure 6 on page 29 shows an example infected endpoint scenario to illustrate how some of the components
work together.
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Figure 6: Blocking an Infected Endpoint

ActionStep

A user downloads a file from the Internet.1

Based on network security policy, the file is sent to the Sky ATP cloud for malware inspection.2

The inspection determines this file is malware and informs Policy Enforcer of the results.3

The enforcement policy is automatically deployed to the SRX Series device and switches.4

The infected endpoint is quarantined.5

Policy Enforcer can track the infected endpoint and automatically quarantine it or block it from accessing
the Internet if the user moves from one campus location to another. See Figure 7 on page 30.
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Figure 7: Tracking Infected Endpoint Movement

In this example, Sky ATP identifies the endpoint as having an IP address of 192.168.10.1 and resides in
SVL-A. The EX Series switch quarantines it because it has been labeled as an infected host by Sky ATP.
Suppose the infected host physically moves from location SVL-A to location SVL-B. The EX Series switch
tracks the MAC address to the new IP address and automatically quarantines it. Policy Enforcer then
informs Sky ATP of the new MAC address-to-IP address binding.

Policy Enforcer can also quarantine infected hosts even if those hosts are connected to third-party switches,
as shown in Figure 8 on page 31.

For Policy Enforcer to provide threat remediation to endpoints connecting through third-party devices, it
must be able to authenticate those devices and determine their state. It does this using a tracking and
accounting threat remediation plug-in to gather information from a RADIUS server and enforce policies
such as terminate session and quarantine. For more information, see “Policy Enforcer Connector Overview”
on page 72
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Figure 8: Third-Party Switch Support

ActionStep

An end-user authenticates to the network through IEEE 802.1X or throughMAC-based authentication.1

Sky ATP detects the end point is infected with malware and adds it to the infected host feed.2

Policy Enforcer downloads the infected host feed.3

Policy Enforcer enforces the infected host policy using the Connector. See “Policy Enforcer Connector
Overview” on page 72.

4

The Connector queries the RADIUS server for the infected host endpoint details and initiates a Change
of Authorization (CoA) for the infected host.

The CoA can be either block or quarantine the infected host.

5

The enforcement occurs on the NAC device the infected host is authenticated with.6

Policy Enforcer communicates the infected host details back to Sky ATP.7
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Policy Enforcer Configuration Concepts

You have some options for how you can approach the initial setup of Sky ATP and Policy Enforcer. There
is a “Guided Setup” approach which walks you through the necessary steps for getting the product up and
running. This is the recommended approach. If you prefer, you can manually configure each part of the
product.

Either way, before you begin the configuration, you need to understand the concepts behind the
configuration items required to successfully deploy threat management policies across your network.
These items include security realms for Sky ATP, secure fabric for sites, and policy groups for endpoints.
These are explained in this section.

• Security Realm—When configuring Sky ATP or Policy Enforcer with Sky ATP, there are Realm selection
fields at the top of several pages such as Guided Setup and Feed Sources. A security realm is a group
identifier for an organization used to restrict access to Web applications. You must create at least one
security realm to login into Sky ATP. Once you create a realm, you can enroll SRX Series devices into
the realm. You can also give more users (administrators) permission to access the realm.

If you have multiple security realms, note that each SRX Series device can only be bound to one realm,
and users cannot travel between realms.

• Policy Enforcement Groups—A policy enforcement group is a grouping of endpoints to which threat
prevention policies are applied. Create a policy enforcement group by adding endpoints (firewalls,
switches, subnets, set of end users) under one common group name and later applying a threat prevention
policy to that group.

Some information to know about enforcement groups is as follows: Determine what endpoints you will
add to the group based on how you will configure threat prevention, either according to location, users
and applications, or threat risk. Endpoints cannot belong to multiple policy enforcement groups.

• Threat Prevention Policies—Once you have a Threat Prevention Policy, you assign one or more Policy
Enforcement Groups to it. Threat prevention policies provide protection and monitoring for selected
threat profiles, including command & control servers, GeoIP, infected hosts, and malware. Using feeds
from Sky ATP and custom feeds you configure, ingress and egress traffic is monitored for suspicious
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content and behavior. Based on a threat score, detected threats are evaluated and action may be taken
once a verdict is reached.

• Secure Fabric—For your configuration you must create one or more sites for your secure fabric. Secure
fabric is a collection of sites which contain network devices (switches, routers, firewalls, and other
security devices), used in policy enforcement groups. When threat prevention policies are applied to
policy enforcement groups, the system automatically discovers to which sites those groups belong. This
is how threat prevention is aggregated across your secure fabric.

Some information to know about sites is as follows: When you create a site, you must identify the
perimeter firewalls so you can enroll them with Sky ATP. If you want to enforce an infected host policy
within the network, you must assign a switch to the site. Devices cannot belong to multiple sites.
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Sky ATP Configuration Type Overview

Sky ATP or JATP with Policy Enforcer can be used in four different configuration types, which will be
explained here.

NOTE: The license you purchase determines if you can use the available configurations and
feature sets for your selected Sky ATP Configuration Type.

Configuration Type is set here in the UI: Administration > Policy Enforcer > Settings.

The following Sky ATP Configuration Types and corresponding workflows are available. Workflows are
the items you configure for each selection.

Sky ATP or JATP with Juniper Connected Security—This is the full version of the product. All Policy
Enforcer features and threat prevention types are available.
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Here is the Sky ATP with Juniper Connected Security configuration:

• Secure Fabric

• Policy Enforcement Group

• Sky ATP Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

Here is the JATP with Juniper Connected Security configuration:

• Secure Fabric

• Policy Enforcement Group

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

Sky ATP or JATP—This includes all threat prevention types, but does not include the benefits of Secure
Fabric, Policy Enforcement Groups, and Threat Prevention policies provided by Policy Enforcer. All
enforcement is done through SRX Series Device policies.

Here is the Sky ATP configuration:

• Sky ATP Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

Here are the JATP components:

• Threat Prevention Policies for the following threat types:

34



• C&C Server

• Infected Hosts

• Malware

• Geo IP

Cloud feeds only—The prevention types available are command and control server, infections hosts, and
Geo IP feeds. All enforcement is done through SRX Series Device policies.

Here is the Cloud feeds only configuration:

• Secure Fabric

• Policy Enforcement Group

• Sky ATP Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Geo IP

NoSkyATP (no selection)—Youwouldmake no Sky ATP selection to configure Juniper Connected Security
using custom feeds. Custom feeds are available for dynamic address, allowlist, blocklist, and infected hosts.
With this setting, there are no feeds available from Sky ATP, but the benefits of Secure Fabric, Policy
Enforcement Groups, and Threat Prevention policies provided by Policy Enforcer are available as options.
Infected hosts is the only prevention type available.

Here is the No selection configuration:

• Secure Fabric

• Policy Enforcement Group

• Custom Feeds

• Threat Prevention Policies for the following threat type:
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• Infected Hosts

NOTE: Moving between solution types is not supported in all cases. You can only move from
one Sky ATP Configuration Type to a “higher” configuration type. You cannot move to a lower
type. Please note the following hierarchy:

• Sky ATP or JATP with Juniper Connected Security (highest)

• Sky ATPor JATP

• Cloud feeds only

• No Sky ATP or JATP- No selection (lowest)

For each solution type, certain features and UI pages are available. Please see the links below for details.

• Features By Sky ATP Configuration Type on page 36

• Available UI Pages by Sky ATP Configuration Type on page 38
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Features By Sky ATP Configuration Type

For each configuration type, certain features and UI pages are available.

Refer to the following table for the features available for each configuration type.
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Table 4: List of features by Sky ATP Configuration Type

No Sky ATP/JATP
(no selection)Cloud feeds onlySky ATP/JATP

SkyATP/JATPwith
Juniper Connected
SecurityFeature

Not AvailableNot AvailableYES

Support with existing
SRX Series policies.
(No Secure Fabric,
Policy Enforcement
Group or Third-party
switch support)

YES

Support with Policy
Enforcement Groups
across the entire
Secure Fabric
(including Third-party
switch support)

Full Threat
Prevention Support

Not AvailableNot AvailableYESYESSRX Series Device
Malware Scanning

Not AvailableNot AvailableYESYESSRX Series Device
Infected Host
Blocking with Sky
ATP or JATP

Not AvailableYESYESYESCloud Feeds for
Command and
Control Servers and
GeoIP with Sky ATP
or JATP

YESYESYESYESInfected Hosts
Custom Feeds

YESYESYESYESDynamic Address
Custom Feeds

YESYESYESYESCustomAllowlist and
Blocklists
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Available UI Pages by Sky ATP Configuration Type

For each configuration type, certain features and UI pages are available.

Refer to the following table for the UI pages available for each configuration type.

Table 5: List of available UI pages by Sky ATP Configuration Type

No Sky ATP/JATP
(no selection)Cloud feeds onlySky ATP/JATP

Sky ATP/JATP
with Juniper
Connected
SecurityUI Page

Monitor Pages: Threat Prevention

Not AvailableNot AvailableYESYESHosts

Not AvailableNot AvailableYESYESC&C Servers

Not AvailableNot AvailableYESYESHTTP File Download

Not AvailableNot AvailableYESYESSMTP Quarantine

Not AvailableNot AvailableYESYESEmail Attachments

Not AvailableNot AvailableYESYESManual Upload

YESYESYESYESAll Hosts Status

YESYESNot AvailableYESDDoS Feeds Status

Devices Page

YESYESNot AvailableYESSecure Fabric

Configure Pages: Threat Prevention

YESYESYESYESPolicies

YESYESYESYESCustom Feeds

(Dynamic Address, Allowlist,
Blocklist)
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Table 5: List of available UI pages by Sky ATP Configuration Type (continued)

No Sky ATP/JATP
(no selection)Cloud feeds onlySky ATP/JATP

Sky ATP/JATP
with Juniper
Connected
SecurityUI Page

YESYESNot AvailableYESCustom Feeds

(Infected Host, DDoS)

Not AvailableYESYES

(Only for Sky ATP)

YES

(Only for Sky ATP)

Sky ATP Realms

Not AvailableNot AvailableYESYESEmail Management

Not AvailableNot AvailableYESYESMalware Management

Shared Objects

YESYESNot AvailableYESPolicy Enforcement Groups

Not AvailableYESYESYESGeo IP

Administration: Policy Enforcer

YESYESYESYESSettings

YESYESNot AvailableYESConnectors

NOTE: SMTP Quarantine is available only for Sky ATP. It is not available for JATP.
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Comparing the Juniper Connected Security and
non-Juniper Connected Security Configuration Steps

The remainder of this guide describes how to configure Security Director for either Policy Enforcer with
Sky ATP (Juniper Connected Security) or Sky ATPwith no Policy Enforcer (non-Juniper Connected Security).
An optional quick setup configuration is available to step you through the configuration tasks. Or you can
use Security Director windows to configure each step manually.

Table 6 on page 40 compares the basic steps for both.

Table 6: Comparing the Juniper Connected Security Configuration Steps to the non-Juniper Connected
Security Configuration Steps

Non-Juniper Connected Security
Configuration StepsJuniper Connected Security Configuration Steps

Register one or more Sky ATP accounts.Create your secure fabric.

A secure fabric is a collection of sites which contain network devices
such as switches, routers, firewalls, and other security devices.

Select your SRX Series devices to register.
Only SRX Series devicesmanaged by Security
Director are supported.

Create your policy enforcement groups.

You can create policy enforcement groups based on, for example,
location or IP subnets. Policy enforcement groups are basically
endpoints.

Create the Sky ATP profiles and policies. You
can create C&C (threat score and actions to
take), malware and infected host policies.

Register one or more Sky ATP accounts.

Add the Sky ATP policy as a rule in your
firewall policy.

Create threat prevention policies.

Threat prevention policies provide protection and monitoring for
selected threat profiles, including command & control servers, infected
hosts, and malware.

Apply your threat prevention policies to policy enforcement groups.

When threat prevention policies are applied to policy enforcement
groups, the system automatically discovers to which sites those groups
belong.When you dynamically add sites, the policy enforcement groups
and threat prevention policies are updated automatically.
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Policy Enforcer Installation Overview

Table 7 on page 43 lists the general steps to install and configure Policy Enforcer.

Table 7: Overview of Steps to Install and Configure Policy Enforcer

SeeDescriptionStep

Junos Space Network Management Platform
software download

Junos Space Security Director software download

Install and configure Junos Space and Security
Director 16.1 or later.

NOTE: After installing Junos Space and Security
Director, you must update to the latest Junos
Space device schema. See your Junos Space
Security Director documentation for more
information on upgrading your schema.

1

Juniper Tech LibraryInstall and configure your SRX Series devices, EX
Series switches or QFX Series switches. Switches
are “discoverable” through Junos Space.

For information on discovering switches, see
“Using Guided Setup for Sky ATP with Juniper
Connected Security” on page 141.

2

“Deploying and Configuring the Policy Enforcer
with OVA files” on page 44

“Installing Policy Enforcer with KVM” on page 50

Download, deploy and configure the Policy
Enforcer virtual machine.

You install Policy Enforcer on an industry-standard
x86 server running a hypervisor, either the
kernel-based virtual machine (KVM) hypervisor or
the VMware ESXi hypervisor.

3

“Identifying the Policy Enforcer Virtual Machine
In Security Director” on page 61

Use the Policy Enforcer Settings screen in Security
Director (Administration > Policy Enforcer
Settings) to identify the Policy Enforcer virtual
machine to communicate with.

4

“Obtaining a Sky ATP License” on page 62

“Creating a Sky ATP Cloud Web Portal Login
Account” on page 63

Obtain a Sky ATP license and create a Sky ATP
portal account.

5
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Table 7: Overview of Steps to Install and Configure Policy Enforcer (continued)

SeeDescriptionStep

“Loading a Root CA” on page 64Install the root CA on your Sky ATP-supported
SRX Series devices.

6

“ClearPass Configuration for Third-Party Plug-in”
on page 105

“Cisco ISE Configuration for Third-Party Plug-in”
on page 112

Configure ClearPass or Cisco ISE as a connector
for third-party products (non-Juniper Networks)
to unify policy enforcement across all network
elements.

7

“Using Guided Setup for Sky ATP with Juniper
Connected Security” on page 141

“Using Guided Setup for Sky ATP” on page 148

Use the Guided Setup screens in Security Director
to configure Threat Prevention policies and deploy
to devices. Optionally, you can configure policies
without guided setup.

8
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Deploying and Configuring the Policy Enforcer with
OVA files

As with other Juniper Networks virtual appliances, Policy Enforcer requires either a VMware ESX server
version 4.0 or later or a VMware ESXi server version 4.0 or later that can support a virtual machine with
the following configuration:

• 2 CPU

• 8-GB RAM (16-GB recommended)

• 120-GB disk space
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If you are not familiar with using VMware ESX or EXSi servers, see VMware Documentation and select
the appropriate VMware vSphere version.

To deploy and configure the Policy Enforcer with OVA files, perform the following tasks:

1. Download the Policy Enforcer virtualmachineOVA image from the JuniperNetworks software download
page.

NOTE: Do not change the name of the Policy Enforcer virtual machine image file that you
download from the Juniper Networks support site. If you change the name of the image file,
the creation of the Policy Enforcer virtual machine can fail.

2. Launch the vSphere Client that is connected to the ESX server where the Policy Enforcer virtual machine
is to be deployed.

3. Select File > Deploy OVF Template from the menu bar.

4. Click Browse to locate the OVA file you downloaded in Step 1.

5. Click Next and follow the instructions in the installation wizard.

It may take a few minutes to deploy your virtual machine. Once deployed, its name appears in the left
side of the vSphere Client.

6. Right-click the virtual machine name in the left side of the vSphere Client and select Open Console to
start configuring your network settings.

7. Log in to your virtual machine using root and abc123 as the username and password, respectively. You
will be required to change the password at a later step.

The welcome page appears.

8. Click OK.

The End User License Agreement (EULA) window appears.

9. Click Accept to acknowledge the EULA. If you do not agree with the EULA, click Cancel. Your
configuration will stop and you will return to the main vSphere Client page.

The Network configuration page appears. See Figure 9 on page 46.
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Figure 9: Defining the Basic Network Configuration Settings

10. Enter the following configuration information.

DescriptionOption

Enter the hostname for the Policy Enforcer virtual machine; for example,
pe.juniper.net.

Hostname

Enter the IP address for the Policy Enforcer virtual machine.

NOTE: Make note of this IP address as you’ll need it in a later step.

IP address

Enter the netmask for the Policy Enforcer virtual machine.Network mask

Enter the IP address of the default gateway that connects your internal network
to external networks.

Default gateway

Enter the IP address of your primary system registered to join theDomainName
System (DNS).

Primary DNS server

Enter the IP address of a secondary DNS server. Policy Enforcer uses this
address only when the primary DNS server is unavailable.

Secondary DNS server

Select this check box if you do not want to check basic network settings. By
default, the system will ping the gateway to ensure it receives a response
indicating your settings are correct.

Skip DNS servers check

11.Click Apply Changes.

Your network settings are applied. A progress window indicates the status.
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When the system is finished updating your network settings, an NTP server window appears and
prompts you to configure the NTP server list. See Figure 10 on page 47.

Figure 10: Prompt for Configuring the NTP Servers

12.Click Yes to customize the NTP server list. Click No to use the default list of 0, 1, 2 and
3.centos.pool.ntp.org.

13. (Optional) Specify the NTP servers to use. See Figure 11 on page 47. Click Apply Changes to accept
your edits, Clear All to clear all fields in this window, or Cancel to discard any edits and continue to the
next step.

Figure 11: Configuring the NTP Servers

14.The Root password change page appears. See Figure 12 on page 48.
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Figure 12: Changing the Root Password

15. Enter and re-enter a new administrator password for the Policy Enforcer virtual machine.

Password restrictions are listed in the screen.

NOTE: Make note of this password as you’ll need it in a later step.

If you forget your password, see CentOS root password reset instructions.

16.Click OK.

The Juniper Networks Policy Enforcer page appears. See Figure 13 on page 48.

Figure 13: Reviewing and Changing Your Configuration Settings
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17. Select one of the options and press Enter.

DescriptionOption

Lets you review the configuration settings you defined one last time before
applying them to the Policy Enforcer virtual machine.

We recommend that you do not change your configuration settings after
Policy Enforcer is set up within Security Director.

Review configuration and finish
setup

Select a setting to update its value.Change...

Lets you ping the default gateway and custom IP address and lets you perform
a DNS lookup to verify that your settings are correct.

Troubleshooting menu

The Review configuration page appears. See Figure 14 on page 49.

Figure 14: Reviewing Your Configuration Settings

18.Review your configuration settings and click Finish setup. To change any of the settings, click Change
configuration.

When you click Finish setup, the configuration settings are applied to the Policy Enforcer virtual machine.
A status page indicates the progress.

When done, the Setup Complete page appears.
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19.Click Finish to return to the main vSphere Client page.

NOTE: Each time you log in to the Policy Enforcer virtual machine, you are given the option
to review or change any of these settings.
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Installing Policy Enforcer with KVM
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Configuring Policy Enforcer Settings | 54

Connecting to the KVMManagement Console | 59

The Policy Enforcer Virtual Appliance Release 17.1R2 and later can be deployed on qemu-kvm (KVM)
Release 1.5.3-105.el7 or later which is on CentOS Release 6.8 or later.

NOTE: Juniper Networks does not provide any support for installing and configuring the KVM
server. You must install the virtual appliance image and configure it as per the recommended
specifications for the virtual appliance. Juniper Networks will provide support only after the
Policy Enforcer Virtual Appliance has booted successfully.

The prerequisites to deploy a Policy Enforcer Virtual Appliance on a KVM server are as follows:

• Knowledge about configuring and installing a KVM server.

• The KVM server and supported packages must be installed on a CentOS machine with the required
kernels and packages. For information about installing a KVM server and supported packages on CentOS,
refer to http://wiki.centos.org/HowTos/KVM.

• The Virtual Machine Manager (VMM) client must be installed on your local system.

• You use virt-manager or virt-install to install Policy Enforcer VMs. See your host OS documentation for
complete details on these packages.

The following are the minimum requirements for installing the Policy Enforcer VM.

• 2 CPU

• 8-GB RAM (16 GB recommended)

• 120-GB disk space

This topic includes:

Installing Policy Enforcer with virt-manager

You can install and launch Policy Enforcer with the KVM virt-manager GUI package.

Ensure that sure you have already installed KVM, qemu, virt-manager, and libvirt on your host OS.
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To install Policy Enforcer with virt-manager:

1. Download the Policy Enforcer KVM image from the Juniper software download site.

2. On your host OS, type virt-manager. The Virtual Machine Manager appears.

NOTE: You must have admin rights on the host OS to use virt-manager.

3. Click Create a new virtual machine. The New VM wizard appears .

4. Enter a name for the virtual machine, select Import existing disk image, and click Forward.

5. Browse to the location of the downloaded Policy Enforcer image and select it.

6. Select Linux from the OS type list and select Show all OS options from the Version list.

7. Select Red Hat Enterprise Linux 6 or later from the expanded Version list and click Forward.

8. Set the RAM to 8192 MB and set CPUs to 1. Click Forward.

9. Under AdvancedOptions, select Specify shared device name and enter the name of the bridge (typically
br0) into the text box.

10.Click Finish. The VM manager creates the virtual machine and launches the Policy Enforcer console.

Installing Policy Enforcer with virt-install

The virt-install and virsh tools are CLI alternatives to installing and managing Policy Enforcer VMs on a
Linux host.

Ensure that sure you have already installed KVM, qemu, virt-install, and libvirt on your host OS.

NOTE: You must have root access on the host OS to use the virt-install command.

To install Policy Enforcer with virt-install:

1. Download the Policy Enforcer KVM image from the Juniper software download site.
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2. On your host OS, use the virt-install commandwith themandatory options listed in Table 8 on page 53.

NOTE: See the official virt-install documentation for a complete description of available
options.

Table 8: virt-install Options

DescriptionCommand Option

Name the Policy Enforcer VM.--name name

Allocate RAM for the VM, in megabytes.--ram megabytes

Enable the vmx feature for optimal throughput. You can also enable aes
for improved cryptographic throughput.

NOTE: CPU flag support depends on your host OS and CPU.

Use virsh capabilities to list the virtualization capabilities of your host OS
and CPU.

--cpu cpu-model, cpu-flags

Allocate the number of vCPUs for the Policy Enforcer VM.--vcpus number

Specify disk storage media and size for the VM. Include the following
options:

• size=gigabytes

• device=disk

• bus=ide

• format=qcow2

--disk path

Configure the guest OS type and variant.--os-type os-type

--os-variant os-type

Create and boot the Policy Enforcer VM from an existing image.--import

The following example creates a Policy Enforcer VM with 8192 MB RAM, 1 vCPUs, and disk storage
up to 120 GB:

hostOS# virt-install --name vPEM --ram 8192 --cpu SandyBridge,+vmx,-invtsc --vcpus=1
--arch=x86_64 --disk path=/mnt/pe.qcow2,size=120,device=disk,bus=ide,format=qcow2 --os-type
linux --os-variant rhel6 --import
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Configuring Policy Enforcer Settings

By default, when you create the Policy Enforcer VM through virt-manager or virt-install, the console
window appears for you to set up and configure the Policy Enforcer settings. You can open the console
at any time after the initial configuration to review or edit your settings.

To configure Policy Enforcer settings:

1. Log in to your virtual machine using root and abc123 as the username and password, respectively. You
will be required to change the password at a later step.

The welcome page appears.

2. Click OK.

The End User License Agreement (EULA) window appears.

3. Click Accept to acknowledge the EULA. If you do not agree with the EULA, click Cancel. Your
configuration will stop and you will return to the main vSphere Client page.

The Network configuration page appears. See Figure 15 on page 54.

Figure 15: Defining the Basic Network Configuration Settings

4. Enter the following configuration information.

DescriptionOption

Enter the hostname for the Policy Enforcer virtual machine; for example,
pe.juniper.net.

Hostname

54



DescriptionOption

Enter the IP address for the Policy Enforcer virtual machine.

NOTE: Make note of this IP address as you’ll need it in a later step.

IP address

Enter the netmask for the Policy Enforcer virtual machine.Network mask

Enter the IP address of the default gateway that connects your internal network
to external networks.

Default gateway

Enter the IP address of your primary system registered to join theDomainName
System (DNS).

Primary DNS server

Enter the IP address of a secondary DNS server. Policy Enforcer uses this
address only when the primary DNS server is unavailable.

Secondary DNS server

Select this check box if you do not want to check basic network settings. By
default, the system will ping the gateway to ensure it receives a response
indicating your settings are correct.

Skip DNS servers check

5. Click Apply Changes.

Your network settings are applied. A progress window indicates the status.

When the system is finished updating your network settings, an NTP server window appears and
prompts you to configure the NTP server list. See Figure 16 on page 55.

Figure 16: Prompt for Configuring the NTP Servers

6. Click Yes to customize the NTP server list. Click No to use the default list of 0, 1, 2 and
3.centos.pool.ntp.org.

7. (Optional) Specify the NTP servers to use. See Figure 17 on page 56. Click Apply Changes to accept
your edits, Clear All to clear all fields in this window, or Cancel to discard any edits and continue to the
next step.
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Figure 17: Configuring the NTP Servers

8. The Root password change page appears. See Figure 18 on page 56.

Figure 18: Changing the Root Password

9. Enter and re-enter a new administrator password for the Policy Enforcer virtual machine.

Password restrictions are listed in the screen.

NOTE: Make note of this password as you’ll need it in a later step.

If you forget your password, see CentOS root password reset instructions.
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10.Click OK.

The Juniper Networks Policy Enforcer page appears. See Figure 19 on page 57.

Figure 19: Reviewing and Changing Your Configuration Settings

11. Select one of the options and press Enter.

DescriptionOption

Lets you review the configuration settings you defined one last time before
applying them to the Policy Enforcer virtual machine.

We recommend that you do not change your configuration settings after
Policy Enforcer is set up within Security Director.

Review configuration and finish
setup

Select a setting to update its value.Change...

Lets you ping the default gateway and custom IP address and lets you perform
a DNS lookup to verify that your settings are correct.

Troubleshooting menu

The Review configuration page appears. See Figure 20 on page 58.
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Figure 20: Reviewing Your Configuration Settings

12.Review your configuration settings and click Finish setup. To change any of the settings, click Change
configuration.

When you click Finish setup, the configuration settings are applied to the Policy Enforcer virtual machine.
A status page indicates the progress.

When done, the Setup Complete page appears.

13.Click Finish to return to the main vSphere Client page.
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NOTE: Each time you log in to the Policy Enforcer virtual machine, you are given the option
to review or change any of these settings.

Connecting to the KVMManagement Console

By default, when you create the Policy Enforcer VM the console window appears for you to set up and
configure the Policy Enforcer settings. You can open the console at any time after the initial configuration
to review or edit your settings. To do this, you must have the virt-manager package or virsh installed on
your host OS.

To connect to the Policy Enforcer console using virt-manager:

1. Launch virt-manager.

2. Highlight the Policy Enforcer VM you want to connect to from the list of VMs displayed.

3. Click Open.

4. Select View>Text Consoles>Serial 1. The Policy Enforcer console appears.

To connect to the Policy Enforcer console with virsh:

1. Use the virsh console command on the Linux host OS. For example:

user@host# virsh console PE-kvm-2
Connected to domain PE-kvm-2

2. The Policy Enforcer console appears.

RELATED DOCUMENTATION
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Policy Enforcer Ports

You will need to open ports for Policy Enforcer to communicate with other products and devices.

Table 9 on page 60 lists the ports that Policy Enforcer uses to communicate with Security Director.

Table 9: Policy Enforcer Ports to Communicate with Security Director

OutInPortProtocolService

X8080TCPHTTPS

X443TCPHTTPS

Table 10 on page 60 lists the ports that Policy Enforcer uses to communicate with SRX Series Devices.

Table 10: Policy Enforcer Ports to Communicate with SRX Series Devices

OutInPortProtocolService

X443TCPHTTPS

Table 11 on page 60 lists the ports that Policy Enforcer uses to communicate with the Sky ATP server to
download feeds.

NOTE: Connectivity between Sky ATP and Policy Enforcer is certificate-based. Once the trust
is established, every request is within a context of valid token.

Table 11: Policy Enforcer Ports to Communicate with cloudfeeds.sky.junipersecurity.net

OutInPortProtocolService

X443TCPHTTPS

Table 12 on page 60 lists the remaining Policy Enforcer services.

Table 12: Policy Enforcer Services

CommentsService

Used for basic network connection.DNS

Used to synchronize system clocks with the Network Time Protocol (NTP).NTP
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If you are using NSX with Policy Enforcer (or Security Director), the following ports must be opened on
NSX.

Table 13: NSX Ports

CommentsOutInPort

Used for communication between NSX and Security Director.X443

Used for outbound SSH based auto discovery of devices.X7804

Used for host management and image upload over sftp.X22

RELATED DOCUMENTATION
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Installing Policy Enforcer with KVM | 50

Identifying the Policy Enforcer Virtual Machine In
Security Director

You must identify the Policy Enforcer virtual machine in Security Director so that they can communicate
with each other. To do so, follow these steps:

1. Log in to Security Director and select Administration > PE Settings.

2. Enter the IP address of the Policy Enforcer virtual machine and the root password and click OK.

3. Select a Threat Prevention Type:

• Sky ATP with PE—All Juniper Connected Security features and threat prevention types are available.

NOTE: If you upgrade from cloud feeds or Sky ATP, you cannot roll back again. Upgrading
resets all devices previously participating in threat prevention. Use the setup wizard to
expedite the process configuring threat prevention policies.
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• Sky ATP—All threat prevention types are available: Command and control server, Geo IP, and Infected
hosts.

NOTE: If you upgrade from cloud feeds only to Sky ATP, you cannot roll back again.
Upgrading resets all devices previously participating in threat prevention, and you must
re-enroll them with Sky ATP. Use the setup wizard to expedite the process configuring
threat prevention policies.

• Cloud Feeds only—Command and control server and Geo IP are the only threat prevention types
available.

For more information on these threat prevention types, see “Policy Enforcer Settings” on page 70.

If you change the Policy Enforcer VM password (see Deploying and Configuring the Policy Enforcer
Virtual Machine), the Policy Enforcer VM still communicates with Security Director even if you do not
update the Policy Enforcer password in the Administration > PE Settingswindow in Security Director.
You can, however, update the information in the PE Settings page with the new password to keep your
credentials consistent.

RELATED DOCUMENTATION

Obtaining a Sky ATP License | 62
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Benefits of Policy Enforcer | 20

Policy Enforcer Components and Dependencies | 27

Obtaining a Sky ATP License

Contact your local sales office or a Juniper Networks partner to place an order for a Sky ATP premium
license. Once the order is complete, an authorization code is e-mailed to you. You will use this code in
conjunction with your SRX Series device serial number to generate a premium license entitlement. (Use
the show chassis hardware CLI command to find the serial number of the SRX Series device.)

To obtain a Sky ATP premium or basic license, follow these steps:

1. Go to https://www.juniper.net/generate_license/ and log in with your Juniper Networks Customer
Support Center (CSC) credentials.
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2. In the Generate Licenses list, select J Series Service Routers and SRX Series Devices.

3. Using your authorization code and SRX Series serial number, follow the instructions to generate your
license key. (Note that you do not enter this license key anywhere.)

Once generated, your license key is automatically transferred to the cloud server. It can take up to 24
hours for your activation to be updated in the Sky ATP cloud server

The free version does not require you to generate a license. The SRX Series device only needs to be enrolled
to the cloud, and it will automatically be entitled to the free version.

Unlike with physical SRX Series devices, you must install Sky ATP premium licenses onto your vSRX
instances. Installing the Sky ATP license follows the same procedure as with most standard vSRX licenses.
Formore information on installing the Sky ATP license onto your vSRX instance, see the LicenseManagement
and vSRX Deployments section within Managing the Sky Advanced Threat Prevention License.
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Creating a Sky ATP Cloud Web Portal Login Account

To create a Sky ATP account, you must first have a Customer Support Center (CSC) user account. For
more information, see Creating a User Account. If you forget to do this step, you will be reminded during
the quick setup.

1. Go to https://sky.junipersecurity.net and select your region. On the next screen, clickCreate a security
realm.

2. Enter the following required information and continue to click Next until you are finished:

• Your single sign-on or Juniper Networks CSC credentials.

• A security realm name — for example, Juniper-Mktg-Sunnyvale. Realm names can only contain
alphanumeric characters and the dash (“-”) symbol.
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• Your contact information.

• An e-mail address and password. Thiswill be your login information to access the SkyATPmanagement
interface.

3. When you click Finish, you are automatically logged in and taken to the Sky ATP Web UI dashboard.

RELATED DOCUMENTATION
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Using Guided Setup for Sky ATP with Juniper Connected Security | 141
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Loading a Root CA

After the Policy Enforcer virtual machine is configured and created and before creating any ATP policy,
you must set up certificates on any Sky ATP-supported SRX Series device. For a list of SkyATP- supported
devices, see Sky ATP Supported Platforms Guide.

NOTE: The following is simply an example. You will need to modify the group name, profile and
policy name to match your configuration.

To set up certificates for Policy Enforcer:

1. Create the CA profile using the following CLI command. A CA profile configuration contains information
specific to a CA.

root@host# request security pki generate-key-pair certificate-id ssl-inspect-ca size 2048 type rsa
root@host# request security pki local-certificate generate-self-signed certificate-id ssl-inspect-ca
domain-name www.juniper.net subject "CN=www.juniper.net,OU=IT,O=Juniper
Networks,L=Sunnyvale,ST=CA,C=US" email security-admin@juniper.net

2. Configure the CA profile.

NOTE: The CA profile name must be policyEnforcer.
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root@host# set security pki policyEnforcer ssl-inspect-ca ca-identity ssl-inspect-ca
root@host# set security pki ca-profile policyEnforcer ca-identity ssl-profile-ca

3. Load the default trusted CA.

root@host# request security pki ca-certificate ca-profile-group load ca-group-nameAll-Trusted-CA-Def
filename default

4. Enable HTTPS on the threat prevention policy.

When creating your threat prevention policy (in Security Director, selectConfigure>Threat Prevention
> Policy), enable the Scan HTTPS option to scan files downloaded over HTTPS. For more information
on creating threat prevention policies, see the Security Director online help.

When you enable HTTPS on the threat prevention policy, Policy Enforcer sends the following
configuration to the devices:

##Security Firewall Policy : trust - untrust##

set security policies from-zone trust to-zone untrust policy 

PolicyEnforcer-Rule1-1 then permit application-services ssl-proxy profile-name

 policyEnforcer

##Security Firewall Policy : global ##

set security policies global policy PolicyEnforcer-Rule1-1 then permit 

application-services ssl-proxy profile-name policyEnforcer

##SSL Forward proxy Profile Configurations##

set services ssl proxy profile policyEnforcer trusted-ca all

set services ssl proxy profile policyEnforcer root-ca ssl-inspect-ca

5. Export the locally generated certificate from the SRX Series device and install it on clients as a trusted
CA to avoid some of the certificate errors that may occur.

Each website or browser behaves slightly different. Some require exceptions to be added to your
browser to display the content while others may not work because the local certificate is weak.

root@host# request security pki local-certificate export certificate-id 

ssl-inspect-ca type pem filename ssl-inspect-ca.pem

6. (Optional) You can limit some certificate warning messages using the following CLI command:

root@host# set services ssl proxy profile policyEnforcer actions 

ignore-server-auth-failure
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Upgrading Your Policy Enforcer Software

To upgrade to the latest release of Policy Enforcer, download and run the rpm file available from Juniper
Network’s software download page. You must have a version of Policy Enforcer already installed to run
the upgrade script. If you do not, download the latest software version from the Policy Enforcer software
download page and follow the Policy Enforcer Installation Overview instructions.

NOTE: You can upgrade only from the previous release. For example, you can upgrade from
16.1R1 to 16.1R2 or from 16.1R2 to 17.1. You cannot skip a release. For example, upgrading
from 16.1R1 to 17.1R1 is not supported.

To upgrade your Policy Enforcer software to the latest release:

1. Access the Policy Enforcer software download page

https://www.juniper.net/support/downloads/?p=sdpe

2. Select the Software tab.

3. From the Version drop-down menu, select the version you want to install.

4. From under the Application Package heading, download the Policy Enforcer RPM to your Policy Enforcer
virtual appliance.

5. On your Policy Enforcer virtual appliance, change directory to where you downloaded the RPM bundle
and install it using the following command:

[root@hostname~]# rpm -Uvh filename.rpm

For example:
[root@hostname~]# rpm -Uvh Policy_Enforcer-19.4R1-975-PE-Upgrade.rpm

It may take a few minutes to install the RPM bundle. Once installed, the Policy Enforcer screens within
Security Director and any schema changes are updated. The configuration settings you used when you
deployed the Policy Enforcer VM are retained.

To verify your upgrade:

• In Security Director, select Administration > PE settings. This page shows the current installed Policy
Enforcer version number.

• Check the log file for any errors.
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• (Upgrading from16.1R1 to 16.2R1) Check the /var/log/pe_upgrade.log file for any errors. The following
is an example output of the pe_upgrade.log file for a successful upgrade.

Location: /var/log/pe_upgrade.log

Update text:

Preparing...                ########################################### [100%]

   1:Policy_Enforcer        ########################################### [100%]

Upgrading..

root

Stopping services

Service: feed_scheduler

Stopping service…

Service stopped

Service: feed_server

Stopping service…

Service stopped

Service: config_server

Stopping service…

Service stopped

Extracting spotlight-connector package

Extracting security-common-lib package

Executing sql table

Copying spotlight-connector package

Copying security-common-lib package

Starting services

Service: config_server

Starting service…

Service started

Service: feed_server

Starting service…

Service started

Service: feed_scheduler

Starting service…

Service started

root

Done.

• (Upgrading from 17.1R1 to 17.2R1) Check the following log files for errors:

• /var/log/pe_upgrade_17_2.log

• /var/log/pe_upgade_17_2_3rd_party_adapter.log

• /var/log/pe_upgrade_nsx.log
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NSXMigration Instructions from Policy Enforcer Release 17.1R1 to 17.2R1

After successfully upgrading to Policy Enforcer Release 17.2R1 and when all the Policy Enforcer services
and NSX micro service are up and running, the administrator must run the nsxmicro_sdsn_migrate script
manually. After the successful installation of the script, the Juniper Connected Security resources such as
Connector instance, Secure Fabric, and Policy Enforcement Groups (PEG) are created for theNSXManagers
that are already discovered in Security Director.

If the Juniper Connected Security resources are already present in the upgraded version of the software,
a message is displayed showing that the NSX Manager with Juniper Connected Security resources are
already present in the NSX database.
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Policy Enforcer Settings

To configure your Policy Enforcer, perform the following actions.

Before You Begin

• Policy Enforcer Release version and Security Director Release version must be compatible. The Settings
page shows the current release version of Policy Enforcer. If there is an incompatibility, an errormessage
is shown that there is a mismatch between Security Director and Policy Enforcer release versions. To
know more about the supported software versions, see Policy Enforcer Release Notes.

You cannot proceed further if the Policy Enforcer and Security Director Release versions are incompatible.

• A valid Policy Enforcer VMpassword is required to have a fully functional Policy Enforcer. If the password
is valid, a message is shown at the top of the Settings page that the Policy Enforcer Space user (pe_user)
password is currently valid and the date by when the password expires. The pe_user has the same
capabilities as the super user.

If the password is invalid, an error message is shown at the top of the Settings page. To fix this issue,
login to the Policy Enforcer VM, change the root password, and then enter the new root password in
the Settings page.

• Policy Enforcer with Security Director can be used in four different configuration types. For each
configuration type, certain features are available. Read the following topic: “Sky ATP Configuration Type
Overview” on page 33 before you make a Sky ATP or Juniper Advanced Threat Prevention (JATP)
Configuration Type selection on the Policy Enforcer Settings page.

• If you are using Sky ATP or JATP without Juniper Connected Security or Cloud Feeds only, you must
still download Policy Enforcer and create a policy enforcer virtual machine.

• A Sky ATP license and account are needed for three of the configuration types (Sky ATP or JATP with
Juniper Connected Security, Sky ATP or JATP, and Cloud Feeds only), but not for the default mode (No
Selection). If you do not have a Sky ATP license, contact your local sales office or Juniper Networks
partner to place an order for a Sky ATP premium license. If you do not have a Sky ATP account, when
you configure Sky ATP, you are redirected to the Sky ATP server to create one. Please obtain a license
before you try to create a Sky ATP account. Refer to “Policy Enforcer Installation Overview” on page 43
for instructions on obtaining a Sky ATP premium license.

To set up a Sky ATP or JATP Configuration Type, you must do the following:

1. Select Security Director>Administration>Policy enforcer>Settings.

2. Enter the IP address for the policy enforcer virtual machine. (This is the IP address you configured
during the PE VM installation. You can locate this IP address in the vSphere Center portal.)
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3. Enter the password for the policy enforcer virtual machine. (This is the same password you use to login
to the VM with your root credentials. Note that the username defaults to root )

NOTE: Refer to “Deploying and Configuring the Policy Enforcer with OVA files” on page 44
for instructions on downloading Policy Enforcer and creating your policy enforcer virtual
machine.

4. If youwant to use certificate based authentication, enable theCertificate BasedAuthentication option.

Browse the X509 certificate file and X509 certificate Key file.

5. Select a Sky ATP Configuration Type. If you do not select a type, Policy Enforcer works in default mode.
(See“Sky ATP Configuration Type Overview” on page 33 for more information.)

Refer Table 14 on page 71 to understand the supported threat prevention types for different Policy
Enforcer modes:

Table 14: Supported Threat Prevention Types for Different PE Modes

Sky ATP or JATP
with Juniper
Connected Security

Sky ATP or
JATP

Cloud Feeds
Only

No Selection
(Default)Threat Prevention Type

YesYesYesYesCustom feeds

YesYesYesYesCommand and Control (C&C) feeds

YesYesYes-Infected Host feed

YesYes--Malware inspection

Yes---Enforcement on EX Series and QFX
Series switches or using 3rd party
Connectors

You cannot change or modify a higher configuration to a basic mode. For example, you cannot change:

• Sky ATP or JATP ->Cloud feeds only

• Sky ATP or JATP with Juniper Connected Security ->Cloud feeds only

• Sky ATP or JATP ->No Selection (Default)
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WARNING: If you change to a lower mode, you must reinstall Security Director
and Policy Enforcer.

However, you can change or modify your configuration to a higher mode. For example you can change:

• Cloud feeds only-> Sky ATP or JATP

• Cloud feeds only ->Sky ATP with Juniper Connected Security

• Sky ATP or JATP -> Sky ATP with Juniper Connected Security

6. Polling timers affect how often the system polls to discover endpoints. There are two polling timers,
one that polls network wide and one that polls site wide. They each have default settings, but you can
change those defaults to poll more or less often.

• Network wide polling interval (value in hours): The default is 24 hours. You can set this range from
between 1 to 48 hours. This timer polls all endpoints added to the secure fabric.

• Site wide polling interval (value in minutes): The default is 5 minutes. You can set this range from 1
minute to 60 minutes. This timer polls infected endpoints moving within the sites that are a part of
Secure fabric.

7. Click the Download button to view or save Policy Enforcer data logs to your local system. These logs
are in a compressed file format.

RELATED DOCUMENTATION

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration
Steps | 40

Using Guided Setup for Sky ATP with Juniper Connected Security | 141

Using Guided Setup for Sky ATP | 148

Configuring Cloud Feeds Only | 205

Using Guided Setup for No Sky ATP (No Selection) | 152

Policy Enforcer Connector Overview

Configure a connector for third-party products (non-Juniper Networks) to unify policy enforcement across
all network elements. This protects endpoints, wired and wireless, connecting to third-party devices as
well as Juniper devices.
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For Policy Enforcer to provide threat remediation to endpoints connecting through third-party devices, it
must be able to authenticate those devices and determine their state. It does this using a tracking and
accounting threat remediation plug-in to gather information from a RADIUS server and enforce policies
such as terminate session and quarantine.

NOTE: All third-party switches being usedwith Policy Enforcer must support AAA/RADIUS and
Dynamic Authorization Extensions to RADIUS protocol (RFC 3579 and RFC 5176).

NOTE: All Cisco Systems switchmodels that adhere to Radius IETF attributes and support Radius
Change of Authorization from Aruba ClearPass are supported by Policy Enforcer for threat
remediation.

Once configured, the connector uses an API to gather endpointMAC address information from the RADIUS
server. If a host is found to be suspicious, the RADIUS server sends a CoA to disconnect the active session
and quarantine the host. Once the threat has beenmitigated, the interface can return to the network again,
but must be authorized to do so by Policy Enforcer using the plug-in and information gathered from the
RADIUS server.

Once you have a connector configured, the following information is provided on the Connectors main
page.

Table 15: Connectors Information- Main Page

DescriptionField

The name you entered for the connector.Name

This field always reads Third Party Switch at this time.Type

The current status of the connector. (Active or Inactive.)

Hover over the status to see more details of connector instances and their respective status.

The following statuses are shown:

• Active status with green icon—All connector instances inside a connector are active

• Inactive status with red icon—All connector instances inside a connector are inactive

• Active status with red icon—One of the connectors is inactive and other connectors are
active.

• In progress status with green icon—All connectors are still in progress.

• Pending (not in progress) status with green icon—All connectors are still pending.

Status
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Table 15: Connectors Information- Main Page (continued)

DescriptionField

Specifies the description of a connector.Description

Specifies the IP address of the product management server.Identity Server

The IP address of the ClearPass RADIUS server.IP Address

Benefits of Policy Enforcer Connector

• Custom threat feed and automation - Automates the threat remediation workflows for third-party
products.

• RESTful APIs - Provides a network vendor agnostic mechanism for threat remediation. Enables you to
automate configuration and management of physical, logical, or virtual devices.

RELATED DOCUMENTATION

ClearPass Configuration for Third-Party Plug-in | 105
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Creating a Policy Enforcer Connector for Public and
Private Clouds

Perform the following actions to configure connectors for the public and private clouds.

Before You Begin

• For Amazon Web Services (AWS) connector:
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• Create access key and password for your AWS account. This will be a unique username and password
for your Amazon account required to create a connector. See Managing Access Keys for Your AWS
Account.

• Create Virtual Private Clouds(VPC) for the required region. See Getting Started With Amazon VPC.

• Instantiate the vSRX instance in the required VPC and set the tag identifier, for example
AWS_SDSN_VSRX. This tag identifier must match with the vSRX instance tag key in AWS.

• Create a Security Group in AWS required to create a threat prevention policy for the AWS connector.

• Deploy workloads in the required VPC and set the resource tags to the workloads.

• For Microsoft Azure connector:

• Get started with Microsoft Azure. See Getting Started With Microsoft Azure.

• Create tenant ID for you Azure account. SeeManaging Access Keys for YourMicrosoft Azure Account.

To configure threat remediation for a public or private cloud, you must install and register the threat
remediation plug-in with Policy Enforcer as follows:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. Complete the configuration using the information in Table 16 on page 75.

4. Click OK.

NOTE: Once configured, you select the connector name as an Enforcement Point in your
Secure Fabric.

Table 16: Fields on the Create Connector Page for AWS and Contrail

DescriptionField

General

Enter a unique string thatmust beginwith an alphanumeric
character and can include underscores; no spaces allowed;
63 characters maximum.

Name
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Enter a description; maximum length is 1024 characters.
You should make this description as useful as possible for
all administrators.

Description

Select AmazonWeb Services, Contrail, orMicrosoft Azure
from the list to connect to your secure fabric and create
policies for this network.

Connector Type

Enter the IP (IPv4 or IPv6) address or URL of AWS,
Contrail, or Microsoft Azure.

For AWS, this field is set to www.aws.amazon.com, by
default. This is where all VPCs are located. You cannot
edit this field.

For Microsoft Azure, this field is set to
management.azure.com, by default. This is where all virtual
networks are located. You cannot edit this field.

IP Address/URL

For AWS and Microsoft Azure connectors, the port is set
to 443 by default and you cannot edit this field.

For Contrail connector, provide the port number as 8081.

Port

Enter the username of the server for the selected
connector type.

For AWS, enter the generated access key for your Amazon
account. This is not same as your Amazon account
username.

Username

Enter the password for the selected connector type.

For AWS, enter your secret password generated along
with your access key. This is not same password as your
amazon account.

Password

Enter the Azure subscription ID available per tenant basis.Subscription ID

(only for Microsoft Azure connector)

Enter the Microsoft Azure tenant ID.Tenant ID

(only for Microsoft Azure connector)
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Network Details

One ormore virtual networks under the AWS account are
discovered. They are called virtual private cloud (VPC).
Only VPCs having vSRX instances deployed aremanaged.
The VPCs are region specific. Select a region from the
Region list and the corresponding VPCs are listed. By
default, the VPCs for the first available region are listed.

Security Director suggests a default Secure Fabric site
name for the VPC, in the <connector name>_<vpc
name>_site format. Click the Secure Fabric site name to
edit it.When you edit the name, youwill also see the other
Secure Fabric sites that do not have any switches or
connectors assigned to them. You can also assign these
Secure Fabric sites to the connectors. If the edited site
name is already existing with a connector or a switch, an
alert message is shown and the Secure Fabric site name
is reverted to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one option.
If you navigate to the next page without enabling these
options, an error message is shown insisting the user to
enable either Threat Remediation or Next Generation
Firewall to proceed further.

You can get a detailed view of the VPC by hovering over
the name and clicking theDetailed View icon. See “Viewing
VPC or Projects Details” on page 92.

NOTE: You can perform search on VPCs. Search is not
supported for the site names.

Connector Type: AWS

Virtual Private Clouds
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

One or more virtual networks under the Microsoft Azure
account are discovered. These virtual networks are based
on the Azure subscription per tenant basis. A tenant can
havemore than one subscription and a single subscription
can contain one or more virtual networks.

Security Director suggests a default site name for the
project, in the <connector name>_<virtual network
name>_site format. Click the site name to edit it. When
you edit the site name, you will also see the other sites
that do not have any switches or connectors assigned to
them. You can also assign these sites to the connectors.
If the edited site name is already existing with a connector
or a switch, an alert message is shown and the site name
is reverted to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one of the
two options. If you navigate to the next page without
enabling these options, an errormessage is shown insisting
the user to enable either Threat Remediation or Next
Generation Firewall to proceed further.

You can get a detailed view of the virtual network by
hovering over the name and clicking the Detailed View
icon.

Connector Type: Microsoft Azure

Virtual Networks
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Tenant information determined from the Contrail
connector is listed.

Security Director suggests a default site name for the
project, in the <connector name>_<project name>_site
format. Click the site name to edit it. When you edit the
site name, you will also see the other sites that do not
have any switches or connectors assigned to them. You
can also assign these sites to the connectors. If the edited
site name is already existing with a connector or a switch,
an alert message is shown and the site name is reverted
to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one of the
two options. If you navigate to the next page without
enabling these options, an errormessage is shown insisting
the user to enable either Threat Remediation or Next
Generation Firewall to proceed further.

You can get a detailed view of the project by hovering
over the name and clicking the Detailed View icon. See
“Viewing VPC or Projects Details” on page 92.

NOTE: You can perform search on Project names. Search
is not supported for the site names.

Connector Type: Contrail

Project

The subnet information for Contrail, Microsoft Azure, and
AWS is determined from the respective systems. For AWS
and Microsoft Azure, subnets are the availability zones
and for Contrail, subnets are virtual networks. You can
create Policy Enforcement Groups for one or more of the
subnets, if threat remediation is selected.

Subnets for AWS, Microsoft Azure, and Contrail are
allocated to bewithin the tenant IP AddressManagement
(IPAM) scheme.

Subnets

Configuration
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Configuration
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Metadata

Specifies the resource tag information and the resource
tag values that you have determined from the projects or
VPC. The tag information appears only if the Next
Generation Firewall option is enabled.

For AWS and Microsoft Azure connector, the resource
tag values are fetched fromAWS andMicrosoft Azure for
all the endpoints and then mapped them to the Security
Director generated metadata names.

Based on the resource tag name, Security Director checks
if a metadata with the same resource tag name is already
available. If available, it automatically maps the resource
tag name to its metadata. If there is no match found,
Security Director suggests a new metadata name for the
corresponding tag. The suggestedmetadata name is same
as the resource tag name. You can also edit the suggested
metadata name and customize the resource tag name.

However, in the GeneratedMetaData Name column, you
cannot use the following predefined metadata names:

• Tenant

• Provider

• Controller

If you provide these names, an appropriate error message
is shown to choose a different name.

Select the Map option to map the resource tag to the
generated Security Director Metadata while creating the
connector instance. If the Map option is not selected, the
connector instance is created for a project or VPCwithout
any resource tags. For example, if you have multiple
resource tags for a project, you can choose one or more
resource tags to map to the corresponding generated
metadata, by selecting the Import option. The project or
VPCwith the selected resource tags are createdwhen the
connector instance is created.

Mapping of Contrail, Microsoft Azure, andAWS connector
resource tags to Security Director metadata enables you
to create the next generation firewall policy definitions
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

for the source and destination rules, based on the
metadata expressions. Policy Enforcer dynamically
determines thematching VM instances in AWS,Microsoft
Azure, or Contrail connector to the metadata expressions
and pushes the IP address content as dynamic address
groups to the enforcement points in the tenant specific
vSRX firewall instance.

In the Configuration Value column, provide any additional
information required for this particular connector
connection. For example, if the connector type is
ForeScout CounterACT, you are required to provide the
WebAPI username and password. Similarly for other
connectors if the additional configuration parameters are
required, they are listed in this column.

After the successful completion, the subnet you have
created is mapped to that particular connector instance.

For AWS and Microsoft Azure, provide the following
configuration parameters:

• SRX username—Specify the username of the vSRX
device that you have instantiated for a VPC or a virtual
network.

• SRX identifier tag—Specify the tag name of the vSRX
device, if the recommended vSRX name was not used.
If you do not specify any value for this field, Policy
Enforcer uses vSRX as a default tag name to identify the
device.

This enables discovery of this particular vSRX device in
Junos Space. This vSRX device is also added to a specific
secure fabric site.

• Infected Host Security Group—Specify the security
group name that you would want to tag an infected
workload for threat remediation.

• SRX authentication key—Specify the authentication key
file to access the vSRX device. Editing this in the grid
prompts you to either upload the authentication key
file or view an already existing uploaded authentication
key.
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Table 16: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

For Contrail, provide the following configuration
parameters:

• SRX username

• SRX password

• Infected host security group

NOTE:
• For AWS, Microsoft Azure, and Contrail connectors, the site association is achieved in the
Connectors page itself.

• When a connector is added to the site, Policy Enforcer discovers the vSRX Series associated
with the connector and assigns it to the site. Hover over the connector name to view the
corresponding vSRX with its IP address as a tool tip.

• If the mode in PE Setting page is Juniper Connected Security with SKYATP, then you must
create a SkyATP realm and assign the sites associated with the VPC or Project to the realm.
Otherwise the vSRX instances in the VPC or Project does not download the dynamic address
group objects, that is the list of workloads in the VPC or Project that match a policy metadata
expression.

Threat Remediation Workflow

Once you create an AWS, Microsoft Azure, or a Contrail connector with Threat Remediation option, a site
is created in the Secure Fabric page.

Perform the following actions for threat remediation:

1. Select Configure > Threat Prevention > Sky ATP Realms.

Select the associated Secure Fabric sites to the respective VPC, virtual networks, or Project that is
successfully added. Add the secure fabric site to a Sky ATP realm and enrol the vSRX devices to the
Sky ATP. Enroll devices by clicking Add Devices in the list view once the realm is created.

2. Select Configure > Shared Objects > Policy Enforcement Groups.

Click the add icon to create a new policy enforcement group. You will see a list of all subnets that you
have created in a VPC or virtual network. Select the required subnets for this VPC or a virtual network
and create a policy enforcement group. Associate this policy enforcement group to threat remediation
policy.
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3. Select Configure > Threat Prevention > Policies.

Click the add icon to create a new threat prevention policy. Add the threat prevention policy, including
profiles for one or more threat types. The security group that you had selected during connector
configuration is used when the host gets infected within a corresponding VPC or a virtual network.

Next Generation Firewall Workflow

When you create an AWS, Microsoft Azure, or a contrail connector with Next Generation Firewall option,
it means that for a particular VPC or a virtual network, Layer 7 firewall policy is enabled. Perform the
following actions to enable next generation firewall:

1. Select Configure > Firewall Policy.

2. Select the policy for which you want to define rules and click Add Rule.

The Create Rules page appears.

3. In the General tab, enter the name of the rule and description of the rule

4. In the Source tab, click Select for the Address(es) field to select the source address.

The Source Address page appears.

• In the Address Selection field, click By Metadata Filter option.

• In the Metadata Provider field, select PE as a provider from the list.

• In theMetadata Filter field, all the generatedmetadatas during the connector configuration are listed.
Using these metadatas, create a required metadata expression. For example, Application =Web and
Tier = App.

• In the Matched Addresses field, addresses matching the selected metadata are listed. This address
is used as a source address. For every metadata expression, a unique dynamic address group(DAG)
is created.

• Click Ok and complete configuring other parameters for the rule.

• Publish and update the configuration immediately or schedule it later.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 72

Editing and Deleting a Connector | 89

Viewing VPC or Projects Details | 92
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Creating a Policy Enforcer Connector for Third-Party
Switches

Perform the following actions to create connectors for the third-party switches.

Before You Begin

• Have your ClearPass, Cisco ISE, ForeScout, Pulse Secure server information available.

• To obtain an evaluation copy of ForeScout CounterACT to use with Policy Enforcer, click here.

• Once configure, you select the Connector as an Enforcement Point in your Secure Fabric.

• Review the “Policy Enforcer Connector Overview” on page 72 topic.

• To create a connector for a public or a private cloud, see “Creating a Policy Enforcer Connector for Public
and Private Clouds” on page 74.

To configure threat remediation for third-party devices, youmust install and register the threat remediation
plug-in with Policy Enforcer as follows:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. Complete the configuration using the information in Table 17 on page 85.

4. Click OK.

NOTE: Once configured, you select the connector name as an Enforcement Point in your
Secure Fabric.

Table 17: Fields on the Create Connector Page

DescriptionField

General

85

https://pact.ly/S1lnt3


Table 17: Fields on the Create Connector Page (continued)

DescriptionField

Enter a unique string thatmust beginwith an alphanumeric
character and can include underscores; no spaces allowed;
63 characters maximum.

Name

Enter a description; maximum length is 1024 characters.
You should make this description as useful as possible for
all administrators.

Description

Select the required third-party network of devices to
connect to your secure fabric and create policies for this
network. The available connectors are Cisco ISE, HP
ClearPass, Pulse Secure, and ForeScout CounterACT.

Connector Type

Enter the IP (IPv4 or IPv6) address of the product
management server.

IP Address/URL

Select the port to be used from the list. When this is left
blank, port 443 is used as the default.

Port

Enter the username of the server for the selected
connector type.

• ClearPass—Enter the Client ID created while setting up
the ClearPass API client. See “ClearPass Configuration
for Third-Party Plug-in” on page 105 for details.

• Cisco ISE—Enter the username you used when you
created the API Client in the Cisco ISE UI. See “Cisco
ISE Configuration for Third-Party Plug-in” on page 112.

• ForeScout—Enter the username of your DEX plugin.
See “Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 94.

Username

86



Table 17: Fields on the Create Connector Page (continued)

DescriptionField

Enter the password of the server for the selected
connector type.

• ClearPass—Enter the Client Secret string created while
setting up the ClearPass API client. See “ClearPass
Configuration for Third-Party Plug-in” on page 105 for
details.

WARNING: When the Access Token Lifetime expires,
youmust generate a newClient Secret in ClearPass and
update it here too.

• Cisco ISE—Enter the password you used when you
created the API Client in the Cisco ISE UI. See “Cisco
ISE Configuration for Third-Party Plug-in” on page 112
.

• ForeScout—Enter the password of your DEX plugin. See
“Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 94.

Password

Enter the Data Exchange (DEX) user role information to
authenticate and connect to the ForeScout connector.
See “Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 94.

DEX User Role

(For ForeScout connector type only)

Network Details
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Table 17: Fields on the Create Connector Page (continued)

DescriptionField

Connector Type:ClearPass, ForeScoutCounterACT, Pulse
Secure, and Cisco ISE

Add subnet information to the connector configuration
so you can include those subnets in groups and then apply
policies to the groups. When using Junos Space, Policy
Enforcer is able to dynamically discover subnets configured
on Juniper switches. Policy Enforcer does not have the
same insight with third-party devices.

When you add subnets as part of the connector
configuration, those subnets become selectable in Policy
Enforcement Groups.

To add subnet information, do one of the following:

• ClickUpload File to upload a text file with an IP address
list.

Note that the file you upload must contain only one
item per line (no commas or semi colons). All items are
validated before being added to the list.

OR

• Manually enter the IP addresses. For example:
192.168.0.1/24.

Click the add icon (+) to add more IP addresses.

NOTE: It is mandatory to add at least one IP subnet to a
connector. You cannot proceed to next step without
adding a subnet.

Subnets

Configuration

Provide any additional information required for this
particular connector connection. After the successful
completion, the subnet you have created is mapped to
that particular connector instance.

NOTE: For ClearPass and Cisco ISE connectors no
additional configuration information are required.

Configuration
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NOTE:
• You can associate ClearPass, Cisco ISE, Pulse Secure, or Forescout connector to a site only in
your Secure Fabric.

• When a connector is added to the site, Policy Enforcer discovers the vSRX Series associated
with the connector and assigns it to the site. Hover over the connector name to view the
corresponding vSRX with its IP address as a tool tip.

WARNING: Ensure that the correct credentials are provided for the ClearPass, Cisco
ISE, Pulse Secure, and ForeScout identity servers. If the initial connection fails, an error
message is shown only at that time. Once that message disappears, the status of
connectivity to the identity server is not shown in Policy Enforcer. Note that the identity
servers are only queried on-demand.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 72

ClearPass Configuration for Third-Party Plug-in | 105

Cisco ISE Configuration for Third-Party Plug-in | 112

Editing and Deleting a Connector | 89

Viewing VPC or Projects Details | 92

Editing and Deleting a Connector

IN THIS SECTION

Editing a Connector | 90

Deleting a Connector | 91

You can edit or delete a connector from the Connector page.
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Editing a Connector

To edit a connector:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector you want to edit , and then click the pencil icon.

The Edit Connector page appears displaying the same options that were used to create a new connector.
Note that you cannot edit the Name and IP Address/URL fields.

For the AWS connector, when you select a new region, you must enter the configuration parameters
for the VPCs in that region. This enables you to maintain different vSRX authentication keys across
different regions.

For AWS and Contrail connectors, you can enable or disable the threat remediation and next generation
firewall features. If you disable the next generation firewall feature from a project or VPC, that particular
project or VPC connector instance will be deleted. The VPCs are deleted from the corresponding
regions.

A warning message is shown if you edit the existing generated metadata name. If you edit the existing
metadata name, duplicate metadata objects are created that are associated to a firewall policy. To edit
the metadata name, select Configure > Shared Objects > Object Metadata and edit the required
metadata name. Also if the firewall policies are associatedwith this metadata, selectConfigure > Firewall
Policy > Policies and edit the corresponding metadata expression.

To delete the mapping of the tag name with the generated metadata, disable the Map option for the
corresponding project or VPC. A warning message is shown that there could be a firewall policy
associated with this metadata. Select Configure > Firewall Policy > Policies and edit the corresponding
metadata expression. The mapping is deleted at the end of the edit workflow. You can also enable the
Import option for the tags thatwere notmapped to the generatedmetadatawhile creating the connector.

3. Modify the required field values and click Save to save your changes.

If you discover a new connector instance, you can enable the threat remediation or next generation firewall
option. A new site is created when you enable one of these options. You must add these new sites to a
realm to perform the threat remediation. At the end of the edit connector workflow, a reminder message
is shown to add the sites to a realm.

90



NOTE:
• During the AWS connector editing, if you change the region, changes that you have made in
the current session are discarded. An alert message is shown when you change the region.

• During the ClearPass or Cisco ISE connector editing, you cannot delete subnets that are already
assigned to a policy enforcement group. However, you can add of any new subnets and edit
their descriptions.

Deleting a Connector

To delete a connector:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector that you want to delete, and select the delete icon (X).

Deleting a connector deletes the connector instances and its references as well. A warning message is
shown listing all the connector instances that will be deleted, before deleting the connector.

3. Click Delete to delete your selection.

If the connector instances that you want to delete has PEG assigned, a warning message is shown to
unassign the subnets from PEG first and then delete the connector, as shown in Figure 21 on page 91.

Figure 21: Deletion Failed Warning
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For AWS and Contrail connectors, if there are connector instanceswith PEG assigned, only those connector
instances are not deleted. However, other connector instances without PEG assigned are deleted.

NOTE:
• You cannot delete the ClearPass or Cisco ISE connector if its subnets are assigned to a policy
enforcement group. Youmust unassign those subnets from that particular policy enforcement
group and then delete the connector.

• You cannot delete a connector if it is assigned as an enforcement point to a site. Before deleting
a connector, you must unassign it from the site on Secure Fabric.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 72

Creating a Policy Enforcer Connector for Third-Party Switches | 85

Viewing VPC or Projects Details

To view the complete details of a VPC or a project:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector you want to edit , and then click the pencil icon.

The Edit Connector page appears displaying the same options that were used to create a new connector.

3. In the Network Details section, get a detailed view by hovering over the VPC or project name and click
the Detailed View icon before the VPC or project name.

The Detailed View page appears, as shown in Figure 22 on page 93.
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Figure 22: Detailed View Page

Table 18 on page 93 explains fields on the Detailed View page.

Table 18: Fields on the Detailed View Page

DescriptionField

Specifies name of a VPC or project.Name

Specifies the site to which the VPC or project s allocated.Secure Fabric

Specifies the connector type. For example, virtual network for Contrails and
AvailabilityZone for AWS.

Type/Zone

Specifies the IP Address Management (IPAM) subnets allocated to the respective VPC or
project.

IPAM Subnet

Specifies the group of subnets allocated to the VPC or project.

For Contrail, you will see a key value of Tier. For example, the group is called web and
assigned subnet is x.x.x.x/xx. For AWS, you will see only the group of subnets.

For Contrail, they are still group of subnets. However, each of the subnets are allocated
to a tag, for example, database, tier, application, and so on.

Group Subnets

RELATED DOCUMENTATION
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Creating a Policy Enforcer Connector for Third-Party Switches | 85

Editing and Deleting a Connector | 89

Integrating ForeScout CounterACT with Juniper
Networks Connected Security

IN THIS SECTION

Configuring the DEX Plug-in | 95

Configuring the Web API Plug-in | 99

Creating ForeScout CounterACT Connector in Security Director | 101

This topic provides instructions on how to integrate the third-party device ForeScout CounterACT with
Juniper Networks Connected Security solution to remediate threats from infected hosts for enterprises.
ForeScout CounterACT is an agentless security appliance that dynamically identifies and evaluates network
endpoints and applications the instant they connect to your network. CounterACT applies an agentless
approach and integrates with Juniper Connected Security to block or quarantine infected hosts on Juniper
Networks’ devices, third-party switches, and wireless access controllers with or without 802.1x protocol
integration.

To integrate ForeScout CounterACT with Juniper Connected Security, you must create a connector in
Policy Enforcer that enables CounterACT to connect to your secure fabric and create policies for
CounterACT. Before you configure the ForeScout CounterACT connector, youmust ensure that ForeScout
CounterACT is installed and runningwith theOpen IntegrationModule (OIM). The ForeScout OIM consists
of two plug-ins: Data Exchange (DEX) and Web API. Install both the plug-ins and ensure that they are
running. You must configure these plug-ins before you create a connector in Policy Enforcer.

If you do not have ForeScout CounterACT installed in your network, obtain an evaluation copy from here.

This topic includes the following sections:
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Configuring the DEX Plug-in

TheDEX plug-in receives API information about infected hosts from the ForeScout CounterACT connector.
Messages from infected hosts are either blocked or quarantined.

When you configure the DEX plug-in, you also configure a new property, Test, for DEX.When configured,
this property ensures that Web services are available for Policy Enforcer, monitors the network status,
and validates usernames and passwords.

To configure the DEX plug-in:

1. Select Tools > Options > Data Exchange (DEX) in the CounterACT UI.

The Data Exchange configuration page appears.

2. On the Data Exchange (DEX) page, select the CounterACTWeb Services > Accounts tab, as shown in
Figure 23 on page 95.

The DEX Accounts page appears.

Figure 23: DEX Accounts Page

3. Select Add.

The Add page appears.

4. In the Name field, enter the name for the CounterACT Web service account.
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Enter this name in the DEX User Role field (see Step 3) while configuring the ForeScout connector in
Security Director.

5. In the Description field, enter a brief description of the purpose of the Web service account.

6. In the Username field, enter the username that will be used to authorize CounterACT to access the
Web service account.

7. In the Password field, enter the password that will be used to authorize CounterACT to access this
Web service account.

8. Click OK.

9. In the Properties tab, click Add.

The General pane of the Add Property from CounterACT Web Service wizard opens, as shown in
Figure 24 on page 97.

96



Figure 24: Add Property-General Pane Page

10.Add properties such as block, quarantine, and Test, as shown in Figure 25 on page 98.

Youmust include the Test property. Otherwise, you cannot add CounterACT as a third-party connector
to Policy Enforcer successfully.
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Figure 25: DEX Properties Page

11. In the Security Settings tab, click Add and add the IP address range from where communication is
expected, as shown in Figure 26 on page 98.

Figure 26: Add IP Range Page

Click OK. The IP address appears in the IP Address Range list, as shown in Figure 27 on page 99.
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Figure 27: DEX Security Settings Page

12.On the Data Exchange (DEX) page, click Apply.

The configuration is saved and the configuration settings are applied.

Configuring the Web API Plug-in

The Web API plug-in enables external entities to communicate with CounterACT by using simple, yet
powerful Web service requests based on HTTP interaction. You configure the Web API plug-in to create
an account for Policy Enforcer integration.

To configure the Web API plug-in:

1. Select Tools > Options >Web API in the CounterACT UI.

The Web API page appears.

2. In the User Settings tab, select Add.

The Add Credentials page appears.

3. Use the same username and password that you created for the DEX configuration (see Step 6 and Step
7) and click OK, as shown in Figure 28 on page 100.
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Figure 28: Web API User Settings Page

4. Select the Client IPs tab and click Add.

Add the Policy Enforcer IP address into the access list.

5. Click OK.

The IP address appears in the IP Address Range list, as shown in Figure 29 on page 101.
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Figure 29: Web API Client IPs Page

6. Click Apply to save and apply your configuration.

Creating ForeScout CounterACT Connector in Security Director

After you configure the DEX and Web API plug-ins, you need to create a connector for ForeScout
CounterACT in Policy Enforcer.

To create a ForeScout CounterACT connector in Junos Space Security Director:

1. Select Security Director > Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. In the General tab, select ForeScout CounterACT as the connector type and provide the username,
DEX user role, and password, as shown in Figure 30 on page 102. ( The DEX user role is the one that
you created in Step 4).

Specify 443 as the port number for communication.
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Figure 30: Edit Connector Page

4. In the Network Details tab, configure the IP subnets, as shown in Figure 31 on page 102.

CounterACT treats the IP subnets as endpoints and takes action.

Figure 31: Edit Connector - Network Details Page
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5. In theConfiguration tab, specify theWebAPI username and password, as shown in Figure 32 on page 103.

Figure 32: ForeScout Connector - Configuration Tab

6. Click Finish.

A new ForeScout CounterACT connector is created.

7. Verify that the communication between Policy Enforcer and CounterACT is working.

After installing ForeScout CounterACT and configuring a connector, in the CounterACT UI, create policies
for CounterACT to take the necessary action on the infected hosts. The Hosts page lists compromised
hosts and their associated threat levels, as shown in Figure 33 on page 104.
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Figure 33: Host Information

Table 19 on page 104 shows the recommended actions performed by CounterACT on the infected hosts
that are blocked or quarantined.

Table 19: Recommended Action to Be Performed on the Infected Hosts

Action Performed by CounterACTConnection State
Infected Host Policy
Enforcer Action

Apply access control list (ACL) to block inbound and outbound
traffic for a specific MAC address.

WiredBlocked

Apply WLAN block on the endpoint, which will block the traffic
based on the wireless MAC address.

Wireless

Apply CoA.Dot1x

Apply VLAN. This action is specified by Policy Enforcer.WiredQuarantined

Apply VLAN. This action is specified by Policy Enforcer.Wireless

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 72
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Creating a Policy Enforcer Connector for Third-Party Switches | 85

ClearPass Configuration for Third-Party Plug-in

Policy Enforcer's ClearPass Connector communicateswith the Clearpass Radius server using the Clearpass
API. As part of threat remediation, Policy Enforcer's Clearpass Connector uses enforcement profiles. This
section provides information for configuring Clearpass so that Policy Enforcer can invoke the appropriate
enforcement profiles.

As part of the configuration, on ClearPass you will create two enforcement profiles, one for quarantine
and one for terminate. Then you will use them in the ClearPass enforcement policy. Once ClearPass is
configured, you will configure a ClearPass Connector on Policy Enforcer.

NOTE:
• Always use a third-party switch that supports 802.1x, Radius CoA, Radius Accounting, and
DHCP snooping features. Enabling DHCP snooping is important which configures the Radius
attribute, Framed-IP-Address. Only after configuring Framed-IP-Address, Policy Enforcer can
detect the session related to the infected-host IP addresses and terminate the session.

• The stale sessions in ClearPass cannot be terminated and therefore, the actual East-West
traffic block will not be active until you reauthenticate the session. You must ensure to clear
the stale sessions in ClearPass frequently.

On ClearPass you will configure the following:

• API Client

• Custom Attribute

• Enforcement Profiles

• Enforcement Policy

To configure the API Client:

1. In ClearPass, navigate to Administration > API Services > API Clients and create a client with the
following attributes:

NOTE: You must login as ClearPass Guest to see the API services menu.
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• Client ID: sdsnclient

• Enabled: Select the check box for Enable API client

• Operator Profile: Create a profile from Administrator > Operator Logins > Profiles for the API client
with minimum access privileges as shown in Figure 34 on page 106.

Figure 34: ClearPass API Client Operator Profile Minimum Privileges

• Grant Type: Select Client credentials (grant_type = client_credentials)

• Client Secret: Copy and save this. It will not be shown again.

• Access Token Lifetime: Enter 5 minutes as a time-frame.
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Figure 35: ClearPass Edit API Client

2. Click Save Changes.

To configure a Custom Attribute:

1. Select ClearPass Policy Manager and navigate to Administration > Dictionaries > Attributes to create
a custom attribute. Then add it into the Dictionary: sdsnEpStatus. Enter the following:

• Entity Type: Endpoint

• Name: sdsnEpStatus (Note that you must use this name - sdsnEpStatus)

• Data Type: List

• Is Mandatory: Yes

• Allowed Values: healthy, blocked, quarantine

• Default Value: healthy
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Figure 36: ClearPass Edit Attribute

2. Click Save.

To configure Enforcement Profiles:

1. In ClearPass, navigate to Configuration > Enforcement > Profiles and create two enforcement profiles.

2. Profile 1: Create the following profile to quarantine infected endpoints:

• Name: Name of the enforcement profile

• Description: Quarantine profile for Juniper Connected Security

• Type: RADIUS

• Action: Accept
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Figure 37: ClearPass Enforcement Profile: Quarantine

NOTE: The data displayed at the bottomof the screen is for example and not for configuration
purposes. Note that the 4th attribute can be set for the accounting packets to be sent by the
NAS device to the Clearpass Radius server.

3. Profile 2: Create the following profile to block infected endpoints:

NOTE: To configure this profile, copy the default system profile Juniper Terminate Session
and edit the profile name and attributes.

• Name: JNPR SDSN Terminate Session

• Description: Block profile for SDSN

• Type: RADIUS_CoA

• Action: Disconnect
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NOTE: If there are any vendor-specific additional attributes required for the Terminate COA,
those needs to be added here. For example, in the case of Juniper Networks TrapezeWireless
Clients, the JNPR SDSN Terminate Session profile requires two additional attributes:
NAS-IP-Address and User-Name.

Figure 38: ClearPass Enforcement Profile: Terminate

Configure an Enforcement Policy:

In ClearPass, navigate toConfiguration > Enforcement > Policies. Both profiles you createdmust be added
to all the enforcement policies for endpoints addressed by Policy Enforcer.
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Figure 39: ClearPass Enforcement Policy

NOTE: Rules Evaluation should be set to "First applicable."

NOTE: Make sure the default termination enforcement profile for each of the supported vendors
is not superseded by any of its enforcement profile copies. Also make sure that all the attributes
required for termination are set in the profile. (As in the previous Juniper Networks Trapeze
Wireless Clients example.)

Enable Insight:

1. In ClearPass, navigate to Administration > Server Manager > Server Configuration for the server in
use.

2. Enable Insight in the System tab.

Set the Log accounting Interim-update Packets as TRUE:

1. In ClearPass, navigate to Administration > Server Manager > Server Configuration for the server in
use.

2. Select the Service Parameters tab.
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3. In the Select Service drop down list, select Radius Server and set the Log accounting Interim-update
Packets as TRUE.

4. Proceed to “Creating a Policy Enforcer Connector for Third-Party Switches” on page 85 to finish the
configuration with Policy Enforcer.

RELATED DOCUMENTATION

Creating a Policy Enforcer Connector for Third-Party Switches | 85

Policy Enforcer Connector Overview | 72

Cisco ISE Configuration for Third-Party Plug-in

Policy Enforcer's Cisco ISE Connector communicates with the Cisco Identity Services Engine server using
the Cisco ISE API. As part of threat remediation, Policy Enforcer's Connector uses enforcement profiles.
This section provides information for configuring Cisco ISE so that Policy Enforcer can invoke the appropriate
enforcement profiles.

As part of the configuration, on Cisco ISE you will create two enforcement profiles, one for quarantine
and one for terminate. Then you will use them in the Cisco ISE enforcement policy. Once Cisco ISE is
configured, you will configure a Cisco ISE Connector on Policy Enforcer.

On Cisco ISE you will configure the following:

• Change policy modes

• Create an API client

• Configure network profiles

• Add a custom attribute

• Configure authorization profiles

• Set an authorization policy
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On Cisco ISE, the Simple Mode policy model is selected by default. For creating an API client, Policy Sets
should be enabled.

• Navigate to Administration > System > Settings > Policy Sets and Enable Policy Setsmode.

You are prompted to login again after changing the mode.

Figure 40: Cisco ISE: Enable Policy Sets Mode

Create an API Client:

1. Using the Cisco ISE web UI, create an Admin User by navigating to Administration > System > Admin
Access > Administrator > Admin User.

2. Create an Admin User and assign it to the following Admin Groups: ERS Admin,MnT Admin.

Make note of the username and password. You will need them when you configure the connector
portion in Policy Enforcer later on.

Figure 41: Cisco ISE: Create Admin User and Assign to Admin Groups

Enable the External RESTful Services API (ERS) for the Administration Node:

1. Navigate to Administration > System > Settings >ERS Settings and select Enable ERS for Read/Write.
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2. Click Save.

Figure 42: Cisco ISE: Enable ERS

Configure network profiles:

Devices managed by ISE must support RADIUS CoA and have the proper network profiles assigned to
handle the CoA commands sent by the ISE server:

1. Navigate to Administration > Network Resources > Network Device Profiles and verify the existing
network device profile list.

If you are creating a new profile, proceed to the next step for information.
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Figure 43: Cisco ISE: Network Device Profiles List

2. If you are configuring a new profile, you must minimally set the following:

• Enable RADIUS and add a corresponding dictionary in the supported protocol list.

Figure 44: Cisco ISE: Network Device Profile, Enable RADIUS

• Enable and configure the Change of Authorization (CoA) according to the figure below.
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Figure 45: Cisco ISE: Configure Change of Authorization (CoA)

• Configure the Disconnection and Re-authenticate operation with the proper RADIUS attributes and
vendor specific VSA to handle the standard disconnect and reauthenticate operations. Below is the
sample configuration for Juniper’s EX devices.

Figure 46: Sample Configuration for Juniper EX
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Configure a custom attribute.

1. Navigate to Administration > Identity Management > Settings > Endpoint Custom Attribute and add
attribute sdsnEpStatus with type string.

Figure 47: Cisco ISE: Add Attribute sdsnEpStatus

2. Verify the attribute under Policy > Policy Elements > Dictionaries > System > Endpoints.
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Figure 48: Cisco ISE: Verify Attribute

3. Navigate to Policy > Policy Elements > Conditions > Authorization > Simple Conditions. Add there
authorization simple conditions using the sdsnEpStatus attribute you created.

In the screen below,, there are three conditions created using sdsnEpStatus attribute. The condition
names do not need to be the same as in the screen here, but the expressions must be matched. These
conditions will be used in Policy Sets to handle the threat remediation for managed endpoints as
described later in the Policy Sets setting section. Only the sdsnEpStatus-blocked and
sdsnEpStatus-quarantine conditions will be used there. sdsnEpStatus-healthy is created for fulfillment
purpose and can be ignored for now.

118



Figure 49: Cisco ISE: Configure Simple Conditions, Match Expression

Figure 50: Cisco ISE: Configure Simple Conditions, Match Expression
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Configure permission/authorization profiles.

You can create the authorization profiles corresponding to “block” and “quarantine” actions as fits your
needs. In the sample configuration provided here, the block action will result as total denial access to the
network, and the quarantine profile will move the endpoint to another designated VLAN.
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1. Navigate to From Policy > Policy Elements > Results > Authorization > Authorization Profiles.

Refer to the figures below for sample configurations.

Figure 51: Cisco ISE: Configure Authorization Profiles

Figure 52: Cisco ISE: Configure Authorization Profiles
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NOTE: For blocking a host, the default ‘DenyAccess’ profile is used.

Set the authorization policy:

1. Create two rules as Local Exceptions, applying the conditions and authorization/permission profiles
we created in the previous step. Names may be different, but these two rules must be at the top of
the Exception list.

Refer to the figure below for a sample configuration.
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Figure 53: Cisco ISE: Local Exception Rules, Example

NOTE: Find this under Policy > Policy Sets > Authorization Policy.

2. Proceed to “Creating a Policy Enforcer Connector for Third-Party Switches” on page 85 to finish the
configuration with Policy Enforcer.
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Integrating Pulse Policy Securewith JuniperNetworks
Connected Security

IN THIS SECTION
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Creating Pulse Policy Secure Connector in Security Director | 134

Troubleshooting | 137

Overview

This topic provides instructions on how to integrate the third-party device Pulse Policy Secure(PPS) with
Juniper Networks Connected Security solution to remediate threats from infected hosts for enterprises.
The Juniper Connected Security solution provides end-to-end network visibility that enables enterprises
to secure their entire physical and virtual networks. PPS provides visibility into the network by detecting
and continuously monitoring the network. Using the threat detection and policy enforcement, the PPS
and Juniper Connected Security solution automates the network security and supports centralised
management, in a multi-vendor environment.

PPS integrates with Juniper Networks Connected Security solution through RESTful APIs and takes
appropriate action based on the admission control policies. The PPS integration with Juniper Connected
Security solution detects and enforces threat prevention policies and provides a collaborative and
comprehensive approach towards complete network security. It enables users to leverage the existing
trusted threat feed sources to provide a consistent and automated defense across diverse environments.

Benefits of the Pulse Policy Secure Integration with Juniper Connected Security

• PPS has more visibility of endpoints connected to the network.

• Based on the threat alerts received from Juniper Connected Security, PPS enhances the security by
isolating or acting at the endpoint level.
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Deployment of Pulse Policy Secure with Juniper Connected Security

The following high level workflow describes the deployment of PPS with Juniper Connected Security. PPS
receives the threat alert information from Juniper Connected Security solution and takes an action on the
endpoint based on the admission control policies.

1. User successfully authenticates with the PPS server.

2. User downloads a file from the Internet. The perimeter firewall (SRX Series device) scans the file and
based on the user-defined policies, sends the scanned file to Sky ATP for analysis.

3. Sky ATP detects that the file contains malware, identifies the endpoint as an infected host, and notifies
the SRX Series device and Policy Enforcer.

4. Policy Enforcer downloads the infected host feed and sends a threat action to PPS.

5. The PPS server quarantines or blocks the endpoint.

PPS tracks the infected host and does not allow the infected host to acquire full access until the endpoint
is disinfected. When the host is disinfected and cleared from Sky ATP or Policy Enforcer, PPS receives
a clear event from the Policy Enforcer connector. After receiving the clear event, PPS removes the
infected host. The host is now authenticated and an appropriate role is assigned to it.

Configuring Pulse Policy Secure with Juniper Connected Security

IN THIS SECTION

Admission Control Template | 130

Admission Control Policies | 131

Admission Control Client | 133

The network security devices are configured with PPS for admission access control.
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A high-level overview of the configuration steps required to set up and run the integration is described
below:

1. The administrator configures the basic PPS configurations such as creating an authentication server,
authenticating realm, user roles, and role mapping rules. To know more about configuring your PPS,
see Pulse Policy Secure Administration Guide.

2. Configure Policy Enforcer as a client in PPS. PPS acts as a RESTful API server for Policy Enforcer.

The RESTful API access for the admin user must be enabled by accessing the serial console or
alternatively from the PPS admin user interface (UI). Select Authentication>Auth
Server>Administrators>Users. Click Admin and enable the Allow access to REST APIs option.

3. Configure PPS to block or quarantine the endpoint based on the threat prevention policy.

You must configure the admission control client to obtain the Policy Enforcer IP address that sends
events to PPS and admission control policy to understand the PPS event types such as,
events-block-endpoint, quarantine-endpoint, clear-blocked-endpoint, and clear-quarantine-endpoint.

4. Configure the Switches or WLC as RADIUS Client in PPS by selecting Endpoint Policy>Network
Access>Radius Clients>New Radius Client. The switch is configured with PPS as a RADIUS server.

5. Configure RADIUS return attribute policies, to define the action upon receiving the quarantine event.

• Quarantine using VLANs:

The PPS determines which quarantine VLAN to send to RADIUS Client when a quarantine-endpoint
event is received, as shown in Figure 54 on page 127.
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Figure 54: RADIUS Return Attributes for Quarantine-Host

• Quarantine using ACLs:

For environments that has flat VLAN, the PPS provides the ability to quarantine users by applying a
preconfigured firewall filter. Also, this is a preferredmethod in environments that use static IP address
assignment for end devices.

The following example shows the firewall filter configuration on the switch. The firewall filter name
is then passed on as RADIUS return attribute, as shown in Figure 55 on page 129.
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Configure the PERMIT-PULSE-ONLY and PERMIT-ALL firewall filters on the switch using the following
commands:

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY termpps fromdestination-address
10.92.81.113/32

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term pps then accept

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term dhcp_allow from
destination-port 67

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term dhcp_allow then accept

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term pps-discard then discard

deactivate firewall family ethernet-switching filter PERMIT-PULSE-ONLY

set firewall family ethernet-switching filter PERMIT-ALL termALLOW-ALL fromdestination-address
0.0.0.0/0

set firewall family ethernet-switching filter PERMIT-ALL term ALLOW-ALL then accept

deactivate firewall family ethernet-switching filter PERMIT-ALL

To assign these filters in PPS, select Endpoint Policy>Network Access>Radius Attributes>Return
Attributes.
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Figure 55: RADIUS Return Attributes for Clear-Quarantine
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NOTE:
• Ensure that PPS has the endpoint IP address for the enforcement to work correctly.

• Since the endpoint IP address is mandatory, deployments where the user is behind a NAT
might not work as expected. This is because PPSmight have the actual IP address, and Juniper
Connected Security might send the NATed IP address.

• To receive the endpoint IP address (accounting information) by PPS, you must use the Pulse
Secure client on endpoints when they are connected to EX4300 Series switches.

Admission Control Template

The admission control template provides a list of possible events that can be received from the network
security device alongwith the regular expression to parse themessage. The template also provides possible
actions that can be taken for an event.

PPS is loadedwith default templates for Policy Enforcer. The administrators can create templates for other
security devices and upload those templates.

To view the admission control templates, select Endpoint Policy>Admission Control>Templates, as shown
in Figure 56 on page 130. You can view the list of configured integration templates with the list of network
security devices and the supported protocol types.

Figure 56: Pulse Secure Templates Page
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Admission Control Policies

The admission control policies define the list of actions to be performed on PPS for the user sessions. The
actions are based on the event and the severity of the information received from the network security
device.

To view and add the new integration policy:

1. Select Endpoint Policy>Admission Control>Policies.

2. Click New Policy.

The New Policy page appears, as shown in Figure 57 on page 131.

Figure 57: Pulse Secure - New Policy Page

3. Enter the policy name.

4. Select Juniper Networks Policy Enforcer as a template.

5. In the Rule on receiving section, select one of the following event types and the severity level. The
event types and the severity level are based on the selected template.
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The following event types are supported on sessions:

• Block-endpoint—Blocks the hostMACAddress on the PPS permanently. If the administrator chooses
to clear the blocked endpoint, it can be cleared either by using the Junos Space Security Director
application or by using the PPS Administration UI.

• Quarantine-endpoint (Change user roles)—Changes the roles assigned to the user on PPS so that
restrictions or privileges for the user can be changed. The administrator can choose to apply these
roles permanently or temporarily. If it is permanent, system is directly quarantined regardless of
which network it connects to.

• Clear Blocked Endpoint—Clears a previously blocked MAC Address.

• Clear Quarantined Endpoint—Clears a previously quarantined MAC Address.

6. In the then perform this action section, select the following desired action:

• Select a role and assign it to the endpoint to put that endpoint into a quarantine network.

• In the Make this role assignment option, specify the following actions:

• Permanent—To apply the role assignment permanently. This is the recommended option. Choose
this option for the action to persist.

• For this session only—To apply the role assignment only for the current session.

7. In the Roles section, specify the following options:

• Policy applies to ALL roles—To apply the policy to all users.

• Policy applies to SELECTED roles—To apply this policy only to users who are mapped to roles in the
Selected roles list. You must add roles to this list from the Available roles list.

• Policy applies to all roles OTHER THAN those selected below—To apply this policy to all users except
for those who are mapped to the roles in the Selected roles list. You must add roles to this list from
the Available roles list.

NOTE: These options are applicable to both quarantine and block actions.

8. Click Save changes.

Once the policy is created, you can see the summary page. Figure 58 on page 133 shows the different
policies created for different events with different user roles.

132



Figure 58: Pulse Secure - Policies Configure Page

Admission Control Client

The admission control clients are the network security devices on which the syslog forwarding is enabled.
The messages are received by the syslog server module running on PPS.

To add a client:

1. Select Endpoint Policy>Admission Control>Clients.

2. Click New Client.

The New Client page appears, as shown in Figure 59 on page 134.
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Figure 59: Pulse Secure - New Client Page

3. Enter the name of the Juniper Networks Policy Enforcer. This is added as a client in the PPS.

4. Enter the description.

5. Enter the IP address of the client.

6. Select the template used by the client: JuniperNerworks-Policy Enforcer-HTTP-JSON.

7. Click Save Changes.

Policy Enforcer is added a new client in the PPS.

Creating Pulse Policy Secure Connector in Security Director

Once you add Policy Enforcer as a client in PPS, create a connector for PPS to configure the Juniper
Connected Security to send the event information.
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To create a connector for PPS and configure Juniper Connected Security using Security Director:

1. Select Security Director>Administration>Policy Enforcer>Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears, as shown in Figure 60 on page 135.

Figure 60: Create Connector Page

3. In the General tab, select Pulse Policy Secure in the ConnectorType list.

4. In the IP Address/URL field, enter the IP address of PPS.

5. Retain the default port number as 443.

6. Enter the username and password of PPS.

Note that you must have enabled the REST API access on PPS (Authentication > Auth Server >
Administrators > Users > click “admin”, enable Allow access to REST APIs).

7. Click Next.

8. In the Network Details section, configure the IP subnets, as shown in Figure 61 on page 136.
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Figure 61: Create Connector Network Details Page

9. In the Configuration tab, provide any additional information required for this specific connector
connection.

10.Click Finish.

Once the configuration is successful the following page is displayed, as shown in Figure 62 on page 136.

Figure 62: Connectors Page

11.Verify that the communication between Policy Enforcer and PPS is working.

After installing PPS and configuring a connector, in the PPS UI, create policies for PPS to take the
necessary action on the infected hosts.
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Troubleshooting

The following troubleshooting logs are available:

• To verify the event logs on PPS, select System>Log/Monitoring>Events.

You can verify that the event logs are generated every time when an event is received from Policy
Enforcer, as shown in Figure 63 on page 137.

Figure 63: Pulse Secure Events Page

• To verify the user login related logs such as realm, roles, username, and IP address, select System>Logs
& Monitoring>User Access.

• To verify the reports, select System>Reports>Infected Hosts.

You can verify whether the quarantined or blocked host is listed in the Infected Devices report. This
report lists the MAC address, IP address, and the device status, as shown in Figure 64 on page 138.
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Figure 64: Infected Hosts Reports Page

• To enable the debug logs for troubleshooting, selectMaintenance>Troubleshooting>Monitoring>Debug
Log, as shown in Figure 65 on page 138.

Figure 65: Debug Log Monitoring Page

• To troubleshoot any issues on the Policy Enforcer, download and verify the Policy Enforcer logs from
Security Director>Administration>Policy Enforcer>Settings page, as shown in Figure 66 on page 139.
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Figure 66: Policy Enforcer Settings Page

• The administrators can also verify the Hosts table from Sky ATP to check the status of the host, as shown
in Figure 67 on page 139.

You can clear the host entry if the State Of Investigation field value is Resolved-Fixed.

Figure 67: Sky ATP Hosts Page
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Using Guided Setup for Sky ATP with Juniper
Connected Security

Guided Setup is the most efficient way to complete your Sky ATP with Juniper Security configuration. To
locate Guided Setup, navigate toConfigure >Guided Setup >Threat Prevention in the Junos Space Security
Director Portal.

Before You Begin

• The Sky ATP Configuration type you select on the Policy Enforcer Settings page determines the guided
setup process. Guided setup provides all the configuration items you need for your chosen type. See
“Sky ATP Configuration Type Overview” on page 33 for details on each configuration type.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 70 for more information.

• Ensure that all the devices that you want to set up threat prevention for are already discovered and
available on Junos Space. See Overview of Device Discovery in Security Director.

• Ensure that you install the proper Schema that is suitable with the OS Version of the device.

• Ensure that device version should not be less than 15.x.

• A Sky ATP license and account are needed for all Sky ATP Configuration Types. (Sky ATP with Juniper
Connected Security, Sky ATP, and Cloud Feeds only). If you do not have a Sky ATP license, contact your
local sales office or Juniper Networks partner to place an order for a Sky ATP premium or basic license.
If you do not have a Sky ATP account, when you configure Sky ATP, you are redirected to the Sky ATP
server to create one. Please obtain a license before you try to create a Sky ATP account. Refer to
“Obtaining a Sky ATP License” on page 62 for instructions on obtaining a Sky ATP license.

• There are some concepts you should understand before you begin the configuration. We recommend
that you read about them here in advance. “Policy Enforcer Configuration Concepts” on page 32.

This video provides a complete overview of how you can set up use Policy Enforcer threat prevention to
blockmalicious servers and domains. You can refer to the procedure below for more elaborate instructions.

Video: Using Guided Setup for Set Up Threat Prevention
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The Guided Setup process offers the following steps for configuring Sky ATP with Juniper Connected
Security threat prevention.

1. Navigate to theGuided Setup page from theConfiguration >Guided Setup > Threat Preventionmenu.

The Threat Prevention Policy Setup page appears as shown in Figure 68 on page 142.

Figure 68: Threat Presentation Guided Setup

2. Click Start Setup to begin the guided setup.

The guided setup takes you through the various configuration, the first being Tenants, as shown in
Figure 69 on page 143.

3.
NOTE: This step is not applicable for SRX Series devices. Tenants are only applicable for MX
Series devices.

Create a tenant representing an enterprise by clicking + on the top-right corner of the page. The Create
Tenant page appears.

Use the instructions provided in section “Create Secure Fabric Tenants” on page 172 to create a tenant.

NOTE: When a tenant is created, a VRF instance is assigned to the tenant. When a site is
associated with this tenant, only those devices that have the VRF instance associated with
the tenant can be added to the site.
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Click OK to move on to the next step.

The Secure Fabric page appears.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

Figure 69: Threat Prevention Configuration

4. A Secure Fabric is a collection of network devices (switches, routers, firewalls, and other security
devices), used by users or user groups, to which policies for aggregated threat prevention are applied.
Create a Secure Fabric by clicking + on the top-right corner of the page. The Create Site page appears.

Use the instructions provided in section “Creating Secure Fabric and Sites” on page 167 to create a site.

After you create a site, youmust add the devices for which youwant to apply a common security policy,
to the site. To do so, click Add Enforcement Points in the Enforcement Points column of a device or,
alternately select a device and click Add Enforcement Points on the top-right corner of the page. Use
the instructions provided in section “Adding Enforcement Points” on page 164 to add endpoints to the
site.

NOTE:
• A device can belong to only one site and you must remove it from any other site where it
is used.

• Firewall devices are automatically enrolled with Sky ATP as part of this step. No manual
enrollment is required.

You can find the newly created Secure Fabric on the Devices page.

Click OK to move on to the next step.

The Policy Enforcement Group page appears.
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5. A policy enforcement group is a grouping of endpoints ready to receive advance threat prevention
policies. Create a policy enforcement group by clicking + on the top-right corner of the page. The Policy
Enforcement Group page appears.

Use the instructions provided in section “Creating Policy Enforcement Groups” on page 173 to create
a policy enforcement group.

You can find the newly created policy enforcement group on the Configure > Shared Objects page.

Click OK to move on to the next step.

The Sky ATP Realm page appears.

6. A security realm is a group identifier for an organization used to restrict access to Web applications.
You can create one or multiple realms. If you have not created a realm from within your Sky ATP
account, you can create and register it here by clicking the + sign on the top-right corner of the page.

Use the instructions provided in section “Creating Sky ATP Realms and Enrolling Devices or Associating
Sites” on page 159 to create and register a realm, and then enroll SRX Series devices into the realm.

If a realm is already created with a site assigned, all devices in a site are listed under the Devices in
Site(s) column that includes EX Series, SRX Series, all enforcement points, and devices that are originally
from a realm. Devices that are marked as perimeter firewall devices are listed under the Perimeter
Firewall column.

Click OK to move on to the next step.

The Threat Prevention Policy page appears.

7. Create a threat prevention policy by clicking + on the top-right corner of the page. The Create Threat
Prevention Policy page appears.

Use the instructions provided in section “Creating Threat Prevention Policies” on page 178 to create a
threat prevention policy.

The newly created threat prevention policy is available on page Configure > Threat Prevention >
Policies.

Click OK to move on to the next step.

The Geo IP page appears.

8. (Optional) Geo IP refers to the method of locating a computer terminal's geographic location by
identifying that terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to
geographical regions. By mapping IP address to the sources of attack traffic, the geographic regions of
origin can be determined, giving you the ability to filter traffic to and from specific locations in the
world. Create a Geo IP by clicking + on the top-right corner of the page. The Create Geo IP page appears
as shown in Figure 70 on page 145.

Use the instructions provided in section “Creating Geo IP Policies” on page 186 to create a Geo IP.
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Click Finish to move on to the Summary page.

The Geo IP page appears.

Figure 70: Create Geo IP

9. The last page is a summary of the parameters you have configured using quick setup. ClickOK to create
the threat prevention policy. The Policies page appears with the newly created policy listed.

10.You must apply your new or edited policy configuration to Policy Enforcer in order for the policy
configuration to go live. In order to do that, click the Ready to Update link in the Status column. The
Threat Policy Analysis page appears.

Use the Threat Policy Analysis page to view your pending policy changes in chronological order. Click
the View Analysis link to view the changes.

In the Action section, you can choose to: Update now to , Update later, or Save the changes without
updating.

• Update now—Apply the policy configuration immediately.
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• Update later—Apply the policy configuration at a scheduled date and time of your choice.

• Save the changeswithout updating—Save the policy changeswithout applying them to Policy Enforcer.
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Using Guided Setup for Sky ATP

Guided Setup is the most efficient way to complete your initial configuration. Locate Guided Setup from
the Configuration > Guided Setup > Threat Prevention menu.

• The Sky ATP Configuration type you select on the Policy Enforcer Settings page determines the guided
setup process. Guided setup provides all the configuration items you need for your chosen type. See
“Sky ATP Configuration Type Overview” on page 33 for details on each configuration type.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 70 for more information.

• A Sky ATP license and account are needed for all Sky ATP Configuration Types. (Sky ATP with Juniper
Connected Security, Sky ATP, and Cloud Feeds only). If you do not have a Sky ATP license, contact your
local sales office or Juniper Networks partner to place an order for a Sky ATP premium or basic license.
If you do not have a Sky ATP account, when you configure Sky ATP, you are redirected to the Sky ATP
server to create one. Please obtain a license before you try to create a Sky ATP account. Refer to
“Obtaining a Sky ATP License” on page 62 for instructions on obtaining a Sky ATP license.

• There are some concepts you should understand before you begin the configuration. Read “Sky ATP
Overview” on page 23 for further information.

Click Start Setup from Configuration > Guided Setup > Threat Prevention to begin.

1. Add a Sky ATP Realm—If you have not created a realm from within your Sky ATP account, you can
create it here by clicking the + sign. Once you add a realm, you can enroll SRX Series devices into the
realm. A security realm is a group identifier for an organization used to restrict access to Web
applications. You can create one or multiple realms. See “Sky ATP Realm Overview” on page 190 for
information. A realm has the following configuration fields

• Username and Password—These are credentials you must provide, obtained through your Sky ATP
account.

• Realm—This is the name of the realm you are creating.

2. Click Add devices to enroll them in threat prevention before proceeding to the next step. Devices
designated as perimeter firewalls are automatically enrolled with Sky ATP.

3. Create a Policy—You create a name for the policy, choose one or more profile types depending on the
type of threat prevention this policy provides (C&C Server, Infected Host, Malware), and select a log
setting.

• Once configured, threat prevention policies are located under Configure > Threat Prevention >
Policies. A policy has the following fields:
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• Name and Description.

• Profiles—The type of threat this policy manages:

• C&C Server (Command and Control Server)—A C&C server is a centralized computer that issues
commands to botnets (compromised networks of computers) and receives reports back from
them. A C&C profile provides information on C&C servers that have attempted to contact and
compromise hosts on your network. Information such as IP address, threat level, and country of
origin are gathered.

• Infected Host—An infected host profile provides information on compromised hosts and their
associated threat levels. Host information includes IP address, threat level, blocked status, when
the threat was seen, command and control hits, and malware detections.

• Malware—A malware profile provides information on files downloaded by hosts and found to
be suspicious based on known signatures or URLs. The filename, file type, signature, date and
time of download, download host, URL, and file verdict are gathered.

• Logging—All traffic is logged by default. Use the pulldown to narrow the types of traffic to be
logged.

4. Geo IP—Geo IP refers to themethod of locating a computer terminal's geographic location by identifying
that terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to geographical
regions. By mapping IP address to the sources of attack traffic, geographic regions of origin can be
determined, giving you the ability to filter traffic to and from specific locations in the world. For Geo
IP, you configure the following:

• Name and Description

• Countries—Select the check box beside the countries in the Available list and click the > icon tomove
them to the Selected list. The countries in the Selected list will be included in the policy and action
will be taken according to their threat level.

• Block Traffic—Choose what traffic to block from the selected countries. Incoming traffic, Outgoing
traffic, or Incoming and Outgoing traffic.

5. The last page is a summary of the items you have configured. ClickOK to be taken to the Policies page
under Configure > Threat Prevention, and your policy is listed there.

NOTE: When you are using Sky ATP without Policy Enforcer, you must assign the policy to a
firewall rule before it can take affect. Navigate to Configure > Firewall Policy > Policies. In the
Advanced Security column, click an existing item to access the Edit Advanced Security page and
select the Threat Prevention Policy from the Threat Prevention pulldown list.
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Using Guided Setup for No Sky ATP (No Selection)

Guided Setup is the most efficient way to complete your initial configuration. Locate Guided Setup from
the Configuration > Guided Setup > Threat Prevention menu.

You would make no Sky ATP selection to configure Juniper Connected Security using only custom feeds.
Custom feeds are the only threat prevention type available if you make no selection for Sky ATP
Configuration Type in the Policy Enforcer Settings page.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 70 for more information.

• There are some concepts you should understand before you begin the configuration. It is recommended
you read about them here in advance. “Policy Enforcer Configuration Concepts” on page 32.

The Guided Setup process offers the following steps for configuring threat prevention with custom feeds
(No Sky ATP selection). Click Start Setup to begin.

1. Tenants—You can create a tenant representing an Enterprise. When a tenant is created, a VRF is
assigned to the tenant. When a site is associated with this tenant, only those devices that have the
VRF associated with the tenant can be added to the site.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

2. Secure Fabric—Secure Fabric is a collection of network devices (switches, routers, firewalls, and other
security devices), used by users or user groups, to which policies for aggregated threat prevention are
applied. Once created, secure fabric is located under Devices. For secure fabric, the following is
configured:

• Sites—A site is a collection of network devices participating in threat prevention. Using quick setup,
you can create your own site, but note that a device can only belong to one site and youmust remove
it from the any other site where it is used to use it elsewhere.

Click Add Devices in the Device Name column or in the IP address column to add devices to a site.
Using the check boxes in the device list, you should indicate which devices are firewalls or switches.

3. Policy Enforcement Group—A policy enforcement group is a grouping of endpoints ready to receive
advance threat prevention policies. Create a policy enforcement group by adding endpoints (firewalls
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and switches) under one common group name and later applying a security policy to that group. For
policy enforcement group, the following is configured:

• Once configured, policy enforcement groups are located under Configure > SharedObjects. A policy
enforcement groups has the following fields:

• Name and Description.

• Group Type—IP Address, Subnet, or Location

• Endpoint—IP addresses included in the group

4. Custom Feeds— Policy Enforcer uses threat feeds to provide actionable intelligence to policies about
various types of threats. These feeds can come from different sources. In this case, the feeds are
customized by adding IP addresses, domains, and URLs to your own lists.

The following types of custom threat feeds are available:

• Dynamic Address—A dynamic address is a group of IP addresses that can be imported from external
sources. These IP addresses are for specific domains or for entities that have a common attribute
such as a particular undesired location that poses a threat. You can then configure security policies
to use the dynamic addresses within a security policy.

• Whitelist—An allowlist contains known trusted IP addresses, URLs, and domains. Content downloaded
from locations on the allowlist does not have to be inspected for malware.

• Blacklist—Ablocklist contains known untrusted IP addresses, URLs, and domains. Access to locations
on the blocklist is blocked, and therefore no content can be downloaded from those sites.

• Infected Host—Infected hosts are hosts known to be compromised.

NOTE: The Juniper Sky ATP advanced anti-malware detection of the infected host is not
supported in SRX Series 300 and SRX Series 320 devices, if these devices are running Junos
OS release prior to 18.3R1.

5. Threat Prevention Policy—A threat prevention policy requires you to create a name for the policy,
choose one or more profile types depending on the type of threat prevention this policy provides
(infected hosts), and select a log setting. Once configured, you apply policies to policy enforcement
groups.

• Once configured, threat prevention policies are located under Configure > Threat Prevention >
Policies. A policy has the following fields:

• Name and Description.

• Profiles—The type of threat this policy manages:
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• Infected Hosts—An infected host profile would provide information on compromised hosts and
their associated threat levels. Host information includes IP address, threat level, blocked status,
when the threat was seen, command and control hits, and malware detections.

• Logging—All traffic is logged by default. Use the pulldown to narrow the types of traffic to be
logged.

• Group—Once your policy is created, it is applied to the policy enforcement group.

6. The last page is a summary of the items you have configured using quick setup. Click OK to be taken
to the Policies page under Configure > Threat Prevention > Policies and your policy is listed there.

7. You must update to apply your new or edited policy configuration. Clicking the Ready to Update link
takes you the Threat Policy Analysis page. See “Threat Policy Analysis Overview” on page 185. From
there you can view your changes and choose to Update now, Update later, or Save them in draft form
without updating.
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Configuring SkyATPwith Juniper Connected Security
(Without Guided Setup) Overview

This is an outline of the tasks required to configure Sky ATP with Juniper Connected Security.

NOTE: If you prefer to use quick setup, which automatically takes you through the steps listed
below, it is located under Configure>Guided Setup >Sky ATP with PE.

Before You Begin

• A Sky ATP license and account are needed for all threat prevention types (Sky ATP with PE, Sky ATP,
and Cloud Feeds only). If you do not have a Sky ATP license, contact your local sales office or Juniper
Networks partner to place an order for a Sky ATP premium or basic license. If you do not have a Sky
ATP account, when you configure Sky ATP, you are redirected to the Sky ATP server to create one.
Please obtain a license before you try to create a Sky ATP account. Refer to “Obtaining a Sky ATP
License” on page 62 for instructions on obtaining a Sky ATP license.

• Before you configure Policy Enforcer, you must enter the IP address and login credentials for the policy
enforcer virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is
entered, you can begin the setup process. See “Policy Enforcer Settings” on page 70. (Refer to “Policy
Enforcer InstallationOverview” on page 43 for instructions on downloading Policy Enforcer and creating
your policy enforcer virtual machine.)

To configure Sky ATP with Juniper Connected Security:

1. Create one or more Sky ATP realms and enroll SRX Series devices in the appropriate realm. (Enroll
devices by clicking Add Devices in the list view once the realm is created.)

In the UI, navigate to Configure>Threat Prevention>Sky ATP Realms. Click the + icon to add a new
Sky ATP realm.

See “Creating Sky ATP Realms and Enrolling Devices or Associating Sites” on page 159 for details.

2. Create sites and add devices to those sites.

In the UI, navigate to Devices >Secure Fabric. Click the + icon to create a new site.

See “Creating Secure Fabric and Sites” on page 167 for details.
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3. Create a policy enforcement group.

In the UI, navigate toConfigure>SharedObjects>Policy EnforcementGroups. Click the + icon to create
a new policy enforcement group.

See “Creating Policy Enforcement Groups” on page 173 for details.

4. Add the threat prevention policy, including profiles for one or more threat types: C&C server, infected
host, malware.

In the UI, navigate to Configure> Threat Prevention > Policies. Click the + icon to create a new threat
prevention policy.

See “Creating Threat Prevention Policies” on page 178 for details.
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Creating Sky ATP Realms and Enrolling Devices or
Associating Sites

You can select a geographical location and enter your Juniper Sky ATP credentials to create a realm and
associate sites or devices with the realm.

If you do not have a Juniper Sky ATP account, select a geographical region and click here. You are redirected
to the Juniper Sky ATP account page.

Before You Begin

• Understandwhich type of Juniper Sky ATP license you have: free, basic, or premium. The license controls
which Juniper Sky ATP features are available.

• To configure a Juniper Sky ATP realm, you must already have a Juniper Sky ATP account with an
associated license.

• Ensure that the internet connectivity is available for Policy Enforcer. Without the internet connectivity,
you cannot create a realm.

• Decide which region will be covered by the realm you are creating. You must a select a region when you
configure a realm.

• Note that adding a device to a realm results in one or more commit operations occurring on the device
to apply the Juniper Sky ATP or Policy Enforcer configuration.

To configure a Sky ATP Realm:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the Sky ATP tab, click the + icon to add a realm.

3. Complete the initial configuration by using the guidelines in Table 20 on page 159 below.

4. Click Finish.

Table 20: Fields on the Add Sky ATP Realm Page

DescriptionField

Sky ATP Realm Credentials
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Table 20: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Select a region of the world from the available choices.

The following options are available in the Location list:

• North America

• European Region

• Canada

• Asia Pacific

By default, the North America value appears in the list. To know more about the geographic
region, see here.

Location

The username for Sky ATP is your e-mail address.Username

Enter a unique string at least 8 characters long. Include both uppercase and lowercase letters,
at least one number, and at least one special character (~!@#$%^&*()_-+={}[]|:;<>,./?); no spaces
are allowed, and you cannot use the same sequence of characters that are in your username.

Password

Enter a name for the security realm. This should be a name that is meaningful to your organization.
A realm name can only contain alphanumeric characters and the dash symbol. Once created,
this name cannot be changed.

NOTE: When you create a custom feed with a realm, the feed is associated at the site level and
not at the realm level. If you modify this realm and associate new sites to it, a warning message
is shown that there are custom feeds are associatedwith this realm. Changing the site information
will change the custom feed information. You must go and edit the custom feed that was
associated with this realm and verify the realm association.

Realm

Site

Select one or more sites to enroll into the realm. If there are no sites associated with the realm,
click Create new site. To knowmore about creating a new site, see “Creating Secure Fabric and
Sites” on page 167.

NOTE:
• If you are using Juniper Sky ATP without Policy Enforcer, you are not prompted to select a
site.

• Assigning a site to the realm will cause a change in the device configuration in the associated
devices.

• You must select the sites either with tenants or without tenants. You cannot select both at a
time.

Site
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Table 20: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Lists all devices from the realm that are not managed in Security Director. You must manually
discover them.

If you are using Juniper Sky ATP with Policy Enforcer and you have no devices enrolled in the
realm, you are asked to select devices in the box on the left and move them to the right to enroll
them. All selected devices are automatically enrolled with Juniper Sky ATP when you finish the
guided setup. To disenroll a device, you can edit a realm and move the device back to the left
side box.

NOTE: Adding a device to a realm results in one or more commit operations occurring on the
device to apply the Juniper Sky ATP or Policy Enforcer configuration.

Unmanaged
Devices

Global Configuration

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the selected
administrators notifying about the infected host events.

Click the+ sign if you want to add new administrators to the list.

Threat Level
Threshold

Enable this option to log the Malware or the Host Status event or both the event types.Logging

Click the add icon (+) to enter the trusted IPv4 address of the proxy server, in the Server IP
column.

When there is a proxy server between users on the network and a firewall, the firewall might
see the proxy server IP address as the source of an HTTP or HTTPS request, instead of the
actual address of the user making the request.

With this in mind, X-Forwarded-For (XFF) is a standard header added to packets by a proxy
server that includes the real IP address of the client making the request. Therefore, if you add
trusted proxy servers IP addresses to the list in Juniper Sky ATP, by matching this list with the
IP addresses in the HTTP header (X-Forwarded-For field) for requests sent from the SRX Series
devices, Juniper Sky ATP can determines the originating IP address.

NOTE: XFF only applies to HTTP or HTTPS traffic, and only if the proxy server supports the
XFF header.

Proxy Servers
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NOTE: If you enrolled a device into a realm from within Security Director and you want to
disenroll it, you must do that from within Security Director. If you enrolled a device into a realm
from within Sky ATP and you want to disenroll it, you must do that from within Sky ATP. You
cannot disenroll a device from within Security Directory that was enrolled from within Sky ATP.
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Secure Fabric Overview

Secure Fabric is a collection of sites which contain network devices (switches, routers, firewalls, and other
security devices), used in policy enforcement groups.When threat prevention policies are applied to policy
enforcement groups, the system automatically discovers to which sites those groups belong. This is how
threat prevention is aggregated across your secure fabric.

• Add Enforcement Points—Click the Add Enforcement Points link to add Firewalls, Switches, and/or
Connectors. There is a one-to-one mapping between devices with sites. If a device is mapped to a site,
you cannot use the same device to map to a different site. The connector can be mapped to multiple
sites. To filter by type, click the three vertical dots beside the search field and select the check box for
the device type. See “Creating Secure Fabric and Sites” on page 167 for more information.

• Drag and Drop Enforcement Points—From the main page, you can select enforcement points and drag
them to other sites to include them there. When you drag, the enforcement point is disenrolled from
the current site and gets enrolled to the new site where the enforcement point is dropped.

You can either have switches or a connector as enforcement points and not both. However, you can
drag a switch and add to a site that already has a switch or SRX Series device.

Table 21 on page 163 shows fields on the Secure Fabric page.

162



Table 21: Secure Fabric Page Fields

DescriptionField

Specifies the name of the secure fabric site.Site

Specifies the name of the secure fabric tenant.Tenant

Specifies the enforcement points for that particular site, if enforcement points are already
added. If not added, click Add Enforcement Points to add Firewalls, Switches, or Connectors
as enforcement points.

A firewall icon is shown against some of the devices to indicate that they are the perimeter
firewalls.

For connectors, if you hover over the enforcement point, a tool tip is shown listing the
corresponding vSRX devices with IP addresses and descriptions.

NOTE: If tenant is configured to the site, onlyMX Series device can be added as enforcement
points.

Enforcement Points

Specifies the IP address of the enforcement point, if the enforecement point is available.IP

Specifies the type of the enforcement point. For example, vSRX, QFX, Connector.Model

Specifies the feed source to Policy Enforcer.Feed Source

Specifies the status of the SkyATP enrollment.

The Success status with a warning symbol indicates that the device is enabled for cloud feeds
only and there is no support for malware capability and enhanced mode. This field will be
blank if the device fails to disenroll SkyATP.

If the status is Failed, click Retry to enroll the device with Sky ATP again. You can hover over
the Failed status to see the corresponding job details. The device enroll retry option is available
only when the status is Failed.

SKYATP Enroll Status

Specifies the date on which the Secure Fabric page was last updated.Last Updated

Specifies the description that you had entered at the time of creating a secure fabric site.Description
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Threat Prevention Policy Overview | 176

Adding Enforcement Points

Use the Add Enforcement Points page to assign devices to a site and indicate which devices are perimeter
firewalls. To enroll a device with Sky ATP/JATP, you must assign one or more perimeter firewalls to each
site.

NOTE:
• When a connector instance is assigned to a site, that particular connector instance will not be
listed as available enforcement point for other sites.

• If you want to enforce an infected host policy within the network, you must assign a switch
to the site.

• Assigning a device to the site will cause a change in the device configuration.

To add firewalls, switches, or connectors as an enforcement point:

1. Select Devices>Secure Fabric.

The Secure Fabric page appears.

2. Select the required site for which you want to add enforcement points, and click Add Enforcement
Points.

The Add Enforcement Points page appears.

3. Complete the configuration as shown in Table 22 on page 165.

4. Click OK.
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Table 22: Fields on the Add Enforcement Points Page

DescriptionField

All device types are displayed in the list. To filter by type, click the four vertical dots beside the search
field and select the check box for the device type.

To include a device, select the check box beside the device in the Unassigned Devices list and click
the > icon to move them to the Selected list. The devices in the Selected list will be included in the
site.

There is a one-to-one mapping between SRX Series devices and connectors with sites. If a device or
a connector is mapped to a site, you cannot use the same device or a connector to map to a different
site.

NOTE: Firewall devices are automatically enrolled with Sky ATP/JATP as part of this step. Nomanual
enrollment is required. The exceptions are “no selection” mode and Cloud Feeds only mode where
Sky ATP/JATP is not available and therefore no enrollment takes place. (see “Sky ATP Configuration
Type Overview” on page 33)

The name of the connector type is shown as a tool tip when you hover over the name.

NOTE: If a site is associated with a tenant, only MX Series devices are listed. Only those MX Series
devices are listed that have the VRF associated with the tenant that the site is associated with.

Enforcement
points
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Table 22: Fields on the Add Enforcement Points Page (continued)

DescriptionField

Select the edge firewall devices connecting the network to the internet. These devices will receive
the threat feeds. Only firewall (SRX, vSRX) or router devices (MX) that you choose in the Enforcement
Points field appear in the Perimeter Device field. You can have SRX Series and MX Series devices in
the same site and select both as perimeter devices.

You must configure MX Series router as a perimeter device to download Command & Control (C&C),
allowlist, blocklist from Policy Enforcer. In the Sky ATP/JATP with Juniper Connected Security mode,
if you choose a MX Series router as a perimeter firewall device, the MX Series router is not enrolled
to Sky ATP/JATP. The Policy Enforcer URL is configured to the device and this enables the device to
request and receive feeds from Policy Enforcer.

NOTE: The policies to take action based on the feed are not configured in Policy Enforcer. The policies
have to be manually configured on the MX Series device.

Among the listed devices, you can choose which device to consider as a perimeter firewall. Only the
perimeter firewall devices are enrolled to Sky ATP/JATP. If you do not choose any firewall device as
a perimeter firewall, all firewall devices listed in this field are enrolled to Sky ATP/JATP as perimeter
firewalls by default.

You can delete devices manually from the field. However, all the firewall devices are still available in
the list to include later. To remove firewall devices permanently from list, you must move the firewall
devices from the Selected column to the Available column in the Enforcement points field.

In any Sky ATP/JATP configuration types, if there is a firewall device assigned to a site, it is mandatory
to assign one of those devices as a perimeter firewall. If there are no firewall devices assigned to a
site, the perimeter firewall list will be empty.

When you enroll a connector instance to Policy Enforcer, the connector instance provides few vSRX
Series devices. These vSRX devices are discovered by Policy Enforcer in Junos Space. Hover over the
connector instances appearing in the Secure Fabric page to view the details of the corresponding
vSRX devices. The vSRX Series devices associated with a connector are not shown in the Perimeter
Firewall field. However, they are considered as perimeter firewalls.

NOTE: If a branch SRX Series device is added and selected as a perimeter firewall, system reboots
and a warning message is shown before rebooting the system.

Perimeter
Device
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Creating Secure Fabric and Sites

You can create sites within your secure fabric from the secure fabric page.

Before You Begin

• Plan out your sites in advance. A site is a grouping of network devices, including firewalls and switches,
that contribute to threat prevention.

• Keep in mind that when you create a site, you must identify the perimeter firewalls so you can enroll
them with Sky ATP/JATP.

• If you want to enforce an infected host policy within the network, you must assign a switch to the site.

• SRX Series devices cannot belong to multiple sites.

• MX Series devices associated with tenants can belong to multiple sites.

• Sites that are associated with tenants do not need switches as enforcement points.

• Switches and connectors cannot be added to the same site.

To create a site within your secure fabric:

1. Select Devices>Secure Fabric.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 23 on page 167 below.

4. Click OK.

5. Create a new site and add an enforcement point to a site.

Table 23: Create Site Page Fields

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-characters maximum.

Site

Select a tenant.Tenant
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Table 23: Create Site Page Fields (continued)

DescriptionField

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

WARNING: If you add certain SRX SeriesDevices to your Secure Fabric as enforcement
points, you may see a warning that the device(s) must be reconfigured in enhanced
mode and require a reboot. Here is a list of SRX models that may require rebooting
for enhanced mode after being registered with Policy Enforcer/Sky ATP/JATP.

• SRX340

• SRX345

• SRX650

• SRX240h2

• SRX320

• SRX300

• SRX550
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Editing or Deleting a Secure Fabric

You can edit or delete a secure fabric from the secure fabric main page.

To edit or delete a secure fabric:

1. Select Devices > Secure Fabric.

The secure fabric page appears.
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2. Select the secure fabric you want to edit or delete and then right-click.

• Select Edit to modify your secure fabric. The secure fabric configuration page appears. Make the
changes and click OK.

• Select Delete to remove your secure fabric. An alert message appears verifying that you want to
delete your selection. Click Yes to delete your selection.

RELATED DOCUMENTATION

Creating Secure Fabric and Sites | 167

Secure Fabric Overview | 162

Creating Policy Enforcement Groups | 173

Logical System and Virtual Routing and Forwarding
Instance Overview

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise and you
can assign a Virtual Routing and Forwarding (VRF) instance to a tenant. The custom feed sends feeds to
Policy Enforcer at the logical system (LSYS) and VRF instance levels on the MX Series device. The VRF
instance is dedicated to handling traffic within the tenant's private network. You can route the traffic on
the tenant’s private network from the VRF instance on the MX Series device at one site to the same VRF
instance on another MX Series device at a different site. The MX Series device supports multiple VRF
instances assigned to different tenants. Therefore, a device can be shared with multiple tenants.

NOTE: In Policy Enforcer Release 20.1R1, onlyMXSeries devices support LSYS andVRF instance.
Also, only root logical system is supported. All the sites of a realm are either with tenants or
without tenants.

When a tenant is created, a VRF instance is assigned to the tenant. When a site is associated with the
tenant, only those devices that have the VRF instance associated with the tenant can be added to the site.
When you associate a site with a realm in Juniper Sky ATP/JATP, the tenant receives the feeds configured
for the realm. TheMXSeries device performs policy enforcement based on tenant system and the associated
Juniper Sky ATP/JATP realm.

On an MX Series device, VRF instance based feeds such as C&C, allowlist, and blocklist are supported
through custom feeds as shown in Figure 71 on page 170.
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NOTE: If you want to use the C&C global feed from Juniper Sky ATP/JATP, then custom feed
for C&C should not be configured in Policy Enforcer.

For, example: VRFx and VRFy are associated with tenants on MX device 1. Custom feed for tenant 1
(VRFx) and custom feed for tenant 2 (VRFy) are associated to each tenant. The custom feed provides LSYS
and VRF instance information. When the device requests for a feed, Policy Enforcer provides all the feed
data associated with the device (global without VRF instance information) in addition to all the data for
the VRF instances configured on the device that are associated with the tenants configured on Policy
Enforcer.

Figure 71: LSYS and VRF Instance Support

WHAT'S NEXT

Create Secure Fabric Tenants | 172

Creating Secure Fabric and Sites | 167

Adding Enforcement Points | 164

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

170



Creating Custom Feeds | 219

RELATED DOCUMENTATION

About the Secure Fabric Tenants Page | 171

About the Feed Sources Page | 241

About the Secure Fabric Tenants Page

To access this page, click Devices > Secure Fabric > Tenants.

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise. When a
tenant is created, a VRF instance is assigned to the tenant.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a tenant. See “Create Secure Fabric Tenants” on page 172.

You can also modify and delete a tenant.

Field Descriptions

Table 24 on page 171 provides guidelines on using the fields on the Secure Fabric Tenants page.

Table 24: Fields on the Secure Fabric Tenants Page

DescriptionField

Specifies the name of the tenant.Tenant

Specifies the root logical system.LDOM

Specifies the VRF created on the MX Series device.VRF

Specifies the name of the sites.Sites
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Creating Secure Fabric and Sites | 167

RELATED DOCUMENTATION

Logical System and Virtual Routing and Forwarding Instance Overview | 169

Create Secure Fabric Tenants

To create a tenant within your secure fabric:

1. Select Devices > Secure Fabric > Tenants.

2. Click the + icon.

3. Complete the configuration using the guidelines in Table 25 on page 172.

4. Click OK.

A tenant is created. After the tenant is created, it can be associated to a site.

Table 25: Create Tenant

GuidelinesField

Enter a unique string thatmust beginwith an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

By default, the root logical system is selected, which you cannot edit. In Policy
Enforcer Release 20.1R1, only root logical system is supported.

LDOM

Enter the virtual routing and forwarding (VRF) instance name, which is created on
the MX Series device.

VRF

To edit a tenant, select a tenant and click the pencil icon.

To delete a tenant, select the delete icon. If a tenant is associated to a site, the tenant cannot be deleted.
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Creating Secure Fabric and Sites | 167

RELATED DOCUMENTATION

Logical System and Virtual Routing and Forwarding Instance Overview | 169

Policy Enforcement Groups Overview

A policy enforcement group is a grouping of endpoints to which threat prevention policies are applied.
Create a policy enforcement group by adding endpoints (firewalls, switches, subnets, set of end users)
under one common group name and later applying a threat prevention policy to that group.

RELATED DOCUMENTATION

Creating Policy Enforcement Groups | 173

Threat Prevention Policy Overview | 176

Creating Policy Enforcement Groups

You can create policy enforcement groups from the policy enforcement groups page.

Before You Begin

• Know what type of endpoints you are including in your policy enforcement group: IP address/subnet,
or location.

• Determine what endpoints you will add to the group based on how you will configure threat prevention
according to location, users and applications, or threat risk.

• Keep in mind that endpoints cannot belong to multiple policy enforcement groups.
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To create a policy enforcement group:

1. Select Configure>Shared Objects>Policy Enforcement Groups.

2. Click the + icon.

3. Complete the configuration by using the guidelines in the Table 26 on page 174 below.

4. Click OK.

Table 26: Fields on the Policy Enforcement Group Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description; maximum length is 64 characters. You should make this description as useful as
possible for all administrators.

Description

Select a group type from the available choices. IP Address/Subnet or Location.Group Type
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Table 26: Fields on the Policy Enforcement Group Page (continued)

DescriptionField

This field is available only if the Group Type field is IP Address/Subnet

The subnets of all connectors added in the Connector page are dynamically listed in the Available
column. If the Group Type is IP Address/Subnet, the subnets within the connector instances that
have the threat remediation enabled are only listed.

When using Junos Space, Policy Enforcer is able to dynamically discover subnets configured on
Juniper switches. Policy Enforcer does not have the same insight with third-party devices. Therefore
you can add subnets to your connector configuration and select them here. This allows you to
selectively apply policies to those subnets.

If you have not configured a connector, you will see only Junos Space subnets discovered by Policy
Enforcer. If you have a connector configured, you can see the subnets of a connector in the Available
column. Hover over subnets to view the description for these subnets entered during the connector
creation. You will not see any description if it is not entered during creating a connector. The
description will show “No description available” for subnets that come from Junos Space.

The Available and Selected columns have filters listed with connectors or Space. You can choose a
connector and filter only the subnets belonging to that particular connector. The result shows the
name of a device to which the subnet belongs and also the type of the device.

You can also use the search bar to search and filter the result based on subnet, name of the device,
or type of the device.

Click Refresh Available IPs to refresh the available IP addresses or subnets. If you edit any selected
items in the Selected column, the list is refreshed to the initial selected list after the refresh. A
progress bar is shown with the refresh progress in percentage.

In a scenario where there are no IP addresses or subnets, the refreshwill still be successful. Amessage
is displayed showing that the refresh was successful but there are no IP addresses or subnets found.

Connector
IPs

This field is available only if the Group Type field is IP Address/Subnet

Enter an IP address and select the connector type from the list to add to PEG. The IP address must
be within the subnet range of the selected connector. Click Add to add the additional IP address to
the Selected column of the Connector IPs field.

A validation is performed to check if the additional IP address is within the subnet range of the
selected connector. If not, an error message is shown to enter the IP address within the subnet range.

Additional
IP

Sites with the threat remediation enabled instances are only listed, if the Group Type is Location.
Select the check box beside the sites in the Available list and click the > icon to move them to the
Selected list.

The endpoints in the Selected list will be included in the policy enforcement group.

Sites
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You can create a policy enforcement group with subnets from different connectors based on how they
have grouped their network segments. For example, If you have Junos Space EX switch with subnets HR:
1.1.1.1/24 and Finance: 2.2.2.2/24, ClearPass connector with subnets HR: 1.1.1.1/24 and Marketing:
2.2.2.2/24, Cisco ISE with subnets HR: 1.1.1.1/24 and Finance: 2.2.2.2/24. You can create a single policy
enforcement group and name it as HR by choosing the following subnets: Junos Space EX HR: 1.1.1.1/24,
ClearPass connector subnet HR: 1.1.1.1/24, and Cisco ISE connector subnet HR: 1.1.1.1/24.

RELATED DOCUMENTATION

Policy Enforcement Groups Overview | 173

Using Guided Setup for Sky ATP with Juniper Connected Security | 141

Deleting Policy Enforcement Group

Threat Prevention Policy Overview

Threat prevention policies provide protection andmonitoring for selected threat profiles, including command
and control servers, infected hosts, and malware. Using feeds from Sky ATP and optional custom feeds
that you configure, ingress and egress traffic is monitored for suspicious content and behavior. Based on
a threat score, detected threats are evaluated and action may be taken once a verdict is reached.

Once policies are configured, the following fields are available on the Security Director main page to
provide an overview of each policy.

Table 27: Threat Prevention Policy Fields

DescriptionField

The user-created name for the policy.Name

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.) For example:

Block: 8-10

Monitor: 5-7

Permit: 1-4

Profile: C&C Server

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Infected Host
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Table 27: Threat Prevention Policy Fields (continued)

DescriptionField

Threat score settings overview if selected for the policy.
(Otherwise this is empty.)

Profile: Malware HTTP

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Malware SMTP

This displays the status of the policy. This status is a
clickable link you can use to change the policy status.
When you first create a policy and assign it to a group,
this field readsViewAnalysis. Read “Threat Policy Analysis
Overview” on page 185 for more information on this field.

If the status is Update Failed, click Retry to perform the
rule analysis again. You can click the Update Failed status
to see the corresponding job details. The rule analysis retry
option is available only when the status is Update Failed.

NOTE: If the policy has been updated after it has already
been pushed to the endpoint, the status here is Update
with a warning icon to notify you the policy has been
changed but not pushed.

Status

This is the group to which the policy is assigned.Policy Enforcement Group

This field displays the log setting for the policy.Log

The user-created description for the policy.Description

Benefits of Threat Prevention Policy

• Enables you to define and enforce policies for controlling specific applications and embedded social
networking widgets.

• Reduces the need for manual updates and automatically applies policies and enforcement rules, driving
down the costs of managing network security.

• Leverages the network for multiple enforcement points across the infrastructure. Enables you to stop
threats closer to infection points and to prevent threats from spreading, which greatly improves the
efficacy of security operations.

177
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Creating Threat Prevention Policies | 178

Policy Enforcement Groups Overview | 173

Creating Geo IP Policies | 186

Policy Enforcer Overview | 18

Benefits of Policy Enforcer | 20

Policy Enforcer Components and Dependencies | 27

Sky ATP Overview | 23

Creating Threat Prevention Policies

You can create threat prevention policies for various profiles from the Policies page.

NOTE: If you are creating policies for the first time, you are given the option of setting up Policy
Enforcer with Sky ATP or configuring Sky ATP alone. Clicking either button takes you to quick
setup for your selection. See “Comparing the Juniper Connected Security and non-Juniper
Connected Security Configuration Steps” on page 40 for a configuration comparison.

Before You Begin

• Determine the type of profile you will use for this policy; command & control server, infected hosts,
malware. You can select one or more threat profiles in a policy. Note that you configure Geo IP policies
separately. See “Creating Geo IP Policies” on page 186.

• Determine what action to take if a threat is found.

• Know what policy enforcement group you will add to this policy. To apply the policy, you must assign
one or more policy enforcement groups. See the instructions for assigning groups to policies at the
bottom of this page.

• Once policies are configured with one more groups assigned, you can save a policy in draft form or
update it. Policies changes do not go live until they have been updated.

178



• If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. See the instructions at the bottom of this page.

• If you delete a threat prevention policy that is assigned to a policy enforcement group, a status screen
appears displaying the progress of the deletion and the affected configuration items.

To create a threat prevention policy:

1. Select Configure>Threat Prevention > Policies.

2. Click the + icon.

The Create Threat Prevention Policy page appears.

3. Complete the configuration by using the guidelines in theTable 28 on page 179, Table 29 on page 180,
Table 30 on page 180, Table 31 on page 181, and Table 32 on page 183 below.

4. Click OK.

Table 28: Fields on the Threat Prevention Policy Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

Include the following profiles to your threat prevention policy. Youmust include at least
one profile. An error message is shown if you try to create the threat prevention policy
without selecting a profile.

• C&C profile—See Table 29 on page 180.

• Infected host profile—See Table 30 on page 180.

• Malware profile—See Table 31 on page 181.

• DDoS profile—See Table 32 on page 183.

Profiles

Select the log setting for the policy. You can log all traffic, log only blocked traffic, or
log no traffic.

Log Setting (Policy
setting for all profiles)

Table 29 on page 180 shows the management of command and control server threat in a policy.
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Table 29: C&C Server Profile Management

DescriptionField

Select and choose settings for command and control servers. A C&C is a centralized computer
that issues commands to botnets (compromised networks of computers) and receives reports
back from them. Botnets can be used to gather sensitive information, such as account numbers
or credit card information, or to participate in a distributed denial-of-service (DDoS) attack.

CommandandControl
Server

Select the check box to include management for this threat type in the policy.Include C& C profile in
policy

Use the slider to change the action to be taken based on the threat score. Threat scores are
assigned using several criteria. Refer to the monitoring pages in the UI to investigate, located
underMonitor > Threat Management.

Threat Score

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custommessage—In the field provided, enter amessage to be shown to users when
connections are dropped.

• Permit the connection block.

Actions

Table 30 on page 180 shows the management of infected host threat in a policy.

Table 30: Infected Host Profile Management

DescriptionField

Infected hosts are systems for which there is a high confidence that attackers have gained
unauthorized access. Infected hosts data feeds are listed with the IP address or IP subnet of
the host, along with a threat score.

Infected Host

Select the check box to include management for this threat type in the policy.

NOTE: If you want to enforce an infected host policy within the network, you must include a
switch in the site.

Include infected host
profile in policy
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Table 30: Infected Host Profile Management (continued)

DescriptionField

You have following options:

• Drop connection silently (This is the default and recommended setting.)

• Monitor—Choose this option to log all the traffic for certain infected hosts and monitor it.
You can then choose to perform any action on the monitored data.

NOTE: The PEG must contain only Space subnets or devices. The Monitor action for the
infected host profile is not applicable to any third party connector devices. An error message
is shown.

• Quarantine—In the field provided, enter a VLAN to which quarantined files are sent. (Note
that the fallback option is to block and drop the connection silently.)

• Permit

Actions

Table 31 on page 181 shows the management of malware threat in a policy.

Table 31: Malware Threat Profile Management

DescriptionField

Malware is files that are downloaded by hosts or received as email attachments and found
to be suspicious based on known signatures, URLs. or other heuristics.

Malware (HTTP file
download, SMTP File
attachment, and IMAP
attachments)

Select the check box to include management for this threat type in the policy.Include malware profile in
policy

Turn this feature on to scan files downloaded over HTTP and then select a file scanning
device profile. The device profile is configured using Sky ATP.

HTTP file download

Turn this feature to scan encrypted files downloaded over HTTPS.Scan HTTPS

Select a Sky ATP device profile. This is configured through Sky ATP. Sky ATP profiles let
you define which files to send to the cloud for inspection. You can group types of files to
be scanned together under a common name and create multiple profiles based on the
content you want scanned.

Device Profile
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Table 31: Malware Threat Profile Management (continued)

DescriptionField

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custom message—In the field provided, enter a message to be shown to users
when connections are dropped.

• Permit

Actions

Turn this feature on to inspect files received as email attachments (over SMTP only).SMTP File Attachments

Enable this option to configure reverse proxy for SMTP.

The reverse proxy does not prohibit server certificates. It forwards the actual server
certificate or chain as is to the client without modifying it.

Scan SMTPS

If you do not click the Change button to select a device profile for SMTP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for SMTP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP and
SMTP. (Note: There is no monitoring setting for malware.)

Threat Score

Actions for SMTP File Attachments include: Quarantine, Deliver malicious messages with
warning headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Turn this feature on to select a a file scanning device profile and threat score ranges to
apply to IMAP e-mails.

IMAP Attachments

Enable this option to configure reverse proxy for IMAP e-mails.Scan IMAPS
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Table 31: Malware Threat Profile Management (continued)

DescriptionField

If you do not click the Change button to select a device profile for IMAP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for IMAP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Actions for IMAP Attachments include: Block, Deliver malicious messages with warning
headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP, SMTP,
and IMAP. (Note: There is no monitoring setting for malware.)

Threat Score

Table 32 on page 183 shows the management of DDoS threat in a policy

Table 32: DDoS Threat Profile Management

DescriptionField

Enable this option to include themanagement of Distributed denial-of-service (DDoS) protection
that enables the MX router to quickly identify an attack and prevent a flood of malicious control
packets from exhausting system resources.

When you create a threat policy for the DDoS profile, it is not pushed to the device because the
policy is not yet assigned to any device. Assign the policy to the policy enforcement group.
Because the policy is created for the MX router, rule analysis is not initiated when a policy is
assigned to the policy enforcement group (PEG).

Include DDoS
Profile in Policy

Select the following actions from the list for the DDoS profile:

• Block—Use this option to block the DDoS attack.

• Rate Limit Value—Use this option to limit the bandwidth on the flow route. You can express
the rate limit value in Kbps, Mbps, or Gbps units. The rate limit range is 10Kbps to 100Gbps.

• Forward to—Use this option to configure the routing next hop to forward the packets for
scrubbing.

Actions

Specify a routing instance to which packets are forwarded in the as-number:community-value
format, where each value is a decimal number. For example, 65001:100.

Scrubbing Site
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Once you have a threat prevention policy, you assign one or more groups to it:

1. In the threat prevention policy main page (located under Configure>Threat Prevention > Policy), find
the appropriate policy.

2. In the Policy Enforcement Groups column, click theAssign toGroups link that appears herewhen there
are no policy enforcement groups assigned or click the group name that appears in this column to edit
the existing list of assigned groups. You can also select the check box beside a policy and click the
Assign toGroups button at the top of the page. See “Policy Enforcement GroupsOverview” on page 173
.

For the infected host profiles created with Monitor action, you cannot assign a policy enforcement
group if it contains only the third-party connector devices or the combination of both Junos Space and
third-party connector devices. You must have only the Junos Space subnets (IP addresses assigned to
the Junos Space NetworkManagement Platform ethernet interfaces) in the policy enforcement groups
to assign them to the infected host profiles with Monitor action.

If you edit an existing infected host profile with either Drop Connection or Quarantine action toMonitor
action, you cannot assign any policy enforcement group having only third-party connector devices or
the combination of Junos Space and third-party connector devices.

3. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

4. Click OK.

Snapshot is taken and policy analysis is initiated. For more information about the threat policy analysis,
see “Threat Policy Analysis Overview” on page 185. From there you can view your changes and choose
to Update now, Update later, or Save them in draft form without updating.

5. If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. Navigate to Configure>Firewall Policy>Standard Policies. Click on a
rule and you are taken to the respective rules page. In the Advanced Security column, click an item to
access the Edit Advanced Security page and select the threat prevention policy from the Threat
Prevention pulldown list.

RELATED DOCUMENTATION

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration
Steps | 40

Creating Policy Enforcement Groups | 173

Threat Policy Analysis Overview | 185
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Sky ATP Overview | 23

Threat Policy Analysis Overview

In the Threat Prevention Policies page, click theReady toUpdate link in the Status column to update policy
changes. Policies must be updated before they can go live.

NOTE: If the policy has been updated after it has already been pushed to the endpoint, the
status here is Update with a warning icon to notify you that the policy has been changed but
not pushed.

Use the threat policy analysis page to view your pending policy changes in chronological order. Click the
View Analysis link to view the changes. In the Action section, you can select to Update now, Update later,
or Save the changes without updating. If you select to update later, you can schedule a time to update.

By clicking on the policy links, you can update only the policies you select and choose not to update others.

RELATED DOCUMENTATION

Threat Prevention Policy Overview | 176

Creating Threat Prevention Policies | 178

Geo IP Overview

Geo IP refers to the method of locating a computer terminal's geographic location by identifying that
terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to geographical regions. By
mapping IP address to the sources of attack traffic, geographic regions of origin can be determined, giving
you the ability to filter traffic to and from specific locations in the world.
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Sky ATP Realm Overview | 190

Creating Geo IP Policies

You can create Geo IP policies from the Geo IP policies page.

Before You Begin

• Youmust have a Sky ATP account to receive Geo IP feeds. Make sure you configure the necessary steps
for Sky ATP before creating a Geo IP policy.

• Geo IP filtering is a useful tool when you are experiencing certain types of attacks, such as DDOS from
specific geographical locations.

• If you are using Sky ATP without Policy Enforcer, you must select your Geo IP policy as the source
and/or destination of a firewall rule to apply it.

To create a Geo IP policy:

1. Select Configure>Shared Objects>Geo IP.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 33 on page 186 below.

4. Click OK.

Table 33: Fields on the Geo IP Policy Page

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description; maximum length is 1024 characters. You should make this description
as useful as possible for all administrators.

Description
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Table 33: Fields on the Geo IP Policy Page (continued)

Select the check box beside the countries in the Available list and click the > icon to move
them to the Selected list. The countries in the Selected list will be included in the policy and
action will be taken according to their threat level.

Countries

Choose what traffic to block from the selected countries. Incoming traffic, Outgoing traffic,
or Incoming and Outgoing traffic. (Policy Enforcer only)

Block Traffic

Choose to log all traffic or only blocked traffic. (Policy Enforcer only)Log Setting

Once you have a Geo IP policy, you assign it to one more groups (Policy Enforcer only):

To assign a Geo IP policy to a group or groups:

1. In the Group column, click the Assign to Groups link that appears here when there are no groups
assigned or click the group name that appears in this column to edit the existing list of assigned groups.

2. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

3. Click OK.

4. Once one or more groups have been assigned, a Ready to Update link appears in the Status column.
You must update to apply your new or edited policy configuration. Clicking the Ready to Update link
takes you the Threat Policy Analysis page. See “Threat Policy Analysis Overview” on page 185. From
there you can view your changes and choose to Update now, Update later, or Save them in draft form
without updating.

5. If you are using Sky ATP without Policy Enforcer, you must select your Geo IP policy as the source
and/or destination of a firewall rule. Navigate to Configure > Firewall Policy > Policies.

RELATED DOCUMENTATION

Creating Policy Enforcement Groups | 173

Creating Threat Prevention Policies | 178

Threat Policy Analysis Overview | 185

Geo IP Overview | 185

Configuring Cloud Feeds Only | 205

Deleting Geo IP Policies
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Configuring Sky ATP (No Juniper Connected Security
and No Guided Setup) Overview

This is an outline of the configuration tasks youmust complete to configure Sky ATPmodewithout Juniper
Connected Security mode.

NOTE: Configuring Policy Enforcer (Juniper Connected Security mode) is required if you want
to work on the Juniper Connected Security architecture from within Security Director.

If you prefer to use guided setup, which automatically takes you through the steps listed below, it is located
under Configure>Guided Setup >Sky ATP.

• A Sky ATP license and account are needed for all threat prevention types (Sky ATP with PE, Sky ATP,
and Cloud Feeds only). If you do not have a Sky ATP license, contact your local sales office or Juniper
Networks partner to place an order for a Sky ATP premium license. If you do not have a Sky ATP account,
when you configure Sky ATP, you are redirected to the Sky ATP server to create one. Please obtain a
license before you try to create a Sky ATP account. Refer to “Obtaining a Sky ATP License” on page 62
for instructions on obtaining a Sky ATP premium license.

• Before you configure Sky ATP youmust enter the IP address and login credentials for the policy enforcer
virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is entered,
you can begin the setup process. See “Policy Enforcer Settings” on page 70. (Refer to “Policy Enforcer
Installation Overview” on page 43 for instructions on downloading Policy Enforcer and creating your
policy enforcer virtual machine.)

1. Create one or more Sky ATP realms and enroll SRX Series devices in the appropriate realm. (Enroll
devices by clicking Add Devices in the list view once the realm is created.)

In the UI, navigate to Configure>Threat Prevention>Sky ATP Realms. Click the + icon to add a new
Sky ATP realm.

See “Creating Sky ATP Realms and Enrolling Devices or Associating Sites” on page 159 for details.

2. Create a threat prevention policy, including profiles for one or more threat types: C&C server, infected
host, or malware.

In the UI, navigate to Configure>Threat Prevention >Policy. Click the + icon to create a new threat
prevention policy.

See “Creating Threat Prevention Policies” on page 178 for details.

3. You must assign a threat prevention policy to a firewall rule before it can take affect.
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In the UI, navigate to Configure > Firewall Policy > Policies. In the Advanced Security column, click an
item to access the Edit Advanced Security page and select the threat prevention policy from the Threat
Prevention pulldown list.

RELATED DOCUMENTATION

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

Creating Threat Prevention Policies | 178

Creating Geo IP Policies | 186

Sky ATP Realm Overview

A security realm is a group identifier for an organization used to restrict access to Web applications. You
must create at least one security realm to login into Sky ATP. Once you create a realm, you can enroll SRX
Series devices into the realm. You can also givemore users (administrators) permission to access the realm.

If you have multiple security realms, note that each SRX Series device can only be bound to one realm,
and users cannot travel between realms.

RELATED DOCUMENTATION

About the Feed Sources Page | 241

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

Using Guided Setup for Sky ATP | 148

Configuring Sky ATP (No Juniper Connected Security and No Guided Setup) Overview | 189
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Creating Sky ATP Realms and Enrolling Devices or
Associating Sites

You can select a geographical location and enter your Juniper Sky ATP credentials to create a realm and
associate sites or devices with the realm.

If you do not have a Juniper Sky ATP account, select a geographical region and click here. You are redirected
to the Juniper Sky ATP account page.

Before You Begin

• Understandwhich type of Juniper Sky ATP license you have: free, basic, or premium. The license controls
which Juniper Sky ATP features are available.

• To configure a Juniper Sky ATP realm, you must already have a Juniper Sky ATP account with an
associated license.

• Ensure that the internet connectivity is available for Policy Enforcer. Without the internet connectivity,
you cannot create a realm.

• Decide which region will be covered by the realm you are creating. You must a select a region when you
configure a realm.

• Note that adding a device to a realm results in one or more commit operations occurring on the device
to apply the Juniper Sky ATP or Policy Enforcer configuration.

To configure a Sky ATP Realm:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the Sky ATP tab, click the + icon to add a realm.

3. Complete the initial configuration by using the guidelines in Table 20 on page 159 below.

4. Click Finish.

Table 34: Fields on the Add Sky ATP Realm Page

DescriptionField

Sky ATP Realm Credentials
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Table 34: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Select a region of the world from the available choices.

The following options are available in the Location list:

• North America

• European Region

• Canada

• Asia Pacific

By default, the North America value appears in the list. To know more about the geographic
region, see here.

Location

The username for Sky ATP is your e-mail address.Username

Enter a unique string at least 8 characters long. Include both uppercase and lowercase letters,
at least one number, and at least one special character (~!@#$%^&*()_-+={}[]|:;<>,./?); no spaces
are allowed, and you cannot use the same sequence of characters that are in your username.

Password

Enter a name for the security realm. This should be a name that is meaningful to your organization.
A realm name can only contain alphanumeric characters and the dash symbol. Once created,
this name cannot be changed.

NOTE: When you create a custom feed with a realm, the feed is associated at the site level and
not at the realm level. If you modify this realm and associate new sites to it, a warning message
is shown that there are custom feeds are associatedwith this realm. Changing the site information
will change the custom feed information. You must go and edit the custom feed that was
associated with this realm and verify the realm association.

Realm

Site

Select one or more sites to enroll into the realm. If there are no sites associated with the realm,
click Create new site. To knowmore about creating a new site, see “Creating Secure Fabric and
Sites” on page 167.

NOTE:
• If you are using Juniper Sky ATP without Policy Enforcer, you are not prompted to select a
site.

• Assigning a site to the realm will cause a change in the device configuration in the associated
devices.

• You must select the sites either with tenants or without tenants. You cannot select both at a
time.

Site
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Table 34: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Lists all devices from the realm that are not managed in Security Director. You must manually
discover them.

If you are using Juniper Sky ATP with Policy Enforcer and you have no devices enrolled in the
realm, you are asked to select devices in the box on the left and move them to the right to enroll
them. All selected devices are automatically enrolled with Juniper Sky ATP when you finish the
guided setup. To disenroll a device, you can edit a realm and move the device back to the left
side box.

NOTE: Adding a device to a realm results in one or more commit operations occurring on the
device to apply the Juniper Sky ATP or Policy Enforcer configuration.

Unmanaged
Devices

Global Configuration

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the selected
administrators notifying about the infected host events.

Click the+ sign if you want to add new administrators to the list.

Threat Level
Threshold

Enable this option to log the Malware or the Host Status event or both the event types.Logging

Click the add icon (+) to enter the trusted IPv4 address of the proxy server, in the Server IP
column.

When there is a proxy server between users on the network and a firewall, the firewall might
see the proxy server IP address as the source of an HTTP or HTTPS request, instead of the
actual address of the user making the request.

With this in mind, X-Forwarded-For (XFF) is a standard header added to packets by a proxy
server that includes the real IP address of the client making the request. Therefore, if you add
trusted proxy servers IP addresses to the list in Juniper Sky ATP, by matching this list with the
IP addresses in the HTTP header (X-Forwarded-For field) for requests sent from the SRX Series
devices, Juniper Sky ATP can determines the originating IP address.

NOTE: XFF only applies to HTTP or HTTPS traffic, and only if the proxy server supports the
XFF header.

Proxy Servers
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NOTE: If you enrolled a device into a realm from within Security Director and you want to
disenroll it, you must do that from within Security Director. If you enrolled a device into a realm
from within Sky ATP and you want to disenroll it, you must do that from within Sky ATP. You
cannot disenroll a device from within Security Directory that was enrolled from within Sky ATP.

RELATED DOCUMENTATION

About the Feed Sources Page | 241

Sky ATP Realm Overview | 190

Using Guided Setup for Sky ATP | 148

Creating Secure Fabric and Sites | 167

Threat Prevention Policy Overview

Threat prevention policies provide protection andmonitoring for selected threat profiles, including command
and control servers, infected hosts, and malware. Using feeds from Sky ATP and optional custom feeds
that you configure, ingress and egress traffic is monitored for suspicious content and behavior. Based on
a threat score, detected threats are evaluated and action may be taken once a verdict is reached.

Once policies are configured, the following fields are available on the Security Director main page to
provide an overview of each policy.

Table 35: Threat Prevention Policy Fields

DescriptionField

The user-created name for the policy.Name

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.) For example:

Block: 8-10

Monitor: 5-7

Permit: 1-4

Profile: C&C Server
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Table 35: Threat Prevention Policy Fields (continued)

DescriptionField

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Infected Host

Threat score settings overview if selected for the policy.
(Otherwise this is empty.)

Profile: Malware HTTP

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Malware SMTP

This displays the status of the policy. This status is a
clickable link you can use to change the policy status.
When you first create a policy and assign it to a group,
this field readsViewAnalysis. Read “Threat Policy Analysis
Overview” on page 185 for more information on this field.

If the status is Update Failed, click Retry to perform the
rule analysis again. You can click the Update Failed status
to see the corresponding job details. The rule analysis retry
option is available only when the status is Update Failed.

NOTE: If the policy has been updated after it has already
been pushed to the endpoint, the status here is Update
with a warning icon to notify you the policy has been
changed but not pushed.

Status

This is the group to which the policy is assigned.Policy Enforcement Group

This field displays the log setting for the policy.Log

The user-created description for the policy.Description

Benefits of Threat Prevention Policy

• Enables you to define and enforce policies for controlling specific applications and embedded social
networking widgets.

• Reduces the need for manual updates and automatically applies policies and enforcement rules, driving
down the costs of managing network security.
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• Leverages the network for multiple enforcement points across the infrastructure. Enables you to stop
threats closer to infection points and to prevent threats from spreading, which greatly improves the
efficacy of security operations.

RELATED DOCUMENTATION

Creating Threat Prevention Policies | 178

Policy Enforcement Groups Overview | 173

Creating Geo IP Policies | 186

Policy Enforcer Overview | 18

Benefits of Policy Enforcer | 20

Policy Enforcer Components and Dependencies | 27

Sky ATP Overview | 23

Creating Threat Prevention Policies

You can create threat prevention policies for various profiles from the Policies page.

NOTE: If you are creating policies for the first time, you are given the option of setting up Policy
Enforcer with Sky ATP or configuring Sky ATP alone. Clicking either button takes you to quick
setup for your selection. See “Comparing the Juniper Connected Security and non-Juniper
Connected Security Configuration Steps” on page 40 for a configuration comparison.

Before You Begin

• Determine the type of profile you will use for this policy; command & control server, infected hosts,
malware. You can select one or more threat profiles in a policy. Note that you configure Geo IP policies
separately. See “Creating Geo IP Policies” on page 186.

• Determine what action to take if a threat is found.
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• Know what policy enforcement group you will add to this policy. To apply the policy, you must assign
one or more policy enforcement groups. See the instructions for assigning groups to policies at the
bottom of this page.

• Once policies are configured with one more groups assigned, you can save a policy in draft form or
update it. Policies changes do not go live until they have been updated.

• If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. See the instructions at the bottom of this page.

• If you delete a threat prevention policy that is assigned to a policy enforcement group, a status screen
appears displaying the progress of the deletion and the affected configuration items.

To create a threat prevention policy:

1. Select Configure>Threat Prevention > Policies.

2. Click the + icon.

The Create Threat Prevention Policy page appears.

3. Complete the configuration by using the guidelines in theTable 28 on page 179, Table 29 on page 180,
Table 30 on page 180, Table 31 on page 181, and Table 32 on page 183 below.

4. Click OK.

Table 36: Fields on the Threat Prevention Policy Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

Include the following profiles to your threat prevention policy. Youmust include at least
one profile. An error message is shown if you try to create the threat prevention policy
without selecting a profile.

• C&C profile—See Table 29 on page 180.

• Infected host profile—See Table 30 on page 180.

• Malware profile—See Table 31 on page 181.

• DDoS profile—See Table 32 on page 183.

Profiles

Select the log setting for the policy. You can log all traffic, log only blocked traffic, or
log no traffic.

Log Setting (Policy
setting for all profiles)

197



Table 29 on page 180 shows the management of command and control server threat in a policy.

Table 37: C&C Server Profile Management

DescriptionField

Select and choose settings for command and control servers. A C&C is a centralized computer
that issues commands to botnets (compromised networks of computers) and receives reports
back from them. Botnets can be used to gather sensitive information, such as account numbers
or credit card information, or to participate in a distributed denial-of-service (DDoS) attack.

CommandandControl
Server

Select the check box to include management for this threat type in the policy.Include C& C profile in
policy

Use the slider to change the action to be taken based on the threat score. Threat scores are
assigned using several criteria. Refer to the monitoring pages in the UI to investigate, located
underMonitor > Threat Management.

Threat Score

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custommessage—In the field provided, enter amessage to be shown to users when
connections are dropped.

• Permit the connection block.

Actions

Table 30 on page 180 shows the management of infected host threat in a policy.

Table 38: Infected Host Profile Management

DescriptionField

Infected hosts are systems for which there is a high confidence that attackers have gained
unauthorized access. Infected hosts data feeds are listed with the IP address or IP subnet of
the host, along with a threat score.

Infected Host

Select the check box to include management for this threat type in the policy.

NOTE: If you want to enforce an infected host policy within the network, you must include a
switch in the site.

Include infected host
profile in policy
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Table 38: Infected Host Profile Management (continued)

DescriptionField

You have following options:

• Drop connection silently (This is the default and recommended setting.)

• Monitor—Choose this option to log all the traffic for certain infected hosts and monitor it.
You can then choose to perform any action on the monitored data.

NOTE: The PEG must contain only Space subnets or devices. The Monitor action for the
infected host profile is not applicable to any third party connector devices. An error message
is shown.

• Quarantine—In the field provided, enter a VLAN to which quarantined files are sent. (Note
that the fallback option is to block and drop the connection silently.)

• Permit

Actions

Table 31 on page 181 shows the management of malware threat in a policy.

Table 39: Malware Threat Profile Management

DescriptionField

Malware is files that are downloaded by hosts or received as email attachments and found
to be suspicious based on known signatures, URLs. or other heuristics.

Malware (HTTP file
download, SMTP File
attachment, and IMAP
attachments)

Select the check box to include management for this threat type in the policy.Include malware profile in
policy

Turn this feature on to scan files downloaded over HTTP and then select a file scanning
device profile. The device profile is configured using Sky ATP.

HTTP file download

Turn this feature to scan encrypted files downloaded over HTTPS.Scan HTTPS

Select a Sky ATP device profile. This is configured through Sky ATP. Sky ATP profiles let
you define which files to send to the cloud for inspection. You can group types of files to
be scanned together under a common name and create multiple profiles based on the
content you want scanned.

Device Profile
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Table 39: Malware Threat Profile Management (continued)

DescriptionField

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custom message—In the field provided, enter a message to be shown to users
when connections are dropped.

• Permit

Actions

Turn this feature on to inspect files received as email attachments (over SMTP only).SMTP File Attachments

Enable this option to configure reverse proxy for SMTP.

The reverse proxy does not prohibit server certificates. It forwards the actual server
certificate or chain as is to the client without modifying it.

Scan SMTPS

If you do not click the Change button to select a device profile for SMTP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for SMTP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP and
SMTP. (Note: There is no monitoring setting for malware.)

Threat Score

Actions for SMTP File Attachments include: Quarantine, Deliver malicious messages with
warning headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Turn this feature on to select a a file scanning device profile and threat score ranges to
apply to IMAP e-mails.

IMAP Attachments

Enable this option to configure reverse proxy for IMAP e-mails.Scan IMAPS
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Table 39: Malware Threat Profile Management (continued)

DescriptionField

If you do not click the Change button to select a device profile for IMAP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for IMAP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Actions for IMAP Attachments include: Block, Deliver malicious messages with warning
headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP, SMTP,
and IMAP. (Note: There is no monitoring setting for malware.)

Threat Score

Table 32 on page 183 shows the management of DDoS threat in a policy

Table 40: DDoS Threat Profile Management

DescriptionField

Enable this option to include themanagement of Distributed denial-of-service (DDoS) protection
that enables the MX router to quickly identify an attack and prevent a flood of malicious control
packets from exhausting system resources.

When you create a threat policy for the DDoS profile, it is not pushed to the device because the
policy is not yet assigned to any device. Assign the policy to the policy enforcement group.
Because the policy is created for the MX router, rule analysis is not initiated when a policy is
assigned to the policy enforcement group (PEG).

Include DDoS
Profile in Policy

Select the following actions from the list for the DDoS profile:

• Block—Use this option to block the DDoS attack.

• Rate Limit Value—Use this option to limit the bandwidth on the flow route. You can express
the rate limit value in Kbps, Mbps, or Gbps units. The rate limit range is 10Kbps to 100Gbps.

• Forward to—Use this option to configure the routing next hop to forward the packets for
scrubbing.

Actions

Specify a routing instance to which packets are forwarded in the as-number:community-value
format, where each value is a decimal number. For example, 65001:100.

Scrubbing Site
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Once you have a threat prevention policy, you assign one or more groups to it:

1. In the threat prevention policy main page (located under Configure>Threat Prevention > Policy), find
the appropriate policy.

2. In the Policy Enforcement Groups column, click theAssign toGroups link that appears herewhen there
are no policy enforcement groups assigned or click the group name that appears in this column to edit
the existing list of assigned groups. You can also select the check box beside a policy and click the
Assign toGroups button at the top of the page. See “Policy Enforcement GroupsOverview” on page 173
.

For the infected host profiles created with Monitor action, you cannot assign a policy enforcement
group if it contains only the third-party connector devices or the combination of both Junos Space and
third-party connector devices. You must have only the Junos Space subnets (IP addresses assigned to
the Junos Space NetworkManagement Platform ethernet interfaces) in the policy enforcement groups
to assign them to the infected host profiles with Monitor action.

If you edit an existing infected host profile with either Drop Connection or Quarantine action toMonitor
action, you cannot assign any policy enforcement group having only third-party connector devices or
the combination of Junos Space and third-party connector devices.

3. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

4. Click OK.

Snapshot is taken and policy analysis is initiated. For more information about the threat policy analysis,
see “Threat Policy Analysis Overview” on page 185. From there you can view your changes and choose
to Update now, Update later, or Save them in draft form without updating.

5. If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. Navigate to Configure>Firewall Policy>Standard Policies. Click on a
rule and you are taken to the respective rules page. In the Advanced Security column, click an item to
access the Edit Advanced Security page and select the threat prevention policy from the Threat
Prevention pulldown list.

RELATED DOCUMENTATION

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration
Steps | 40

Creating Policy Enforcement Groups | 173

Threat Policy Analysis Overview | 185
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Configuring Cloud Feeds Only

This in an outline of the configuration tasks you must complete to configure Cloud feeds only threat
prevention.

NOTE: Since devices are not enrolled to Sky ATP in Cloud feed onlymode, there is no information
to display under Monitor > Threat Prevention, and therefore those screens are unavailable.

• A Sky ATP license and account are needed for the following (Sky ATP with Juniper Connected Security,
Sky ATP, and Cloud feeds only). If you do not have a Sky ATP license, contact your local sales office or
Juniper Networks partner to place an order for a Sky ATP premium license. If you do not have a Sky
ATP account, when you configure Sky ATP, you are redirected to the Sky ATP server to create one.
Please obtain a license before you try to create a Sky ATP account. Refer to “Obtaining a Sky ATP
License” on page 62 for instructions on obtaining a Sky ATP premium license.

• Before you configure Cloud Feeds you must enter the IP address and login credentials for the policy
enforcer virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is
entered, you can begin the setup process. See “Policy Enforcer Settings” on page 70. (Refer to “Deploying
and Configuring the Policy Enforcer with OVA files” on page 44 for instructions on downloading Policy
Enforcer and creating your policy enforcer virtual machine.)
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To configure Security Director for Cloud feed only threat prevention, do the following:

NOTE: Cloud feed only configuration is similar to Sky ATP (without Juniper Connected Security)
configuration. The only differences being that devices do not have to be enrolled to Sky ATP
and the only threat prevention types available are command and control server and Geo IP.

1. Create a tenant representing an Enterprise. When a tenant is created, a VRF is assigned to the tenant.

In the UI, navigate to Devices >Secure Fabric > Tenants. Click the + icon to create a new tenant.

See “Create Secure Fabric Tenants” on page 172 for details.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

2. Create one or more Sky ATP realms and add devices to the realm. (Note that devices do not have to
be enrolled to Sky ATP for Cloud Feed only mode.)

In the UI, navigate to Configure>Threat Prevention>Sky ATP Realms. Click the + icon to add a new
Sky ATP realm.

See “Creating Sky ATP Realms and Enrolling Devices or Associating Sites” on page 159 for details.

3. Create sites and add devices to those sites.

In the UI, navigate to Devices >Secure Fabric. Click the + icon to create a new site.

See “Creating Secure Fabric and Sites” on page 167 for details.

4. Create a policy enforcement group.

In the UI, navigate toConfigure>SharedObjects>Policy EnforcementGroups. Click the + icon to create
a new policy enforcement group.

See “Creating Policy Enforcement Groups” on page 173 for details.

5. Create a threat prevention policy for Command and Control server, Geo IP, or Infected hosts.

In the UI, navigate to Configure>Threat Prevention >Policy. Click the + icon to create a new threat
prevention policy.
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See “Creating Threat Prevention Policies” on page 178 for details.

6. Configure Geo IP settings for inclusion in a firewall policy. See “Creating Geo IP Policies” on page 186.

You must select your Geo IP policy as the source and/or destination of a firewall rule before it can take
effect. Navigate to Configure > Firewall Policy > Policies.

.

RELATED DOCUMENTATION

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

Creating Geo IP Policies | 186

Creating Threat Prevention Policies | 178

Policy Enforcer Settings | 70

207



11
CHAPTER

Configuring No Sky ATP (No Selection)
(without Guided Setup)

Secure Fabric Overview | 209

Creating Secure Fabric and Sites | 210

Logical System and Virtual Routing and Forwarding Instance Overview | 213

About the Secure Fabric Tenants Page | 215

Create Secure Fabric Tenants | 216

Creating Policy Enforcement Groups | 217

Creating Custom Feeds | 219

Threat Prevention Policy Overview | 224

Creating Threat Prevention Policies | 226



Secure Fabric Overview

Secure Fabric is a collection of sites which contain network devices (switches, routers, firewalls, and other
security devices), used in policy enforcement groups.When threat prevention policies are applied to policy
enforcement groups, the system automatically discovers to which sites those groups belong. This is how
threat prevention is aggregated across your secure fabric.

• Add Enforcement Points—Click the Add Enforcement Points link to add Firewalls, Switches, and/or
Connectors. There is a one-to-one mapping between devices with sites. If a device is mapped to a site,
you cannot use the same device to map to a different site. The connector can be mapped to multiple
sites. To filter by type, click the three vertical dots beside the search field and select the check box for
the device type. See “Creating Secure Fabric and Sites” on page 167 for more information.

• Drag and Drop Enforcement Points—From the main page, you can select enforcement points and drag
them to other sites to include them there. When you drag, the enforcement point is disenrolled from
the current site and gets enrolled to the new site where the enforcement point is dropped.

You can either have switches or a connector as enforcement points and not both. However, you can
drag a switch and add to a site that already has a switch or SRX Series device.

Table 21 on page 163 shows fields on the Secure Fabric page.

Table 41: Secure Fabric Page Fields

DescriptionField

Specifies the name of the secure fabric site.Site

Specifies the name of the secure fabric tenant.Tenant

Specifies the enforcement points for that particular site, if enforcement points are already
added. If not added, click Add Enforcement Points to add Firewalls, Switches, or Connectors
as enforcement points.

A firewall icon is shown against some of the devices to indicate that they are the perimeter
firewalls.

For connectors, if you hover over the enforcement point, a tool tip is shown listing the
corresponding vSRX devices with IP addresses and descriptions.

NOTE: If tenant is configured to the site, onlyMX Series device can be added as enforcement
points.

Enforcement Points

Specifies the IP address of the enforcement point, if the enforecement point is available.IP

Specifies the type of the enforcement point. For example, vSRX, QFX, Connector.Model
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Table 41: Secure Fabric Page Fields (continued)

DescriptionField

Specifies the feed source to Policy Enforcer.Feed Source

Specifies the status of the SkyATP enrollment.

The Success status with a warning symbol indicates that the device is enabled for cloud feeds
only and there is no support for malware capability and enhanced mode. This field will be
blank if the device fails to disenroll SkyATP.

If the status is Failed, click Retry to enroll the device with Sky ATP again. You can hover over
the Failed status to see the corresponding job details. The device enroll retry option is available
only when the status is Failed.

SKYATP Enroll Status

Specifies the date on which the Secure Fabric page was last updated.Last Updated

Specifies the description that you had entered at the time of creating a secure fabric site.Description

RELATED DOCUMENTATION

Creating Secure Fabric and Sites | 167

Policy Enforcement Groups Overview | 173

Threat Prevention Policy Overview | 176

Creating Secure Fabric and Sites

You can create sites within your secure fabric from the secure fabric page.

Before You Begin

• Plan out your sites in advance. A site is a grouping of network devices, including firewalls and switches,
that contribute to threat prevention.

• Keep in mind that when you create a site, you must identify the perimeter firewalls so you can enroll
them with Sky ATP/JATP.

• If you want to enforce an infected host policy within the network, you must assign a switch to the site.
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• SRX Series devices cannot belong to multiple sites.

• MX Series devices associated with tenants can belong to multiple sites.

• Sites that are associated with tenants do not need switches as enforcement points.

• Switches and connectors cannot be added to the same site.

To create a site within your secure fabric:

1. Select Devices>Secure Fabric.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 23 on page 167 below.

4. Click OK.

5. Create a new site and add an enforcement point to a site.

Table 42: Create Site Page Fields

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-characters maximum.

Site

Select a tenant.Tenant

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description
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WARNING: If you add certain SRX SeriesDevices to your Secure Fabric as enforcement
points, you may see a warning that the device(s) must be reconfigured in enhanced
mode and require a reboot. Here is a list of SRX models that may require rebooting
for enhanced mode after being registered with Policy Enforcer/Sky ATP/JATP.

• SRX340

• SRX345

• SRX650

• SRX240h2

• SRX320

• SRX300

• SRX550

RELATED DOCUMENTATION
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Policy Enforcement Groups Overview | 173

Threat Prevention Policy Overview | 176
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Logical System and Virtual Routing and Forwarding
Instance Overview

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise and you
can assign a Virtual Routing and Forwarding (VRF) instance to a tenant. The custom feed sends feeds to
Policy Enforcer at the logical system (LSYS) and VRF instance levels on the MX Series device. The VRF
instance is dedicated to handling traffic within the tenant's private network. You can route the traffic on
the tenant’s private network from the VRF instance on the MX Series device at one site to the same VRF
instance on another MX Series device at a different site. The MX Series device supports multiple VRF
instances assigned to different tenants. Therefore, a device can be shared with multiple tenants.

NOTE: In Policy Enforcer Release 20.1R1, onlyMXSeries devices support LSYS andVRF instance.
Also, only root logical system is supported. All the sites of a realm are either with tenants or
without tenants.

When a tenant is created, a VRF instance is assigned to the tenant. When a site is associated with the
tenant, only those devices that have the VRF instance associated with the tenant can be added to the site.
When you associate a site with a realm in Juniper Sky ATP/JATP, the tenant receives the feeds configured
for the realm. TheMXSeries device performs policy enforcement based on tenant system and the associated
Juniper Sky ATP/JATP realm.

On an MX Series device, VRF instance based feeds such as C&C, allowlist, and blocklist are supported
through custom feeds as shown in Figure 71 on page 170.

NOTE: If you want to use the C&C global feed from Juniper Sky ATP/JATP, then custom feed
for C&C should not be configured in Policy Enforcer.

For, example: VRFx and VRFy are associated with tenants on MX device 1. Custom feed for tenant 1
(VRFx) and custom feed for tenant 2 (VRFy) are associated to each tenant. The custom feed provides LSYS
and VRF instance information. When the device requests for a feed, Policy Enforcer provides all the feed
data associated with the device (global without VRF instance information) in addition to all the data for
the VRF instances configured on the device that are associated with the tenants configured on Policy
Enforcer.
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Figure 72: LSYS and VRF Instance Support

WHAT'S NEXT

Create Secure Fabric Tenants | 172

Creating Secure Fabric and Sites | 167

Adding Enforcement Points | 164

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

Creating Custom Feeds | 219

RELATED DOCUMENTATION

About the Secure Fabric Tenants Page | 171

About the Feed Sources Page | 241
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About the Secure Fabric Tenants Page

To access this page, click Devices > Secure Fabric > Tenants.

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise. When a
tenant is created, a VRF instance is assigned to the tenant.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a tenant. See “Create Secure Fabric Tenants” on page 172.

You can also modify and delete a tenant.

Field Descriptions

Table 24 on page 171 provides guidelines on using the fields on the Secure Fabric Tenants page.

Table 43: Fields on the Secure Fabric Tenants Page

DescriptionField

Specifies the name of the tenant.Tenant

Specifies the root logical system.LDOM

Specifies the VRF created on the MX Series device.VRF

Specifies the name of the sites.Sites

WHAT'S NEXT

Creating Secure Fabric and Sites | 167

RELATED DOCUMENTATION
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Logical System and Virtual Routing and Forwarding Instance Overview | 169

Create Secure Fabric Tenants

To create a tenant within your secure fabric:

1. Select Devices > Secure Fabric > Tenants.

2. Click the + icon.

3. Complete the configuration using the guidelines in Table 25 on page 172.

4. Click OK.

A tenant is created. After the tenant is created, it can be associated to a site.

Table 44: Create Tenant

GuidelinesField

Enter a unique string thatmust beginwith an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

By default, the root logical system is selected, which you cannot edit. In Policy
Enforcer Release 20.1R1, only root logical system is supported.

LDOM

Enter the virtual routing and forwarding (VRF) instance name, which is created on
the MX Series device.

VRF

To edit a tenant, select a tenant and click the pencil icon.

To delete a tenant, select the delete icon. If a tenant is associated to a site, the tenant cannot be deleted.

WHAT'S NEXT

Creating Secure Fabric and Sites | 167

RELATED DOCUMENTATION
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Logical System and Virtual Routing and Forwarding Instance Overview | 169

Creating Policy Enforcement Groups

You can create policy enforcement groups from the policy enforcement groups page.

Before You Begin

• Know what type of endpoints you are including in your policy enforcement group: IP address/subnet,
or location.

• Determine what endpoints you will add to the group based on how you will configure threat prevention
according to location, users and applications, or threat risk.

• Keep in mind that endpoints cannot belong to multiple policy enforcement groups.

To create a policy enforcement group:

1. Select Configure>Shared Objects>Policy Enforcement Groups.

2. Click the + icon.

3. Complete the configuration by using the guidelines in the Table 26 on page 174 below.

4. Click OK.

Table 45: Fields on the Policy Enforcement Group Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description; maximum length is 64 characters. You should make this description as useful as
possible for all administrators.

Description

Select a group type from the available choices. IP Address/Subnet or Location.Group Type
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Table 45: Fields on the Policy Enforcement Group Page (continued)

DescriptionField

This field is available only if the Group Type field is IP Address/Subnet

The subnets of all connectors added in the Connector page are dynamically listed in the Available
column. If the Group Type is IP Address/Subnet, the subnets within the connector instances that
have the threat remediation enabled are only listed.

When using Junos Space, Policy Enforcer is able to dynamically discover subnets configured on
Juniper switches. Policy Enforcer does not have the same insight with third-party devices. Therefore
you can add subnets to your connector configuration and select them here. This allows you to
selectively apply policies to those subnets.

If you have not configured a connector, you will see only Junos Space subnets discovered by Policy
Enforcer. If you have a connector configured, you can see the subnets of a connector in the Available
column. Hover over subnets to view the description for these subnets entered during the connector
creation. You will not see any description if it is not entered during creating a connector. The
description will show “No description available” for subnets that come from Junos Space.

The Available and Selected columns have filters listed with connectors or Space. You can choose a
connector and filter only the subnets belonging to that particular connector. The result shows the
name of a device to which the subnet belongs and also the type of the device.

You can also use the search bar to search and filter the result based on subnet, name of the device,
or type of the device.

Click Refresh Available IPs to refresh the available IP addresses or subnets. If you edit any selected
items in the Selected column, the list is refreshed to the initial selected list after the refresh. A
progress bar is shown with the refresh progress in percentage.

In a scenario where there are no IP addresses or subnets, the refreshwill still be successful. Amessage
is displayed showing that the refresh was successful but there are no IP addresses or subnets found.

Connector
IPs

This field is available only if the Group Type field is IP Address/Subnet

Enter an IP address and select the connector type from the list to add to PEG. The IP address must
be within the subnet range of the selected connector. Click Add to add the additional IP address to
the Selected column of the Connector IPs field.

A validation is performed to check if the additional IP address is within the subnet range of the
selected connector. If not, an error message is shown to enter the IP address within the subnet range.

Additional
IP

Sites with the threat remediation enabled instances are only listed, if the Group Type is Location.
Select the check box beside the sites in the Available list and click the > icon to move them to the
Selected list.

The endpoints in the Selected list will be included in the policy enforcement group.

Sites

218



You can create a policy enforcement group with subnets from different connectors based on how they
have grouped their network segments. For example, If you have Junos Space EX switch with subnets HR:
1.1.1.1/24 and Finance: 2.2.2.2/24, ClearPass connector with subnets HR: 1.1.1.1/24 and Marketing:
2.2.2.2/24, Cisco ISE with subnets HR: 1.1.1.1/24 and Finance: 2.2.2.2/24. You can create a single policy
enforcement group and name it as HR by choosing the following subnets: Junos Space EX HR: 1.1.1.1/24,
ClearPass connector subnet HR: 1.1.1.1/24, and Cisco ISE connector subnet HR: 1.1.1.1/24.

RELATED DOCUMENTATION

Policy Enforcement Groups Overview | 173

Using Guided Setup for Sky ATP with Juniper Connected Security | 141

Deleting Policy Enforcement Group

Creating Custom Feeds

Use the Create Custom Feed page to configure the Dynamic Address, Allowlist, Blocklist, Infected Hosts,
and DDoS custom feeds. These feeds provide relevant and timely intelligence that you can use to create
enforcement policies.

NOTE: If you have configured Sky ATP Configuration Type as “No Selection” in the
Administration>Policy Enforcer>Settings page, only the Dynamic Address custom feed is
supported.

Before You Begin

• Knowwhat type of feed you are configuring and have all the necessary information on hand. Local feeds
are created on your local system and uploaded from there.

• Note that infected hosts are hosts known to be compromised. For an infected host custom feed, enter
host IP addresses manually or upload a text file with the IP addresses of infected hosts.
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• If you create an allowlist, blocklist, or infected hosts feed, it will override the respective Sky ATP/JATP
feed.

• Note that when Sky ATP/JATP only mode is selected as the Threat Prevention Type, the infected host
and DDoS custom feeds are not available.

To create local file and remote file custom feeds:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears. Youwill see only custom feeds available as the threat prevention type,
if you make no selection for Sky ATP/JATP Configuration Type in the Policy Enforcer Settings page.

2. Click Create and select one of the following:

• Feeds with local files—Enter your data manually into the provided fields or upload from a text file on
your location machine.

• Feeds with remote file server—Configure communication with the remote server to fetch the data
feed from it.

3. Complete the configuration by using the guidelines in Table 46 on page 221 or Table 47 on page 222.

4. Click OK.

NOTE:
• Feeds are processed in the following order: SecIntel feeds -> Policy Enforcer -> SRX Series
devices. If you configure a local feed through Policy Enforcer, the configured local feed will
overwrite the cloud feeds.

• To use a custom feed, apply it to the source or destination address in a firewall rule. In the
firewall rule, you can filter addresses to show only the custom feeds.

If there is a firewall policy rule created using the dynamic address, you cannot delete the same
dynamic address from the Feed Sources page. You must first delete the firewall policy rule
and then , delete the dynamic address from the Feed Sources page.

• When you have no Sky ATP/JATP Configuration Type selected (No selection), Sky ATP/JATP
realms are disabled. Because site selection is usually done from the Sky ATP/JATP realm page,
you must select sites from the Create Custom Feed page when in “No selection” mode. The
custom feeds are then downloaded to the devices in the chosen sites. This is the only time
site selection available in the Create Custom Feed page.
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Table 46: Fields on the Create Custom Feed Page, Feeds with Local Files

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should make this
description as useful as possible for all administrators.

Description

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Whitelist

• Blacklist

• Infected Hosts

• DDoS

• CC

Feed Type

Select the required sites from the list to associate them with the dynamic address or allowlists and
blocklists feeds.

In the default mode (no Sky ATP), only sites are listed because of no Sky ATP. You can share a site
across the same feed type for dynamic address, allowlist, and blocklist. For Infected hosts and
DDoS, sites cannot be shared across the same feed type. However, you can share a site across
different feed types.

Sites

Select the required realms from the list, if you are in Cloud feeds only, Sky ATP/JATP, or Sky
ATP/JATP with Juniper Connected Security mode.

Associate these realms with dynamic address or allowlists and blocklists feeds. You can share a
realm across the same feed type for dynamic address, allowlist, and blocklist. For Infected hosts
and DDoS, realms cannot be shared across the same feed type. However, you can share a realm
across different feed types.

The Sky ATP/JATP realm without any assigned sites are not listed here. Only realms with sites
associated are listed here.

NOTE: If a site is associated with a tenant, the Sky ATP/JATP realm displays the list in the
<realm-name>(Tenant:<tenant-name>) format.

Zones/Realms
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Table 46: Fields on the Create Custom Feed Page, Feeds with Local Files (continued)

DescriptionField

Select one of the following input types for Whitelist and Blacklist:

• IP, Subnet and Range—Enter an IPV4 address in standard four octet format. CIDR notation and
IP address ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30,
or 1.2.3.4-1.2.3.6.

• URL and Domain—Enter the URL using the following format: http://yourfeed.com/abc and
Domain using the following format: http://yourfeed.com.

Wildcards and protocols are not valid entries.

User Input Type

(Available for
Allowlist and
Blocklist)

Do one of the following:

• Click Upload File to upload a text file with an IP address list. Click the Add button to include the
address list in your custom list.

For infected host andDDoS, the uploading file must have the string add at the beginning, followed
by the IP addresses. If you want to delete certain IP addresses, enter the string delete followed
by the IP addresses to delete.

Note that the file must contain only one item per line (no commas or semi colons). All items are
validated before being added to the custom list.

The file must not contain more than 500 entries. An error message is shown if you try to upload
a file containing more than 500 IP addresses. Use the Feeds with remote file server option to
upload a file containing more than 500 IP addresses.

• Manually enter your item and threshhold value in the space provided in the Custom List section.
To add more items, click + to add more spaces.

For syntax, enter an IPv4 address in standard four octet format. CIDR notation and IP address
ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or
1.2.3.4-1.2.3.6.

Custom List

Table 47: Fields on the Create Custom Feed Page, Feeds with Remote File Server

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
only dashes and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should
make this description as useful as possible for all administrators.

Description
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Table 47: Fields on the Create Custom Feed Page, Feeds with Remote File Server (continued)

DescriptionField

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Blocklist

• Infected Hosts

• DDoS

• CC

Feed Type

Select one of the following:

• http

• https

Type of Server URL

Enter the URL for the remote file server.Server File URL

Click Browse and select the CA certificate to upload.

If you do not upload a certificate for https server URL, a warning message is shown
that a certificate is not uploaded and to whether proceed further or not. Click Yes to
proceed further without uploading a certificate or No to go back and upload the
certificate.

Certificate Upload

(If the URL type is HTTPS)

Enter the credentials for the remote file server.

This is not a mandatory field. You can still proceed to create a custom feed without
entering the username.

Username

Enter the credentials for the remote file server.

This is a mandatory field, if you have provided the username.

Password

Select how often updates are retrieved from the remote files server: Hourly, Daily,
Weekly, Monthly, Never

Update Interval

Select the required sites from the list to associate them with the custom feeds.Sites

If you try to disenroll a site in an infected host, a warning message is shown to resolve all the current
infected hosts from the respective endpoints within a site. To resolve the infected hosts, log-in to Sky ATP
UI, resolve the hosts, and then unassign sites from Policy Enforcer. Ensure that you always resolve the
infected hosts before unassigning sites. Once you unassign sites, you cannot resolve the hosts.
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RELATED DOCUMENTATION

Custom Feed Sources Overview | 240

About the Feed Sources Page | 241

Configuring Settings for Custom Feeds | 271

Threat Prevention Policy Overview

Threat prevention policies provide protection andmonitoring for selected threat profiles, including command
and control servers, infected hosts, and malware. Using feeds from Sky ATP and optional custom feeds
that you configure, ingress and egress traffic is monitored for suspicious content and behavior. Based on
a threat score, detected threats are evaluated and action may be taken once a verdict is reached.

Once policies are configured, the following fields are available on the Security Director main page to
provide an overview of each policy.

Table 48: Threat Prevention Policy Fields

DescriptionField

The user-created name for the policy.Name

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.) For example:

Block: 8-10

Monitor: 5-7

Permit: 1-4

Profile: C&C Server

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Infected Host

Threat score settings overview if selected for the policy.
(Otherwise this is empty.)

Profile: Malware HTTP

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Malware SMTP
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Table 48: Threat Prevention Policy Fields (continued)

DescriptionField

This displays the status of the policy. This status is a
clickable link you can use to change the policy status.
When you first create a policy and assign it to a group,
this field readsViewAnalysis. Read “Threat Policy Analysis
Overview” on page 185 for more information on this field.

If the status is Update Failed, click Retry to perform the
rule analysis again. You can click the Update Failed status
to see the corresponding job details. The rule analysis retry
option is available only when the status is Update Failed.

NOTE: If the policy has been updated after it has already
been pushed to the endpoint, the status here is Update
with a warning icon to notify you the policy has been
changed but not pushed.

Status

This is the group to which the policy is assigned.Policy Enforcement Group

This field displays the log setting for the policy.Log

The user-created description for the policy.Description

Benefits of Threat Prevention Policy

• Enables you to define and enforce policies for controlling specific applications and embedded social
networking widgets.

• Reduces the need for manual updates and automatically applies policies and enforcement rules, driving
down the costs of managing network security.

• Leverages the network for multiple enforcement points across the infrastructure. Enables you to stop
threats closer to infection points and to prevent threats from spreading, which greatly improves the
efficacy of security operations.

RELATED DOCUMENTATION

Creating Threat Prevention Policies | 178

Policy Enforcement Groups Overview | 173
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Creating Geo IP Policies | 186

Policy Enforcer Overview | 18

Benefits of Policy Enforcer | 20

Policy Enforcer Components and Dependencies | 27

Sky ATP Overview | 23

Creating Threat Prevention Policies

You can create threat prevention policies for various profiles from the Policies page.

NOTE: If you are creating policies for the first time, you are given the option of setting up Policy
Enforcer with Sky ATP or configuring Sky ATP alone. Clicking either button takes you to quick
setup for your selection. See “Comparing the Juniper Connected Security and non-Juniper
Connected Security Configuration Steps” on page 40 for a configuration comparison.

Before You Begin

• Determine the type of profile you will use for this policy; command & control server, infected hosts,
malware. You can select one or more threat profiles in a policy. Note that you configure Geo IP policies
separately. See “Creating Geo IP Policies” on page 186.

• Determine what action to take if a threat is found.

• Know what policy enforcement group you will add to this policy. To apply the policy, you must assign
one or more policy enforcement groups. See the instructions for assigning groups to policies at the
bottom of this page.

• Once policies are configured with one more groups assigned, you can save a policy in draft form or
update it. Policies changes do not go live until they have been updated.

• If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. See the instructions at the bottom of this page.

• If you delete a threat prevention policy that is assigned to a policy enforcement group, a status screen
appears displaying the progress of the deletion and the affected configuration items.
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To create a threat prevention policy:

1. Select Configure>Threat Prevention > Policies.

2. Click the + icon.

The Create Threat Prevention Policy page appears.

3. Complete the configuration by using the guidelines in theTable 28 on page 179, Table 29 on page 180,
Table 30 on page 180, Table 31 on page 181, and Table 32 on page 183 below.

4. Click OK.

Table 49: Fields on the Threat Prevention Policy Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

Include the following profiles to your threat prevention policy. Youmust include at least
one profile. An error message is shown if you try to create the threat prevention policy
without selecting a profile.

• C&C profile—See Table 29 on page 180.

• Infected host profile—See Table 30 on page 180.

• Malware profile—See Table 31 on page 181.

• DDoS profile—See Table 32 on page 183.

Profiles

Select the log setting for the policy. You can log all traffic, log only blocked traffic, or
log no traffic.

Log Setting (Policy
setting for all profiles)

Table 29 on page 180 shows the management of command and control server threat in a policy.

Table 50: C&C Server Profile Management

DescriptionField

Select and choose settings for command and control servers. A C&C is a centralized computer
that issues commands to botnets (compromised networks of computers) and receives reports
back from them. Botnets can be used to gather sensitive information, such as account numbers
or credit card information, or to participate in a distributed denial-of-service (DDoS) attack.

CommandandControl
Server
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Table 50: C&C Server Profile Management (continued)

DescriptionField

Select the check box to include management for this threat type in the policy.Include C& C profile in
policy

Use the slider to change the action to be taken based on the threat score. Threat scores are
assigned using several criteria. Refer to the monitoring pages in the UI to investigate, located
underMonitor > Threat Management.

Threat Score

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custommessage—In the field provided, enter amessage to be shown to users when
connections are dropped.

• Permit the connection block.

Actions

Table 30 on page 180 shows the management of infected host threat in a policy.

Table 51: Infected Host Profile Management

DescriptionField

Infected hosts are systems for which there is a high confidence that attackers have gained
unauthorized access. Infected hosts data feeds are listed with the IP address or IP subnet of
the host, along with a threat score.

Infected Host

Select the check box to include management for this threat type in the policy.

NOTE: If you want to enforce an infected host policy within the network, you must include a
switch in the site.

Include infected host
profile in policy
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Table 51: Infected Host Profile Management (continued)

DescriptionField

You have following options:

• Drop connection silently (This is the default and recommended setting.)

• Monitor—Choose this option to log all the traffic for certain infected hosts and monitor it.
You can then choose to perform any action on the monitored data.

NOTE: The PEG must contain only Space subnets or devices. The Monitor action for the
infected host profile is not applicable to any third party connector devices. An error message
is shown.

• Quarantine—In the field provided, enter a VLAN to which quarantined files are sent. (Note
that the fallback option is to block and drop the connection silently.)

• Permit

Actions

Table 31 on page 181 shows the management of malware threat in a policy.

Table 52: Malware Threat Profile Management

DescriptionField

Malware is files that are downloaded by hosts or received as email attachments and found
to be suspicious based on known signatures, URLs. or other heuristics.

Malware (HTTP file
download, SMTP File
attachment, and IMAP
attachments)

Select the check box to include management for this threat type in the policy.Include malware profile in
policy

Turn this feature on to scan files downloaded over HTTP and then select a file scanning
device profile. The device profile is configured using Sky ATP.

HTTP file download

Turn this feature to scan encrypted files downloaded over HTTPS.Scan HTTPS

Select a Sky ATP device profile. This is configured through Sky ATP. Sky ATP profiles let
you define which files to send to the cloud for inspection. You can group types of files to
be scanned together under a common name and create multiple profiles based on the
content you want scanned.

Device Profile
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Table 52: Malware Threat Profile Management (continued)

DescriptionField

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custom message—In the field provided, enter a message to be shown to users
when connections are dropped.

• Permit

Actions

Turn this feature on to inspect files received as email attachments (over SMTP only).SMTP File Attachments

Enable this option to configure reverse proxy for SMTP.

The reverse proxy does not prohibit server certificates. It forwards the actual server
certificate or chain as is to the client without modifying it.

Scan SMTPS

If you do not click the Change button to select a device profile for SMTP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for SMTP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP and
SMTP. (Note: There is no monitoring setting for malware.)

Threat Score

Actions for SMTP File Attachments include: Quarantine, Deliver malicious messages with
warning headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Turn this feature on to select a a file scanning device profile and threat score ranges to
apply to IMAP e-mails.

IMAP Attachments

Enable this option to configure reverse proxy for IMAP e-mails.Scan IMAPS
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Table 52: Malware Threat Profile Management (continued)

DescriptionField

If you do not click the Change button to select a device profile for IMAP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for IMAP.

Device profiles are configured through Sky ATP and define which files to send to the
cloud for inspection.

Device Profile

Actions for IMAP Attachments include: Block, Deliver malicious messages with warning
headers added, and Permit. This actions are set in Sky ATP. Refer to the Sky ATP
documentation for information.

Actions

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP, SMTP,
and IMAP. (Note: There is no monitoring setting for malware.)

Threat Score

Table 32 on page 183 shows the management of DDoS threat in a policy

Table 53: DDoS Threat Profile Management

DescriptionField

Enable this option to include themanagement of Distributed denial-of-service (DDoS) protection
that enables the MX router to quickly identify an attack and prevent a flood of malicious control
packets from exhausting system resources.

When you create a threat policy for the DDoS profile, it is not pushed to the device because the
policy is not yet assigned to any device. Assign the policy to the policy enforcement group.
Because the policy is created for the MX router, rule analysis is not initiated when a policy is
assigned to the policy enforcement group (PEG).

Include DDoS
Profile in Policy

Select the following actions from the list for the DDoS profile:

• Block—Use this option to block the DDoS attack.

• Rate Limit Value—Use this option to limit the bandwidth on the flow route. You can express
the rate limit value in Kbps, Mbps, or Gbps units. The rate limit range is 10Kbps to 100Gbps.

• Forward to—Use this option to configure the routing next hop to forward the packets for
scrubbing.

Actions

Specify a routing instance to which packets are forwarded in the as-number:community-value
format, where each value is a decimal number. For example, 65001:100.

Scrubbing Site
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Once you have a threat prevention policy, you assign one or more groups to it:

1. In the threat prevention policy main page (located under Configure>Threat Prevention > Policy), find
the appropriate policy.

2. In the Policy Enforcement Groups column, click theAssign toGroups link that appears herewhen there
are no policy enforcement groups assigned or click the group name that appears in this column to edit
the existing list of assigned groups. You can also select the check box beside a policy and click the
Assign toGroups button at the top of the page. See “Policy Enforcement GroupsOverview” on page 173
.

For the infected host profiles created with Monitor action, you cannot assign a policy enforcement
group if it contains only the third-party connector devices or the combination of both Junos Space and
third-party connector devices. You must have only the Junos Space subnets (IP addresses assigned to
the Junos Space NetworkManagement Platform ethernet interfaces) in the policy enforcement groups
to assign them to the infected host profiles with Monitor action.

If you edit an existing infected host profile with either Drop Connection or Quarantine action toMonitor
action, you cannot assign any policy enforcement group having only third-party connector devices or
the combination of Junos Space and third-party connector devices.

3. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

4. Click OK.

Snapshot is taken and policy analysis is initiated. For more information about the threat policy analysis,
see “Threat Policy Analysis Overview” on page 185. From there you can view your changes and choose
to Update now, Update later, or Save them in draft form without updating.

5. If you are using Sky ATP without Policy Enforcer, you must assign your threat prevention policy to a
firewall rule for it to take affect. Navigate to Configure>Firewall Policy>Standard Policies. Click on a
rule and you are taken to the respective rules page. In the Advanced Security column, click an item to
access the Edit Advanced Security page and select the threat prevention policy from the Threat
Prevention pulldown list.
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Sky ATP Realm Overview

A security realm is a group identifier for an organization used to restrict access to Web applications. You
must create at least one security realm to login into Sky ATP. Once you create a realm, you can enroll SRX
Series devices into the realm. You can also givemore users (administrators) permission to access the realm.

If you have multiple security realms, note that each SRX Series device can only be bound to one realm,
and users cannot travel between realms.

RELATED DOCUMENTATION

About the Feed Sources Page | 241

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

Using Guided Setup for Sky ATP | 148

Configuring Sky ATP (No Juniper Connected Security and No Guided Setup) Overview | 189

Sky ATP Email Management Overview

With Email Management, enrolled devices transparently submit potentially malicious email attachments
to the cloud for inspection. Once an attachment is evaluated, Sky ATP assigns the file a threat score
between 0-10 with 10 being the most malicious.

NOTE: If an email contains no attachments, it is allowed to pass without any analysis.

Configure one of the following actions when an email attachment is determined to be malicious:

• Quarantine Malicious Messages—If you select to quarantine emails with attachments found to be
malicious, those emails are stored in the cloud in an encrypted form and a replacement email is sent to
the intended recipient. That replacement email informs the recipient of the quarantined message and
provides a link to the Sky ATP quarantine portal where the email can be previewed. The recipient can
then choose to release the email by clicking a Release button (or request that the administrator release
it) or Delete the email.

• Deliver malicious messages with warning headers added—When you select this option, headers are
added to emails that most mail servers recognize and filter into Spam or Junk folders.

• Permit—You can select to permit the email and the recipient receives it intact.
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Figure 73: Email Management Overview

Quarantine Release

If the recipient selects to release a quarantined email, it is allowed to pass through the SRX series with a
header message that prevents it from being quarantined again, but the attachments are placed in a
password-protected ZIP file. The password required to open the ZIP file is also included as a separate
attachment. The administrator is notified when the recipient takes an action on the email (either to release
or delete it).

If you configure Sky ATP to have the recipient send a request to the administrator to release the email,
the recipient previews the email in the Sky ATP quarantine portal and can select to Delete the email or
Request to Release. The recipient receives amessagewhen the administrator takes action (either to release
or delete the email.)

Blocklist and Allowlist

Emails are checked against administrator-configured blocklists and allowlists using information such as
Envelope From (MAIL FROM), Envelope To (RCPT TO), Body Sender, Body Receiver. If an email matches
the allowlist, that email is allowed through without any scanning. If an email matches the blocklist, it is
considered to be malicious and is handled the same way as an email with a malicious attachment.
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RELATED DOCUMENTATION

Sky ATP Email Management: SMTP Settings | 249

Sky ATP Malware Management Overview

Malware management includes profiles you can create to group file types together for scanning. It also
lets you configure customized allowlists and blocklists.

• File inspection profiles let you define which files to send to the cloud for inspection. By grouping similar
file types together to be scanned (such as .tar, .exe, and .java) under a common name, you can create
multiple profiles based on the content you want scanned. Then enter the profile names on eligible SRX
Series devices to apply them.

• Use the allowlist and blocklist pages to configure custom trusted and untrusted URLs and IPs. Content
downloaded from locations on the allowlist is trusted and does not have to be inspected for malware.
Hosts cannot download content from locations on the blocklist because those locations are untrusted.

RELATED DOCUMENTATION

Creating File Inspection Profiles | 259

File Inspection Profiles Overview

File Inspection profiles let you define which files to send to the cloud for inspection. You can group types
of files to be scanned together (such as .tar, .exe, and .java) under a common name and create multiple
profiles based on the content you want scanned. Then enter the profile names on eligible devices to apply
them.

Table 54: File Category Contents

DescriptionCategory

Archive filesArchive

Configuration filesConfiguration

All document types except PDFsDocument
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Table 54: File Category Contents (continued)

DescriptionCategory

Executable binariesExecutable

Java applications, archives, and librariesJava

Dynamic and static libraries and kernel modulesLibrary

Mobile formatsMobile

OS-specific update applicationsOS package

PDF, e-mail, and MBOX filesPDF

Installable Internet Applications such as Adobe Flash, JavaFX, Microsoft
Silverlight

Rich Application

Scripting filesScript

You can also define the maximum file size requirement per each category to send to the cloud. If a file
falls outside of the maximum file size limit the file is automatically downloaded to the client system.

NOTE: Once the profile is created, use the set services advanced-anti-malware policy CLI
command to associate it with the Sky ATP profile.

NOTE: If you are using the free model of Sky ATP, you are limited to only the executable file
category.

RELATED DOCUMENTATION

Creating File Inspection Profiles | 259

Sky ATP Malware Management Overview | 238

File Scanning Limits | 303
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Custom Feed Sources Overview

Policy Enforcer uses threat feeds to provide actionable intelligence to policies about various types of
threats. These feeds can come fromdifferent sources, such as Sky ATP, and from lists that you can customize
by adding IP addresses, domains, and URLs.

NOTE: Sky ATP feeds and custom feeds are mutually exclusive. You can only have one source
for allowlist, blocklist, and infected host feeds.

The following types of custom threat feeds are available:

• A dynamic address is a group of IP addresses that can be imported from external sources. These IP
addresses are for specific domains or for entities that have a common attribute such as a particular
undesired location that poses a threat. You can then configure security policies to use the dynamic
addresses within a security policy.

• An allowlist contains known trusted IP addresses, URLs, and domains. Content downloaded from locations
on the allowlist does not have to be inspected for malware.

• A blocklist contains known untrusted IP addresses, URLs, and domains. Access to locations on the
blocklist is blocked, and therefore no content can be downloaded from those sites.

• Infected hosts are hosts known to be compromised. Enter host IP addresses manually or upload a text
file with the IP addresses of infected hosts.

• Using DDoS threat feed, policy Enforcer blocks source IP addresses in the feed, rate limit the traffic
from the source IP addresses, and takes BGP Flowspec action to apply null-route filtering or redirect
the traffic to scrubbing centers.

For threat management policies to use these feeds, you must enter configuration information for each
feed type.

Benefits of Custom Feed Sources

• Provides relevant and timely intelligence that you can use to create enforcement policies. Enables you
to customize threat feeds specific to your industry or organization.

• Provides flexible mechanisms to synchronize threat information to:

• Configure Policy Enforcer to poll from local file and remote file custom feeds.

• Push threat feeds to Policy Enforcer using the Threat Feed API .
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RELATED DOCUMENTATION

Creating Custom Feeds | 219

Example: Creating a Dynamic Address Custom Feed and Firewall Policy | 269

About the Feed Sources Page

To access this page, click Configure > Threat Prevention > Feed Sources.

Policy Enforcer uses threat feeds to provide actionable intelligence to policies about various types of
threats. These feeds can come from different sources, such as Sky ATP, Juniper ATP, and from lists that
you can customize by adding IP addresses, domains, and URLs.

You can add allowlist and blocklist in Sky ATP and as well as in Custom feeds. When you add an allowlist
or blocklist in Custom feeds, a warning message shows that it will erase the existing allowlist or a blocklist
in Sky ATP, if any. You can only have one source for allowlist, blocklist, and infected host feeds.

Tasks You Can Perform

You can perform the following tasks from the Sky ATP page:

• Add a Sky ATP realm. See “Creating Sky ATP Realms and Enrolling Devices or Associating Sites” on
page 159.

• Inspect andmanage email attachments sent over SMTP. See “SkyATPEmailManagement: SMTP Settings”
on page 249.

• Configure email management for IMAP. See “Configure IMAP Settings” on page 256.

• Configure Allowlist and Blocklist. See “Creating Allowlist for Sky ATP Email and Malware Management”
on page 252 and “Creating Blocklists for Sky ATP Email and Malware Management” on page 254.

• Configure file inspection profiles. See “Creating File Inspection Profiles” on page 259.

• Edit the Sky ATP realm. See “Modifying Sky ATP Realm” on page 248.

• Delete the Sky ATP realm.

You can perform the following tasks from the JATP page:

• Add JATP server. See “Add JATP Server” on page 261.

• Edit the JATP server configuration. See “Edit or Delete a JATP Server” on page 263

• Delete the JATP server.
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You can perform the following tasks from the Custom Feeds page:

• Create custom feeds for the dynamic address, allowlist, blocklist, infected hosts, and DDoS feed types.
See “Creating Custom Feeds” on page 219.

• Configure settings. See “Configuring Settings for Custom Feeds” on page 271.

• Edit the custom feed.

• Delete the custom feed.

Field Descriptions

Table 55 on page 242 provides guidelines on using the fields on the Feed Sources page.

Table 55: Fields on the Feed Sources Page

DescriptionField

Sky ATP

Name of the Sky ATP realm.Realm

Name of the site associated to the realm.Sites

Name of the perimeter firewall devices that are enrolled to Sky ATP.Devices

Region of the Sky ATP realm.Location

Enrollment status of the realm.Enrollment Status

Expiry date and time of a token generated at the Sky ATP side when a realm is registered.
The tokenwill be valid for one year. Once the token expires, the status is flipped to Expired.

Thirty days prior to the expiry date, renew option is enabled to renew the token. Click
Renew to renew the token. Enter the realm credentials in the renew window and if the
realm credentials are valid, a new token is generated and assigned to the realm. The old
and the expired token is deleted.

NOTE: The username (e-mail address) that you provide as realm credentials must exactly
match with the username that is used while creating a realm in Juniper Sky ATP. To view
the username in the Juniper Sky ATP user interface, go to Administration>Users.

The e-mail address used as a username is case sensitive. If there is a mismatch in the
username, the validation of realm credentials fails and the token will not be renewed.

Token Expiry
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Table 55: Fields on the Feed Sources Page (continued)

DescriptionField

The consolidated status of all the feeds of a selected Sky ATP realm is shown here.

If the status of any one of the feeds is FAILED, then the consolidated status is shown as
FAILED. Hover over the field to see the individual status of each feed. The status of IPv6
feeds are also listed along with other feed sources.

Feed Status

The date and time of the last time Policy Enforcer has requested the feeds from Sky ATP
is shown here. Hover over the field to view a detailed list of date and time of each feed
download.

Last Downloaded

JATP

Name of the Juniper ATP zone.Zone Name

Name of the site associated to the zone.Sites

The consolidated status of all the feeds of a selected Juniper ATP zone is shown here.
Hover over the field to see the individual status of each feed. The status of IPv6 feeds are
also listed along with other feed sources.

If the status of any one of the feeds is FAILED, then the consolidated status is shown as
FAILED.

Feed Status

The date and time of the last time Policy Enforcer has requested the feeds from Juniper
ATP is shown here. Hover over the field to view a detailed list of date and time of each
feed download.

Last Downloaded

Name of the perimeter firewall devices that are enrolled to Juniper ATP.Devices

Enrollment status of the zone.Enrollment Status

The IP address of the configured Juniper ATP appliance.Server IP Address

Custom Feeds

Name of the custom feed.Name

Type of the custom feed. For example, dynamic address, allowlist, blocklist, infected hosts,
or DDoS.

Feed Type

Date and time when the selected custom feed was last updated.Last Updated

Number of days within which the custom feed is going to expire or become inactive.Days to Become Inactive
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Table 55: Fields on the Feed Sources Page (continued)

DescriptionField

View the status of downloading feeds from a remote file server to Policy Enforcer. This
field is blank for the locally created custom feeds.

The following statuses are shown under different scenarios:

• Pending—Status is shown as pending until Policy Enforcer downloads the new feeds
from the remote file server.

• Success—Status is shown as success when Policy Enforcer downloads the feeds
successfully.

• Failed—Status is shown as failed when downloading the feeds fails.

RemoteDownload Status

View the description of your custom feed.Description

In the Custom Feeds page, you can search for any particular custom feed by its name and type of the
custom feed. Click the filter icon and the following fields can be searchable:

• Name—Enter the name of the custom feed to be searched.

• Feed Type—Select the feed type from the list.

RELATED DOCUMENTATION
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Creating Sky ATP Realms and Enrolling Devices or
Associating Sites

You can select a geographical location and enter your Juniper Sky ATP credentials to create a realm and
associate sites or devices with the realm.

If you do not have a Juniper Sky ATP account, select a geographical region and click here. You are redirected
to the Juniper Sky ATP account page.

Before You Begin

• Understandwhich type of Juniper Sky ATP license you have: free, basic, or premium. The license controls
which Juniper Sky ATP features are available.

• To configure a Juniper Sky ATP realm, you must already have a Juniper Sky ATP account with an
associated license.

• Ensure that the internet connectivity is available for Policy Enforcer. Without the internet connectivity,
you cannot create a realm.

• Decide which region will be covered by the realm you are creating. You must a select a region when you
configure a realm.

• Note that adding a device to a realm results in one or more commit operations occurring on the device
to apply the Juniper Sky ATP or Policy Enforcer configuration.

To configure a Sky ATP Realm:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the Sky ATP tab, click the + icon to add a realm.

3. Complete the initial configuration by using the guidelines in Table 20 on page 159 below.

4. Click Finish.

Table 56: Fields on the Add Sky ATP Realm Page

DescriptionField

Sky ATP Realm Credentials
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Table 56: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Select a region of the world from the available choices.

The following options are available in the Location list:

• North America

• European Region

• Canada

• Asia Pacific

By default, the North America value appears in the list. To know more about the geographic
region, see here.

Location

The username for Sky ATP is your e-mail address.Username

Enter a unique string at least 8 characters long. Include both uppercase and lowercase letters,
at least one number, and at least one special character (~!@#$%^&*()_-+={}[]|:;<>,./?); no spaces
are allowed, and you cannot use the same sequence of characters that are in your username.

Password

Enter a name for the security realm. This should be a name that is meaningful to your organization.
A realm name can only contain alphanumeric characters and the dash symbol. Once created,
this name cannot be changed.

NOTE: When you create a custom feed with a realm, the feed is associated at the site level and
not at the realm level. If you modify this realm and associate new sites to it, a warning message
is shown that there are custom feeds are associatedwith this realm. Changing the site information
will change the custom feed information. You must go and edit the custom feed that was
associated with this realm and verify the realm association.

Realm

Site

Select one or more sites to enroll into the realm. If there are no sites associated with the realm,
click Create new site. To knowmore about creating a new site, see “Creating Secure Fabric and
Sites” on page 167.

NOTE:
• If you are using Juniper Sky ATP without Policy Enforcer, you are not prompted to select a
site.

• Assigning a site to the realm will cause a change in the device configuration in the associated
devices.

• You must select the sites either with tenants or without tenants. You cannot select both at a
time.

Site
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Table 56: Fields on the Add Sky ATP Realm Page (continued)

DescriptionField

Lists all devices from the realm that are not managed in Security Director. You must manually
discover them.

If you are using Juniper Sky ATP with Policy Enforcer and you have no devices enrolled in the
realm, you are asked to select devices in the box on the left and move them to the right to enroll
them. All selected devices are automatically enrolled with Juniper Sky ATP when you finish the
guided setup. To disenroll a device, you can edit a realm and move the device back to the left
side box.

NOTE: Adding a device to a realm results in one or more commit operations occurring on the
device to apply the Juniper Sky ATP or Policy Enforcer configuration.

Unmanaged
Devices

Global Configuration

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the selected
administrators notifying about the infected host events.

Click the+ sign if you want to add new administrators to the list.

Threat Level
Threshold

Enable this option to log the Malware or the Host Status event or both the event types.Logging

Click the add icon (+) to enter the trusted IPv4 address of the proxy server, in the Server IP
column.

When there is a proxy server between users on the network and a firewall, the firewall might
see the proxy server IP address as the source of an HTTP or HTTPS request, instead of the
actual address of the user making the request.

With this in mind, X-Forwarded-For (XFF) is a standard header added to packets by a proxy
server that includes the real IP address of the client making the request. Therefore, if you add
trusted proxy servers IP addresses to the list in Juniper Sky ATP, by matching this list with the
IP addresses in the HTTP header (X-Forwarded-For field) for requests sent from the SRX Series
devices, Juniper Sky ATP can determines the originating IP address.

NOTE: XFF only applies to HTTP or HTTPS traffic, and only if the proxy server supports the
XFF header.

Proxy Servers
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NOTE: If you enrolled a device into a realm from within Security Director and you want to
disenroll it, you must do that from within Security Director. If you enrolled a device into a realm
from within Sky ATP and you want to disenroll it, you must do that from within Sky ATP. You
cannot disenroll a device from within Security Directory that was enrolled from within Sky ATP.

RELATED DOCUMENTATION

About the Feed Sources Page | 241

Sky ATP Realm Overview | 190

Using Guided Setup for Sky ATP | 148

Creating Secure Fabric and Sites | 167

Modifying Sky ATP Realm

Use the Modify Sky ATP Realm page to modify the site information and global configuration information
of an existing Juniper Sky ATP realm. You can also view devices from the realm that are not managed by
Security Director.

To modify a Juniper Sky ATP realm:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Select the realm and click the pencil icon to modify the configuration.

The Modify Sky ATP Realm page appears.

3. Complete the configuration by using the guidelines in Table 57 on page 249.

4. Click Finish to complete the configuration or Cancel to discard the changes.

NOTE: Assigning a site to the realm will cause a change in the device configuration in the
associated devices.
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Table 57: Fields on the Modify Sky ATP Realm page

DescriptionField

Site

Select a site to enroll into the realm. If there are no sites associated with the realm,
click Create new site.

Site

Lists all devices from the realm that are not managed in Security Director. You must
manually discover them.

Unmanaged Devices

Global Configuration

Enable this option to receive IPv6 feeds from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the
selected administrators notifying about the infected host events.

Threat Level Threshold

Enable or disable logging for the Malware or the Host Status event.Logging

Click the add icon (+) to enter the IPv4 address of the proxy server, in the Server IP
column.

You can also edit the existing IP address or delete them.

Proxy Servers

RELATED DOCUMENTATION

Creating Sky ATP Realms and Enrolling Devices or Associating Sites | 159

About the Feed Sources Page | 241

Sky ATP Email Management: SMTP Settings

Use the SMTP Settings page to inspect and manage email attachments sent over SMTP.

Before You Begin

• Read the “Sky ATP Email Management Overview” on page 236 topic.
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• Decide how malicious emails are handled: quarantined, delivered with headers, or permitted.

To configure the email management settings for the Sky ATP realm:

1. Select Configure > Threat Prevention > Feed Sources.

The Feed Sources page appears

2. Under the Sky ATP tab, right-click a Sky ATP Realm or from the More list, select SMTP Settings.

3. Based on your selections, configuration options described in Table 58 on page 250, Table 59 on page 251,
and Table 60 on page 251.

Table 58: Configure Quarantine Malicious Messages

GuidelineSetting

Quarantine malicious messages (the default)—When you select to
quarantinemalicious email messages, in place of the original email, intended
recipients receive a custom email you configure with information on the
quarantining. Both the original email and the attachment are stored in the
cloud in an encrypted format.

Action to take

• Recipients can release email—This option provides recipients with a link
to the Sky ATP quarantine portal where they can preview the email.
From the portal, recipients can select to Release the email or Delete it.
Either action causes a message to be sent to the administrator.

NOTE: If a quarantined email has multiple recipients, any individual
recipient can release the email from the portal and all recipients will
receive it. Similarly, if one recipient deletes the email from the portal, it
is deleted for all recipients.

• Recipients can request administrator to release email—This option also
provides recipients with a link to the Sky ATP quarantine portal where
they can preview the email. From the portal, recipients can select to
Request toRelease the email orDelete it. Either choice causes amessage
to be sent to the administrator. When the administrator takes action on
the email, a message is sent to the recipient.

NOTE: When a quarantined email is released, it is allowed to pass through
the SRX series with a header message that prevents it from being
quarantined again, but the attachment is placed inside a
password-protected zip file with a text file containing the password that
the recipient must use to open the file.

Release option

Email Notifications for End Users

250



Table 58: Configure Quarantine Malicious Messages (continued)

GuidelineSetting

If you have a corporate web site with further information for users, enter
that URL here. If you leave this field blank, this option will not appear to
the end user.

Learn More Link URL

When an email is quarantined, the recipient receives a custom message
informing them of their quarantined email. For this custommessage, enter
a subject indicating a suspicious email sent to them has been quarantined,
such as "Malware Detected."

Subject

Enter information to help email recipients understand what they should
do next.

Custom Message

Enter custom text for the Sky ATP quarantine portal link where recipients
can preview quarantined emails and take action on them.

Click Preview to view the custom message that will be sent to a recipient
when an email is quarantined.

Custom Link Text

Table 59: Configure Deliver with Warning Headers

GuidelineSetting

Delivermaliciousmessageswithwarning headers added—When you select
to deliver a suspicious email with warning headers, you can add headers
to emails that most mail servers will recognize and filter into spam or junk
folders.

Action to take

• X-Distribution (Bulk, Spam)—Use this header for messages that are sent
to a large distribution list and are most likely spam. You can also select
“Do not add this header.”

• X-Spam-Flag—This is a common header added to incoming emails that
are possibly spam and should be redirected into spam or junk folders.
You can also select “Do not add this header.”

• Subject Prefix—You can prepend headers with information for the
recipient, such as "Possible Spam."

SMTP Headers

Table 60: Permit

GuidelineSetting

Permit—You can select to permit themessage and no further configuration
is required.

Action to take
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To send notifications to administrators when emails are quarantined or released from quarantine:

1. Click the + sign to add an administrator.

2. Enter the administrator's email address.

3. Select the Quarantine Notification check box to receive those notifications.

4. Select the Release Notifications check box to receive those notifications.

5. Click OK.

RELATED DOCUMENTATION

Sky ATP Email Management Overview | 236

Creating Allowlist for Sky ATP Email and Malware
Management

Use theModifyWhitelist page to add email addresses, IP addresses, and URLs to the allowlist. An allowlist
contains known trusted IP addresses, URLs, and domains. Content downloaded from locations on the
allowlist does not have to be inspected for malware.

Before You Begin

• Read the “Sky ATP Email Management Overview” on page 236 topic.

• Read the “Sky ATP Malware Management Overview” on page 238 topic.

• Decide on the type of location you intend to define: URL or IP address.

• Review the current list of entries to ensure that the item you are adding does not already exist.
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To configure the allowlists:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the Sky ATP tab, right-click the Sky ATP realm or from the More list, selectWhitelist.

The Modify Whitelist page appears.

3. Click the + sign to add more entries to the allowlist.

4. Complete the configuration by using the guidelines in Table 61 on page 253.

5. Click OK.

Table 61: Fields on the Modify Whitelist Page

DescriptionField

Email List

The allowed email senders are listed here.

To add more email senders to the allowlist, click the + sign.

Enter the full address in the format name@domain.com or wildcard the name to permit all emails
from a specific domain. For example, *@domain.com.

Email Sender

Malware List

Enter an IP address or a URL.

• IP—Enter an IPV4 address in standard four octet format. CIDR notation and IP address ranges
are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or 1.2.3.4-1.2.3.6.

• URL—Enter the URL using the following format: juniper.net. Wildcards and protocols are not
valid entries. The system automatically adds a wildcard to the beginning and end of URLs.
Therefore juniper.net also matches a.juniper.net, a.b.juniper.net, and a.juniper.net/abc. If you
explicitly enter a.juniper.net, it matches b.a.juniper.net, but not c.juniper.net. You can enter a
specific path. If you enter juniper.net/abc, it matches x.juniper.net/abc, but not x.juniper.net/123.

IP and URL

To edit an existing allowlist entry, select the allowlist that you want to edit and click the pencil icon.

Sky ATP periodically polls for new and updated content and automatically downloads it to your SRX Series
device. There is no need to manually push your allowlist files.
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Sky ATP Email Management Overview | 236

Sky ATP Malware Management Overview | 238

About the Feed Sources Page | 241

Creating Blocklists for Sky ATP Email and Malware
Management

Use the Modify Blacklist page to add email addresses, IP addresses, and URLs to the blocklist. A blocklist
contains known untrusted IP addresses, URLs, and domains. Access to locations on the blocklist is blocked,
and therefore no content can be downloaded from those sites.

Before You Begin

• Read the “Sky ATP Email Management Overview” on page 236 topic.

• Read the “Sky ATP Malware Management Overview” on page 238 topic.

• Compile a list of knownmalicious email addresses or domains to add to your blocklist. If an email matches
the blocklist, it is considered to be malicious and is handled the same way as an email with a malicious
attachment, blocked and a replacement email is sent. If an email matches the allowlist, that email is
allowed through without any scanning.

• It is worth noting that attackers can easily fake the “From” email address of an email, making blocklists
a less effective way to stop malicious emails.

• Decide on the type of location you intend to define: URL or IP address.

• Review the current list of entries to ensure that the item you are adding does not already exist.

To configure the blocklists:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the Sky ATP tab, right-click the Sky ATP realm or from the More list, select Blacklist.

The Modify Blacklist page appears.

3. Click the + sign to add more entries to the blocklist.
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4. Complete the configuration by using the guidelines in Table 62 on page 255.

5. Click OK.

Table 62: Fields on the Modify Blacklist Page

DescriptionField

Email List

The allowed email senders are listed here.

To add more email senders to the blocklist, click the + sign.

Enter the full address in the format name@domain.com or wildcard the name to permit all emails
from a specific domain. For example, *@domain.com.

Email Sender

Malware List

Enter an IP address or a URL.

• IP—Enter an IPV4 address in standard four octet format. CIDR notation and IP address ranges
are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or 1.2.3.4-1.2.3.6.

• URL—Enter the URL using the following format: juniper.net. Wildcards and protocols are not
valid entries. The system automatically adds a wildcard to the beginning and end of URLs.
Therefore juniper.net also matches a.juniper.net, a.b.juniper.net, and a.juniper.net/abc. If you
explicitly enter a.juniper.net, it matches b.a.juniper.net, but not c.juniper.net. You can enter a
specific path. If you enter juniper.net/abc, it matches x.juniper.net/abc, but not x.juniper.net/123.

IP and URL

To edit an existing blocklist entry, select the blocklist that you want to edit and click the pencil icon.

Sky ATP periodically polls for new and updated content and automatically downloads it to your SRX Series
device. There is no need to manually push your blocklist files.

RELATED DOCUMENTATION

Sky ATP Email Management Overview | 236

Sky ATP Malware Management Overview | 238

About the Feed Sources Page | 241

255



Configure IMAP Settings

Use the IMAP Settings page to configure email management for IMAP.With email management for IMAP,
the enrolled SRX Series devices can transparently submit suspicious emails to Sky ATP for inspection and
blocking.

Before You Begin

• Read the “Sky ATP Email Management Overview” on page 236 topic.

• Decide how malicious emails are handled. For IMAP, the available options are to block or permit email.
Unlike SMTP, there is no quarantine option for IMAP and there is no option to preview a blocked email.

To configure the IMAP settings:

1. Select Configure > Threat Prevention > Feed Sources.

The Feed Sources page appears

2. Under the Sky ATP tab, right-click a Sky ATP Realm or from the More list, select IMAP Settings.

3. Complete the configuration as per the guidelines given in Table 63 on page 257.

Based on your selections, configuration options will vary.
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Table 63: Configure Block Malicious Messages

GuidelineSetting

• Permit download of attachments—Allow email attachments, either from
all IMAP servers or specific IMAP servers, through to their destination.

NOTE: In Permit mode, block and allowlists are not checked. Emails
from blocklisted addresses are not sent to the cloud for scanning. They
are allowed through to the client.

• Block download of attachments—Block email attachments, either from
all IMAP servers or specific IMAP servers, from reaching their destination.

NOTE: In Block mode, block and allowlists are checked. Emails from
blocklisted addresses are blocked. Emails from allowlisted addresses are
allowed through to the client.

Recipients can send a request to an administrator to release the email.
Enter the email address towhich recipients should send a release request.

NOTE: If a blocked email hasmultiple recipients, any individual recipient
can request to release the email and all recipients will receive it.

When you select to block email attachments, in place of the original email,
intended recipients receive a custom email you configure with information
on the block action. Both the original email and the attachment are stored
in the cloud in an encrypted format.

Action to take

• All IMAP Servers—The permitting or blocking of email attachments
applies to all IMAP servers.

• Specific IMAP Server—The permitting or blocking of email attachments
applies only to IMAP servers with hostnames that you add to a list. A
configuration section to add the IMAP server name appears when you
select this option.

When you add IMAP servers to the list, it is sent to the SRX Series device
to filter emails sent to Sky ATP for scanning. For emails that are sent for
scanning, if the returned score is above the set policy threshold on the
SRX, then the email is blocked.

IMAP Server

Select the Specific IMAP Server option above and click the + sign to add
IMAP server hostnames to the list.

NOTE: You must use the IMAP server hostname and not the IP address.

IMAP Servers

Email Notifications for End Users
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Table 63: Configure Block Malicious Messages (continued)

GuidelineSetting

If you have a corporate web site with further information for users, enter
that URL here. If you leave this field blank, this option will not appear to
the end user.

Learn More Link URL

When an email is blocked, the recipient receives a custom message
informing them of their blocked email. For this custom message, enter a
subject indicating a suspicious email sent to them has been blocked, such
as "Malware Detected."

Subject

Enter information to help email recipients understand what they should
do next.

Custom Message

Enter custom text for the Sky ATP quarantine portal link where recipients
can preview blocked emails and take action on them.

Click Preview to view the custom message that will be sent to a recipient
when an email is blocked.

Custom Link Text

To send notifications to administrators when emails are blocked or released from quarantine:

1. Click the + sign to add an administrator.

2. Enter the email address of the administrator and click OK.

3. Once the administrator is created, you can uncheck or check which notification types the administrator
will receive.

• Block Notifications—If you enable this option, a notification is sent when an email is blocked.

• Unblock Notifications—If you enable this option, a notification is sent when a user releases a blocked
email.

RELATED DOCUMENTATION

About the Feed Sources Page | 241
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Creating File Inspection Profiles

Use the Sky ATP File Inspection Profiles page to create profiles to define which files to send to the cloud
for inspection.

Before you Begin

• Read the “File Inspection Profiles Overview” on page 238 topic.

• Read the “File Scanning Limits” on page 303 topic.

• Note that if you are using the free version of Sky ATP, only executable files are scanned.

To configure file inspection profiles:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the Sky ATP tab, select a Sky ATP realm, right-click or from the More list, select File Inspection
Profiles.

The Sky ATP File Inspection Profiles page appears showing the existing file inspection profiles.

3. Click the + sign to create new profiles.

The Create Profile page appears.

4. Enter a name for the profile. (You can create multiple profiles for file inspection.)

5. In the File Categories section, select the file categories and the following actions from the list for each
file category:

• Do not scan—The file category will not be scanned.

• Scan file up to max size—The maximum files size (up to 32MB) to scan. If a file falls outside of the
maximum file size limit, the file is automatically downloaded to the client system.

• Hash lookup only—Hash lookups are not recommended because, they are compared with the files
that are already evaluated before.

See Table 64 on page 260 for the list of file types for each category.

6. Click OK.
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Table 64: File Category Contents

DescriptionCategory

Archive filesArchive

Configuration filesConfiguration

All document types except PDFsDocument

Executable binariesExecutable

Java applications, archives, and librariesJava

Dynamic and static libraries and kernel modulesLibrary

Mobile formatsMobile

OS-specific update applicationsOS package

PDF, e-mail, and MBOX filesPDF

Scripting filesScript

Installable Internet Applications such as Adobe Flash, JavaFX, Microsoft
Silverlight

Rich Application

NOTE: Once the profile is created, use the set services advanced-anti-malware policy CLI
command to associate it with the Sky ATP profile. For more details, see set services
advanced-anti-malware policy.

RELATED DOCUMENTATION
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Add JATP Server

Configure the Juniper ATP appliance in Policy Enforcer to receive threat feeds for threat mitigation.

Before You Begin

Before you add the Juniper ATP Appliance:

• Obtain the IP address of the Juniper ATP appliance.

• Generate the API Authorization key for the Juniper ATP admin user. This is required to provide authorized
programmatic access to the Juniper ATP Appliance REST API. The configured Authorization Key for that
user is then applied each time an API request is made by that user.

• In the Juniper ATP Appliance web UI, navigate to Config>System Profiles>Users and click on an
existing user account. To know more about accessing the web UI, see Juniper ATP Appliance Web UI
Access.

• In the Update User page, select the Generate New API Key option.

For more information, see Updating a User Account and Setting an API Authorization Key.

• Configure multi-tenancy Web Collector Zones for Managed Security Service Provider (MSSP) support.

• In the Juniper ATP Appliance web UI, navigate to Config>System Profiles>Zones.

For more information, see Configuring MSSP Multi-Tenancy Zones.

To add a Juniper ATP server:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Source page appears.

2. In the JATP page, click the + sign.

The Add JATP Server page appears.

3. Complete the configuration according to the guidelines provided in Table 65 on page 262.

4. Click Finish.

The required Juniper ATP appliance is added to Policy Enforcer for threat monitoring.
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Table 65: Fields on the Add JATP Server Page

DescriptionField

JATP Server Settings

Enter the IP address of the Juniper ATP appliance.JATP Server IP Address

Enter the API Authorization key of the Juniper ATP appliance user. The same API key is
used for general Juniper ATP RESTful API access and also to integrate with SRX Series
devices.

The API key is used only once to obtain the application token from the JATP server. The
obtained application token is provided to Policy Enforcer and this token never expires.

To know more about generating the API key, see Updating a User Account and Setting
an API Authorization Key.

API Key

Enter the configured zone name.

You can enroll Policy Enforcer with the Juniper ATP default zone or with a specific Juniper
ATP zone. This enrollment is authenticated with an API authorization key.

Zone Name

Site

Select the site to be enrolled to the zone from the list.

If there are no sites associated with the realm, click Add new Site.

Site

Lists all devices from the zone that are not managed in Security Director. You must
manually discover them.

Unmanaged Devices

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

RELATED DOCUMENTATION
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Edit or Delete a JATP Server

You can modify the site information of an existing Juniper ATP zone or delete a Juniper ATP server, from
the Feed Sources page.

To edit or delete a Juniper ATP server:

1. Select Configure>Threat Prevention>Feed Sources>JATP.

The Feed Sources page appears.

2. Select the zone you want to edit or delete and then right-click.

• Select Edit to modify site information. TheModify JATP Server page appears. Make the changes and
click Finish.

You can also click the pencil icon to modify the configuration.

• Select Delete to remove the Juniper ATP server. An alert message appears verifying that you want
to delete your selection. Click Yes to delete your selection.

You can also click the delete icon to delete the Juniper ATP server.

RELATED DOCUMENTATION
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Creating Custom Feeds

Use the Create Custom Feed page to configure the Dynamic Address, Allowlist, Blocklist, Infected Hosts,
and DDoS custom feeds. These feeds provide relevant and timely intelligence that you can use to create
enforcement policies.

NOTE: If you have configured Sky ATP Configuration Type as “No Selection” in the
Administration>Policy Enforcer>Settings page, only the Dynamic Address custom feed is
supported.

Before You Begin

• Knowwhat type of feed you are configuring and have all the necessary information on hand. Local feeds
are created on your local system and uploaded from there.

• Note that infected hosts are hosts known to be compromised. For an infected host custom feed, enter
host IP addresses manually or upload a text file with the IP addresses of infected hosts.

• If you create an allowlist, blocklist, or infected hosts feed, it will override the respective Sky ATP/JATP
feed.

• Note that when Sky ATP/JATP only mode is selected as the Threat Prevention Type, the infected host
and DDoS custom feeds are not available.

To create local file and remote file custom feeds:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears. Youwill see only custom feeds available as the threat prevention type,
if you make no selection for Sky ATP/JATP Configuration Type in the Policy Enforcer Settings page.

2. Click Create and select one of the following:

• Feeds with local files—Enter your data manually into the provided fields or upload from a text file on
your location machine.

• Feeds with remote file server—Configure communication with the remote server to fetch the data
feed from it.
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3. Complete the configuration by using the guidelines in Table 46 on page 221 or Table 47 on page 222.

4. Click OK.

NOTE:
• Feeds are processed in the following order: SecIntel feeds -> Policy Enforcer -> SRX Series
devices. If you configure a local feed through Policy Enforcer, the configured local feed will
overwrite the cloud feeds.

• To use a custom feed, apply it to the source or destination address in a firewall rule. In the
firewall rule, you can filter addresses to show only the custom feeds.

If there is a firewall policy rule created using the dynamic address, you cannot delete the same
dynamic address from the Feed Sources page. You must first delete the firewall policy rule
and then , delete the dynamic address from the Feed Sources page.

• When you have no Sky ATP/JATP Configuration Type selected (No selection), Sky ATP/JATP
realms are disabled. Because site selection is usually done from the Sky ATP/JATP realm page,
you must select sites from the Create Custom Feed page when in “No selection” mode. The
custom feeds are then downloaded to the devices in the chosen sites. This is the only time
site selection available in the Create Custom Feed page.

Table 66: Fields on the Create Custom Feed Page, Feeds with Local Files

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should make this
description as useful as possible for all administrators.

Description

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Whitelist

• Blacklist

• Infected Hosts

• DDoS

• CC

Feed Type
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Table 66: Fields on the Create Custom Feed Page, Feeds with Local Files (continued)

DescriptionField

Select the required sites from the list to associate them with the dynamic address or allowlists and
blocklists feeds.

In the default mode (no Sky ATP), only sites are listed because of no Sky ATP. You can share a site
across the same feed type for dynamic address, allowlist, and blocklist. For Infected hosts and
DDoS, sites cannot be shared across the same feed type. However, you can share a site across
different feed types.

Sites

Select the required realms from the list, if you are in Cloud feeds only, Sky ATP/JATP, or Sky
ATP/JATP with Juniper Connected Security mode.

Associate these realms with dynamic address or allowlists and blocklists feeds. You can share a
realm across the same feed type for dynamic address, allowlist, and blocklist. For Infected hosts
and DDoS, realms cannot be shared across the same feed type. However, you can share a realm
across different feed types.

The Sky ATP/JATP realm without any assigned sites are not listed here. Only realms with sites
associated are listed here.

NOTE: If a site is associated with a tenant, the Sky ATP/JATP realm displays the list in the
<realm-name>(Tenant:<tenant-name>) format.

Zones/Realms

Select one of the following input types for Whitelist and Blacklist:

• IP, Subnet and Range—Enter an IPV4 address in standard four octet format. CIDR notation and
IP address ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30,
or 1.2.3.4-1.2.3.6.

• URL and Domain—Enter the URL using the following format: http://yourfeed.com/abc and
Domain using the following format: http://yourfeed.com.

Wildcards and protocols are not valid entries.

User Input Type

(Available for
Allowlist and
Blocklist)
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Table 66: Fields on the Create Custom Feed Page, Feeds with Local Files (continued)

DescriptionField

Do one of the following:

• Click Upload File to upload a text file with an IP address list. Click the Add button to include the
address list in your custom list.

For infected host andDDoS, the uploading file must have the string add at the beginning, followed
by the IP addresses. If you want to delete certain IP addresses, enter the string delete followed
by the IP addresses to delete.

Note that the file must contain only one item per line (no commas or semi colons). All items are
validated before being added to the custom list.

The file must not contain more than 500 entries. An error message is shown if you try to upload
a file containing more than 500 IP addresses. Use the Feeds with remote file server option to
upload a file containing more than 500 IP addresses.

• Manually enter your item and threshhold value in the space provided in the Custom List section.
To add more items, click + to add more spaces.

For syntax, enter an IPv4 address in standard four octet format. CIDR notation and IP address
ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or
1.2.3.4-1.2.3.6.

Custom List

Table 67: Fields on the Create Custom Feed Page, Feeds with Remote File Server

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
only dashes and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should
make this description as useful as possible for all administrators.

Description

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Blocklist

• Infected Hosts

• DDoS

• CC

Feed Type

Select one of the following:

• http

• https

Type of Server URL

Enter the URL for the remote file server.Server File URL
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Table 67: Fields on the Create Custom Feed Page, Feeds with Remote File Server (continued)

DescriptionField

Click Browse and select the CA certificate to upload.

If you do not upload a certificate for https server URL, a warning message is shown
that a certificate is not uploaded and to whether proceed further or not. Click Yes to
proceed further without uploading a certificate or No to go back and upload the
certificate.

Certificate Upload

(If the URL type is HTTPS)

Enter the credentials for the remote file server.

This is not a mandatory field. You can still proceed to create a custom feed without
entering the username.

Username

Enter the credentials for the remote file server.

This is a mandatory field, if you have provided the username.

Password

Select how often updates are retrieved from the remote files server: Hourly, Daily,
Weekly, Monthly, Never

Update Interval

Select the required sites from the list to associate them with the custom feeds.Sites

If you try to disenroll a site in an infected host, a warning message is shown to resolve all the current
infected hosts from the respective endpoints within a site. To resolve the infected hosts, log-in to Sky ATP
UI, resolve the hosts, and then unassign sites from Policy Enforcer. Ensure that you always resolve the
infected hosts before unassigning sites. Once you unassign sites, you cannot resolve the hosts.
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Example: Creating a Dynamic Address Custom Feed
and Firewall Policy

As stated earlier, dynamic addresses provide dynamic IP address information to security policies. A dynamic
address entry (DAE) is a group of IP addresses, not just a single IP prefix, that can be entered manually or
imported from external sources. The DAE feature allows feed-based IP objects to be used in security
policies to either deny or allow traffic based on either source or destination IP criteria. For example, a DAE
may contain IP addresses for specific domains or for entities that have a common attribute such as a
particular undesired location that poses a threat. When the DAE is updated, the changes automatically
become part of the security policy. There is no need tomanually update the policy; no configuration commit
action is required.

This topic steps you through a simple example of creating a DAE and associating it with a policy. For
complete information in creating firewall policies in Security Director, see Creating Firewall Policies.

1. Click Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the Custom Feeds tab, click Create > Feeds with local files.

3. Enter DAE_example1 as the name.

4. Select Dynamic Address from the Feed Type list.

5. Select the Sky ATP realms from the Realms field.

6. In the Custom List field, click the plus sign (+) to add individual entries to the custom list.

7. Add the following IP addresses. See the online help for information on supported formats.

• 192.0.2.0

• 192.0.2.1/10

• 198.51.100.0-198.51.100.5

8. Make sure all entries in the custom list are unchecked and click OK.

9. Click Configure > Firewall Policy > Policies.
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NOTE: This is example uses simplistic rules to show how to associate a DAEwith an allowlist
firewall policy. When creating your own firewall policy, you will have to configure the rules
that meet your company’s requirements.

10.Click the plus sign (+) to create a new firewall policy.

11. Enter dynamic_address_test as the name.

12. Select All Logging Enabled from the Profile pull-down menu.

13. Select Device Policy as the Type and select a device from the Device pull-down menu.

14.Click OK.

After a few seconds, the dynamic_address_test policy appears in the list.

15.Click Add Rule next to the dynamic_address_test policy to start the rule wizard.

16. Enter dynamic_rule as the name and click Next.

17. In the Source window, select untrust from the Zone pulldown menu and click Select under the
Address(es) field.

18. In the Source Address window, select the Include Specific radio button.

19. SelectDAE_example1 in the left table and click the right arrow to move it to the right table. Then click
Next.

The Source window reappears and DAE_example1 appears in the address(es) field.

20. In the Destionation window, select trust from the Zone pulldown menu and click Next.

21. In the Advanced Security window, select permit from the Rule Action pulldown menu and click Next.

22. In the Rule Options window, click Next to use the default settings.

23.Click Select in the Address(es) section and click the Include Specifics radio button.
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24. In the Rule Analysis window, select theAnalyze the new rule to suggest a placement to avoid anomalies
checkbox and click Next.

After a few seconds, an analysis of your rule appears, including where it should be placed, etc.

25.Click Finish and then OK to exit the wizard.

26. In the resulting page, click Save (located near the top of the window.)

27.Check the checkbox for the dynamic_rule policy and click Publish.

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device.

Configuring Settings for Custom Feeds

Use the Settings page to specify the number of days for the custom feed to be active and expire once the
duration is crossed. Also, specify how often the feeds must be updated.

In the Sky ATP with Juniper Connected Security, Clouds feed only, and No Sky ATP modes, you can
configure the Time To Live (TTL) settings for dynamic address, allowlist, blocklist, infected host, and DDoS
feed types. In the Sky ATP mode, you can configure TTL settings for only dynamic address, allowlist, and
blocklist feed types.

NOTE: When you configure a TTL setting for a particular feed type, the configuration is applicable
for all the custom feeds belonging to that particular feed type. For example, if you set TTL for
Allowlist feed type to 45 days, then all Allowlist feeds will have the same configuration.

To configure Settings:

1. Select Configure>Threat Prevention>Feed Source.

The Feed Sources page appears.

2. In the Custom Feeds tab, select Settings.

The Settings page appears.
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3. Complete the configuration by using the guidelines in Table 68 on page 272.

4. Click Update.

The settings are updated and a success message is shown that the Settings are updated successfully.

At the beginning of the Settings page, the last updated settings information is shown. This message is
refreshed whenever you update the setting.

Table 68: Fields on the Settings Page

DescriptionOption

Select one of the following options:

• Specify manually—Select this option to specify the number of days for the required custom
feed type to be active.

• Expires in (days)—Enter the number of days for the required custom feed to be active. Default
value is 30 days. The available range is 1 to 365 days.
The number of days that you configure in this field appears in the Days to Become Inactive
field on the Custom Feeds page. If you make any changes to this field, the same information
is refreshed in the Days to Become Inactive field and the timer is adjusted to the updated
value.

• Never Expire—Select this option if you do not want any custom feed type to be inactive or
expire.

Time to live

Specify how often each feed type must be updated.

By default, all feeds are updated every 5 minutes.

Valid range is 1 through 5 minutes.

Update Interval
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Implementing Threat Policy on VMWare NSX

IN THIS SECTION

VMWare NSX Integration with Policy Enforcer and Sky ATP Overview | 273

Before You Begin | 276

Configuring VMware NSX with Policy Enforcer | 279

Example: Creating a Firewall Rule in VMWare vCenter Server Using SDSN_BLOCK Tag | 281

VMWare NSX Integration with Policy Enforcer and Sky ATP Overview

Juniper Networks Sky Advanced Threat Prevention (Sky ATP) identifies the infected virtual machines(VMs)
running on VMWare NSX and tags these VMs as infected. This is based on a malware file exchange from
the infected VMs and/or based on the Command and Control communication with known botnet sites on
the internet.

Based on this identification of infected or compromised hosts, you can take one of the following actions:

• Enable additional security features such as Layer-7 Application Firewall and Intrusion Prevention (IPS)
leveraging vSRX

• Enforce Layer-2 to Layer-4 controls using NSX Distributed Firewall

• Leverage NSX integration with Host-Based security vendors
(https://www.vmware.com/products/nsx/technology-partners.html) to take host-based security actions
such as running antivirus or anti malware features on the infected VMs.

Policy Enforcer provides a set of Connector APIs for the third-party adaptors. TheNSXConnector integrates
with the Policy Enforcer using these APIs to enable enforcement of the infected hosts policy on Secure
Fabric. For NSX connectors, the NSX Manager , its associated vCenter, and an edge firewall form the
Secure Fabric.

The following topology shows how NSXManager and the edge firewall create a Secure Fabric to use with
Policy Enforcer.
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Figure 74: Topology of NSX Integration with Policy Enforcer
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Within the NSX Manager, the virtual machines (VM) connect to logical networks, shown as green and
yellow colour logical networks, as shown in Figure 74 on page 274. The logical switches connect to each
other using a Distributed Logical Router(DLR). To form the Secure Fabric, configure the edge service
gateway (ESG) to point to SRX Series devices or vSRX as the gateway for the networks hosted on NSX.
This is implemented by establishing IBGP session between ESG and vSRX or SRX Series device. This ensures
that all the north-south traffic passes through the vSRX edge firewall. The vSRX edge gateway is enrolled
with Sky ATP for the traffic inspection.

If NAT services are required, it must be configured on the vSRX and not on the ESG. Configure NAT
services using the following CLI commands.

set security nat source rule-set trust-to-untrust from zone trust

set security nat source rule-set trust-to-untrust to zone untrust

set security nat source rule-set trust-to-untrust rule snat-rule match source-address 0.0.0.0/0

set security nat source rule-set trust-to-untrust rule snat-rule then source-nat interface

To establish a BGP session, use the following configuration commands:

set routing-options autonomous-system 10

set protocols bgp group nsx neighbor 5.0.0.2 peer-as 10
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You can view the BGP configuration in VMWare vCenter Server, as shown in Figure 75 on page 275.

Figure 75: VMWare vCenter BGP Configuration

NOTE: You can register the NSXManager with Security Director only when the Policy Enforcer
is configured. The NSXmicro service is bundled with the Policy Enforcer VM. However, the NSX
micro service is packaged as a standalone rpm, so that theNSXmicro service upgrade and patches
can be performed independent of the Policy Enforcer VM.

Implementation of Infected Hosts Policy Overview

The vSRX or SRX Series devices running as an edge firewall is enrolled to send all the suspected traffic to
Sky ATP.

The following steps explain the high-level workflow:

• If an infection is detected, Sky ATP notifies the Policy Enforcer about the infected IP addresses

• If the infected IP address belongs to Secure Fabric associated with the NSX domain, Policy Enforcer
calls the NSX plugin APIs to notify the NSX Connector about the list of infected IP addresses

• NSX service will then retrieve the VM corresponding to the IP addresses sent and then calls the NSX
API to tag to an appropriate VM with a security tag, SDSN_BLOCK.

You can then create a policy to block the infected hosts using the SDSN_BLOCK tag by creating VMWare
Distributed Firewall (DFW) rules. The block policy consists of two rules for ingress block and egress block.
The ingress block rule applies to any traffic originating from a security group composed of VMs tagged

275



with a block tag to any destination. Similarly, the egress block rule applies to any traffic destined to security
group composed of VMs tagged with block tag from any source.

The creation of security groups associatedwith the SDSN_BLOCK tag, creation of ingress and egress block
rules, and the action to take on the matching packets must be configured by the VMWare administrators.
The NSX Connector will simply apply the SDSN_BLOCK tag on the infected VM.

Registering NSX Micro Service as Policy Enforcer Connector Instance Overview

The integration of each NSX manager discovered in Security Director with Policy Enforcer is triggered
automatically.

The automatic registration of a connector instance involves the following steps:

1. Discovering the NSXManager in Security Director. This triggers an auto creation of the Policy Enforcer
connector instance.

2. Secure Fabric is created to manage the discovered NSX Manager.

3. Creation of threat prevention policy requires the knowledge of Sky ATP realm and the edge firewall
device. These are taken as inputs from the user.

Before You Begin

IN THIS SECTION

Infected Hosts Workflow in VMware vCenter Server | 276

Before you begin to configure NSXwith Policy Enforcer, configure the infected hosts workflow in VMWare
vCenter Server.

Infected Hosts Workflow in VMware vCenter Server

To block the infected hosts:

1. Log in to the vSphere Web Client through the VMware vCenter Server.

2. From the vSphere Web Client, click Networking & Security and then click NSX Managers.
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Under the Manage section, click Security Tags column head and create SDSN_BLOCK security tag for
NSX, as shown in Figure 76 on page 277.

Figure 76: SDSN_BLOCK Security Tag

The feed for the infected hosts will be triggered by Sky ATP down to Policy Enforcer. When there is a
trigger, the SDSN_BLOCK tag is attached to the VM. Click on the VM Count column to see the VM
details attached to the tag.

3. Select Networking & Security and then click Service Composer.

The Service Composer page appears. From the Service Composer, click the Security Groups tab. The
security administrator can create the security group based on the security tag.

4. Click the New Security Group icon to create a new security group.

5. Enter a name and description for the security group and then click Next.

6. On the Define dynamic membership page, define the criteria that an object must meet for it to be
added to the security group you are creating.

In the Criteria Details row, select Security Tag from the list and provide the SDSN_BLOCK tag name,
as shown in Figure 77 on page 278.
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Figure 77: Define Dynamic Membership Page

Click Next.

7. In the Ready to Complete page, verify the parameters and click Finish.

In the Service Composer page, under the Security Groups tab, you can see that the security group has
been created and the VM with the security tag is assigned to the security group.
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Configuring VMware NSX with Policy Enforcer

The following steps explain configuring VMWare NSX with Policy Enforcer:

1. Add the NSXManager to the Security Director database, as shown in Figure 78 on page 279. To know
more about adding a NSX Manager, see Adding the NSX Manager.

Figure 78: Adding NSX Manager Page

2. After discovering the NSX Manager in Security Director, use the Guided Setup workflow to configure
the following parameters:

• Secure Fabric

• Policy Enforcement Group (PEG)

• Sky ATP Realm

• Threat policies for the following threat types:

• Command and Control (C&C) Server

• Infected Hosts

• Malware

3. Select Configuration > Guided Setup > Threat Prevention.
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The Threat Prevention Policy Setup page appears.

4. Click Stat Setup.

The Threat Prevention Policy Setup page appears, as shown in Figure 79 on page 280. Some of the
resources are already configured as you discover the NSX Manager.

Figure 79: Guided Setup Page

5. In the Secure Fabric page, the site is already created. For that site, one enforcement point is also added.

To create a secure fabric site in Policy Enforcer for NSX based environment, you require two parts :
NSX Manager and edge firewall. In the Add Enforcement Points page, add vSRX, as shown in the
topology, as a edge firewall. Select the vSRX device listed under the Available column and move it to
the Selected column. You now have two enforcement points within the Secure Fabric.

Click Next.

6. In the Policy Enforcement Groups page, the policy enforcement group is already created based on the
Location Group Type. The location points to the Secure Fabric site created for NSX.

Click. Next.

7. In the Sky ATP Realm page, associate the Secure Fabric with a Sky ATP realm.

If the Sky ATP realm is already created, click Assign Sites in the Sites Assigned column and chose the
Secure Fabric site. The Sky ATP realm and Secure Fabric are now associated.

Click. Next.

8. In the Policies page, create a threat prevention policy by choosing the profile types depending on the
type of threat prevention this policy provides (C&C Server, Infected Host, Malware) and an action for

280



the profile. The DDoS profile is not supported by the NSX Connector. Once configured, you apply
policies to PEGs.

ClickAssign groups in the Policy Enforcement Group column to associate the policy enforcement group
with the policy.

SecurityDirector takes the snapshot of the firewall by performing the rule analysis and threat remediation
rules are pushed into the edge firewall.

Click Finish.

NOTE: The GeoIP feeds are not used with the NSX Connectors.

9. The last page is a summary of the items you have configured using quick setup. Click OK to be taken
to the Policies page under Configure > Threat Prevention > Policies and your policy is listed there.

Example: Creating a Firewall Rule in VMWare vCenter Server Using
SDSN_BLOCK Tag

The following example shows the firewall rule creation using the SDSN_BLOCK security tag:

1. Log in to the vSphere Web Client through the VMware vCenter Server.

2. Select Networking & Security and then click Service Composer.

The Service Composer page appears.

3. Select Security Policies tab in the Service Composer page.

Create a security policy to block the traffic coming from the infected hosts.

4. Select the Create Security Policy icon.

The New Security Policy page appears.

5. Enter a name and description for the security policy, and click Next.

6. Select the Firewall Rules option from the left pane.

The Firewall Rules page appears.

7. Select the New Firewall Rule icon (+) to create a new firewall rule.
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The New Firewall Rule page appears.

8. Enter the name of the firewall rule.

9. In the Action field, select the Block option.

10. In the Source field, click Change and select the security group.

11. In the Destination field, click Change and select the security group to add as Any.

Click Ok. Figure 80 on page 283 shows a sample firewall rule configuration.
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Figure 80: New Firewall Rule Page

12.Click Finish.

A new policy is created. You can apply this policy to the security group.

13. In the Security Policies page, right-click on the policy name and select Apply Policy.

The Apply Policy to Security Groups page appears, as shown in Figure 81 on page 284.
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Figure 81: Apply Policy to SG Page

14. Select the security group that you have created and assign to a policy.

Security administrator is now able to block the traffic coming from the infected hosts.
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Policy Enforcer Dashboard Widgets

Policy enforcer adds widgets to the dashboard that provide a summary of all gathered information on
compromised content and hosts. Drag and drop widgets to add them to your dashboard. Mouse over a
widget to refresh, remove, or edit the contents.

To view the Policy Enforcer dashboard widgets, select Security Director>Dashboard. You can view all
widgets mentioned in Table 69 on page 287.

In addition, you can use the dashboard to:

• Navigate to the File Scanning page from the Top Scanned Files and Top Infected Files widgets by clicking
the More Details link.

• Navigate to the Hosts page from the Top Compromised Hosts widget by clicking theMore Details link.

• Navigate to the Command and Control Servers page from the C&C Server Malware Source Location
widget.

NOTE: C&C andGeoIP filtering feeds are only available with the Cloud Feed or Premium license.

Available dashboard widgets are as follows:

Table 69: Policy Enforcer Dashboard Widgets

DefinitionWidget

A list of the top malware found based on the number of times the malware is
detected over a period of time. Use the arrow to filter by different time frames.

Top Malware Identified

A list of the top compromised hosts based on their associated threat level and
blocked status.

Top Compromised Hosts

A graph of the top infected file types by file extension. Examples: exe, pdf, ini,
zip. Use the arrows to filter by threat level and time frame.

Top Infected File Types

A graph of the top infected file categories. Examples: executables, archived files,
libraries. Use the arrows to filter by threat level and time frame.

Top Infected File Categories

A graph of the top file types scanned for malware. Examples: exe, pdf, ini, zip.
Use the arrows to filter by different time frames.

Top Scanned File Types

A graph of the top file categories scanned for malware. Examples: executables,
archived files, libraries. Use the arrows to filter by different time frames.

Top Scanned File Categories
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Table 69: Policy Enforcer Dashboard Widgets (continued)

DefinitionWidget

A color-coded map displaying the location of Command and Control servers or
othermalware sources. Click a location on themap to view the number of detected
sources.

C&C Server and Malware Source

RELATED DOCUMENTATION

Infected Hosts Overview | 288

Command and Control Servers Overview | 290

HTTP File Download Overview | 293

SMTP Quarantine Overview | 297

Infected Hosts Overview

The hosts page lists compromised hosts and their associated threat levels. From here, you can monitor
and mitigate malware detections on a per host basis.

NOTE: You must select a Sky ATP realm from the available pulldown.

Compromised hosts are systems forwhich there is a high confidence that attackers have gained unauthorized
access. When a host is compromised, the attacker can do several things to the computer, such as:

• Send junk or spam e-mail to attack other systems or distribute illegal software.

• Collect personal information, such as passwords and account numbers.

Compromised hosts are listed as secure intelligence data feeds (also called information sources.) The data
feed lists the IP address or IP subnet of the host along with a threat level; for example, 130.131.132.133
and threat level 5. Once threats are identified, you can create threat prevention policies to take enforcement
actions on the inbound and outbound traffic on these infected hosts.

Export Data—Click the Export button to download compromised host data to a CSV file. You are prompted
to narrow the data download to a selected time-frame.
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Infected Host Details

Use the host details page to view in-depth information about current threats to a specific host by time
frame. From here you can change the investigation status and the blocked status of the host.

Table 70 on page 289 shows the information provided on the host details page:

Table 70: Threat Level Definitions

DefinitionThreat Level

Clean; no action is required.0

Low threat level. Recommendation: Disable this host.1–3

Medium threat level. Recommendation: Disable this host.4–6

High threat level. Host has been automatically blocked.7–10

• Host Status—Displays the current state by threat level, which could be any of the levels described in the
table above.

• Investigation Status—The following states of investigation are available: Open, In progress, Resolved -
false positive, Resolved - fixed, and Resolved - ignored.

• Policy override for this host—The following options are available: Use configured policy (not included
in infected hosts feed), Always include host in infected hosts feed, Never include host in infected hosts
feed.

289



NOTE: The blocked status changes in relation to the investigation state. For example, when
a host changes from an open status (Open or In Progress) to one of the resolved statuses, the
blocked status is changed to allowed and the threat level is brought down to 0. Also, when
the investigation status is changed to resolved, an event is added to the log at the bottom of
the page.

• Host threat level graph—This is a color-coded graphical representation of threats to this host displayed
by time frame. You can change the time frame, and you can slide the graph backward or forward to
zoom in or out on certain times. When you zoom in, you can view individual days within a month.

• Expand time-frame to separate events—Use this check box to stretch a period of time and see the events
spread out individually.

• Past threats—The date and status of past threats to this host are listed here. The time frame set previously
also applies to this list. The description for each event provides details about the threat and the action
taken at the time.

RELATED DOCUMENTATION
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Command and Control Servers Overview

The Command and Control (C&C) servers page lists information on servers that have attempted to contact
and compromise hosts on your network. A C&C server is a centralized computer that issues commands
to botnets (compromised networks of computers) and receives reports back from them. Botnets can be
used to gather sensitive information, such as account numbers or credit card information, or to participate
in a distributed denial-of-service (DDoS) attack.
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NOTE:
• C&C and Geo IP filtering feeds are only available with a Sky ATP premium license.

• When managing Sky ATP with Security Director, you must select a Sky ATP realm from the
available pulldown.

When a host on your network tries to initiate contact with a possible C&C server on the Internet, the SRX
Series device can intercept the traffic and perform an enforcement action based on real-time intelligence
feed information that identifies the C&C server IP address and URL.

• Export Data—Click the Export button to download C&C data to a CSV file. You are prompted to narrow
the data download to a selected time-frame.

Table 71 on page 291 provides the following information available on the C&C page.

Table 71: Command & Control Server Data Fields

DefinitionField

The IP address of the suspected command and control server.External Server IP

The hostname of the suspected command and control server.External Server Hostname

Specifies the information on how the servers are blocked.Blocked Via

The threat level of the C&C server as determined by an analysis of actions and
behaviors.

Highest Threat Level

The number of times the C&C server has attempted to contact hosts on your
network.

Count

The country where the C&C server is located.Country

The date and time of the most recent C&C server hit.Last Seen

The action taken on the communication (permitted or blocked).Action

Specifies the category of the C&C server.Category
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File Scanning Limits | 303

Command and Control Server Details

Use Command and Control Server Details page to view analysis information and a threat summary for the
C&C server. The following information is displayed for each server.

• Total Hits

• Threat Summary (Threat level, Location, Category, Time last seen)

• Ports and protocols used

You can filter this information by clicking on the time-frame links: 1 day, 1 week, 1 month, Custom (select
your own time-frame). You can also expand the time-frame to separate events using the slider.

Hosts That have Contacted This C&C Server

This is a list of hosts that have contacted the server. Table 72 on page 292 shows the information provided
in this section:

Table 72: Command & Control Server Contacted Host Data

DefinitionField

The name of the host in contact with the command and control server.Client Host

The IP address of the host in contact with the command and control server.
(Click through to the Host Details page for this host IP.)

Client IP Address

The threat level of the C&C server as determined by an analysis of actions
and behaviors.

C&C Threat Level

The action taken on the communication (permitted or blocked).Action

The protocol (TCP or UDP) the C&C server used to attempt communication.Protocol

The port the C&C server used to attempt communication.Port
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Table 72: Command & Control Server Contacted Host Data (continued)

DefinitionField

The name of the device in contact with the command and control server.Device Name

The date and time of the most recent C&C server hit.Date Seen

The name of the host user in contact with the command and control server.Username

Associated Domains

This is a list of domains the destination IP addresses in the C&C server events resolved to.

Signatures

This is a list of command and control indicators that were detected.

RELATED DOCUMENTATION
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HTTP File Download Overview

A record is maintained of all file metadata sent to the cloud for inspection. These are files downloaded by
hosts and found to be suspicious based on known signatures or URLs. From the main page, click the file’s
signature to view more information, such as file details, what other malware scanners say about this file,
and a complete list of hosts that downloaded this file.

293



NOTE: When managing Sky ATP with Security Director, you must select a Sky ATP realm from
the available pulldown.

Export Data—Click the Export button to download file scanning data to a CSV file. You are prompted to
narrow the data download to a selected time-frame.

Table 73 on page 294 shows the following information available on this page:

Table 73: HTTP Scanning Data Fields

DefinitionField

A unique identifier located at the beginning of a file that provides information on the contents
of the file. The file signature can also contain information that ensures the original data
stored in the file remains intact and has not been modified.

File Signature

The threat score.

NOTE: Click the three vertical dots at the top of the column to filter the information on the
page by threat level.

Threat Level

The name of the file, including the extension.

NOTE: Enter text in the space at the top of the column to filter the data.

Filename

The time and date of the most recent scan of this file.Last Submitted

The URL from which the file originated.

NOTE: Enter text in the space at the top of the column to filter the data.

URL

The name of file and the type of threat if the verdict is positive for malware. Examples:
Trojan, Application, Adware. If the file is not malware, the verdict is "clean."

NOTE: Enter text in the space at the top of the column to filter the data.

Malware

The type of file. Examples: PDF, executable, document.

NOTE: Enter text in the space at the top of the column to filter the data.

Category
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HTTP File Download Details

Use the File Scanning Details page to view analysis information and malware behavior summaries for the
downloaded file. In the HTTP File Donwload page, click on the File Signature to go to the File Scanning
Details page. This page is divided into several sections:

Report False Positives—Click the Report False Positive button to launch a new screen which lets you send
a report to Juniper Networks, informing Juniper of a false position or a false negative. Juniper will investigate
the report, however, this does not change the verdict. If you want to make a correction (mark system as
clean) you must do it manually.

Printable View—Click this link to organize the information into a print-ready format.

The top of the page provides a quick view of the following information (scroll to the right in the UI to see
more boxes):

• Threat Level—This is the threat level assigned (0-10), This box also provides the threat category and the
action taken.

• Top Indicators—In this box, you will find the malware name, the signature it matches, and the IP
address/URL from which the file originated.

• Prevalence—This box provides information on howoften thismalware has been seen, howmany individual
hosts on the network downloaded the file, and the protocol used.

File Summary

Table 74: General Summary Fields

DefinitionField

This is the assigned threat level 0-10. 10 is the most malicious.Threat Level

How often this file has been seen across different customers.Global Prevalence

The time and date of the last scan to detect the suspicious file.Last Scanned
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Table 74: General Summary Fields (continued)

DefinitionField

The name of the suspicious file. Examples: unzipper-setup.exe,
20160223158005.exe,, wordmui.msi.

File Name

The type of file. Examples: PDF, executable, document.Category

The size of the downloaded file.File Size

The target operating system of the file. Example. Win32Platform

If possible, Sky ATP determines the name of the malware.Malware Name

If possible, Sky ATP determines the type of threat. Example: Trojan, Application,
Adware.

Malware Type

If possible, Sky ATP determines the strain of malware detected. Example:
Outbrowse.1198, Visicom.E, Flystudio.

Malware Strain

One way to determine whether a file is malware is to calculate a checksum for the
file and then query to see if the file has previously been identified as malware.

sha256 and md5

In the Network Activity section, you can view information in the following tabs:

• Contacted Domains—If available, lists any domains that were contacted while executing the file in the
Sky ATP sandbox.

• Contacted IPs—If available, lists all IPs that were contacted while executing the file, along with the
destination IP’s country, ASN, and reputation. The reputation field is based on Juniper IP intelligence
data destination.

• DNS Activity— This tab lists DNS activity while executing the file, including reverse lookup to find the
domain name of externally contacted servers. This tab also provides the known reputation of the
destination servers.

HTTP Downloads

This is a list of hosts that have downloaded the suspicious file. Click the IP address to be taken to the Host
Details page for this host. Click the Device Serial number to be taken to the Devices page. From there
you can view device versions and version numbers for the Sky ATP configuration, including profile, allowlist,
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and blocklist versions. You can also view themalware detection connection type for the device: telemetry,
submission, or C&C event.

RELATED DOCUMENTATION

HTTP File Download Details | 295

SMTP Quarantine Overview | 297

Email Attachments Scanning Overview | 299

File Scanning Limits | 303

SMTP Quarantine Overview

Access this page from theMonitor menu.

The SMTP quarantine monitor page lists quarantined emails with their threat score and other details
including sender and recipient. You can also take action on quarantined emails here, including releasing
them and adding them to the blocklist.

The following information is available from the Summary View:

Table 75: Blocked Email Summary View

DescriptionField

Use the slider to narrow or increase the time-frame within the selected the
time parameter in the top right: 12 hrs, 24 hrs, 7 days or custom.

Time Range

This lists the total number of emails scanned during the chosen time-frame
and then categorizes them into blocked, quarantined, released, and permitted
emails.

Total Email Scanned

This is a graphical representation of emails, organized by time, with lines for
blocked emails, quarantined and not released emails, and quarantined and
released emails.

Malicious Email Count

This is a graphical representation of emails, organized by time, with lines for
total emails, and emails with one or more attachments.

Emails Scanned

This is another graphical view of classified emails, organized by percentage
of blocked emails, quarantined and not released emails, and quarantined and
released emails.

Email Classification
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The following information is available from the Detail View:

Table 76: Blocked Email Detail View

DescriptionField

The email address of the recipient.Recipient

The email address of the sender.Sender

Click the Read This link to go to the Sky ATP quarantine portal and preview
the email.

Subject

The date the email was received.Date

Click on the attachment name to go to the Sky ATP file scanning page where
you can view details about the attachment.

Malicious Attachment

The size of the attachment in kilobytes.Size

The threat score of the attachment, 0-10, with 10 being the most malicious.Threat Score

The type of threat found in the attachment, for example, worm or trojan.Threat Name

The action taken, including the date and the person (recipient or administrator)
who took the action.

Action

Using the available buttons on the Details page, you can take the following actions on blocked emails:

• Add domain to blocklist

• Add sender to blocklist

• Release
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Email Attachments Scanning Overview

A record is kept of all file metadata sent to the cloud for inspection. These are files downloaded by hosts
and found to be suspicious based on known signatures From the main page, click the file’s signature to
viewmore information, such as file details, what other malware scanners say about this file, and a complete
list of hosts that downloaded this file.

NOTE: You must select a Sky ATP realm from the available pulldown.

Export Data—Click the Export button to download file scanning data to a CSV file. You are prompted to
narrow the data download to a selected time-frame.

Table 77 on page 299 shows the information available on this page.

Table 77: Email Attachments Scanning Data Fields

DefinitionField

A unique identifier located at the beginning of a file that provides information on
the contents of the file. The file signature can also contain information that ensures
the original data stored in the file remains intact and has not been modified.

File Signature

The threat score.Threat Level

The date and time the file was scanned.Date Scanned

The name of the file, including the extension.Filename

The email address of the intended recipient.Recipient

The email address of the sender.Sender

The type of malware found.Malware Name

Indicates whether the file was blocked or permitted.Status

The type of file. Examples: PDF, executable, document.Category

RELATED DOCUMENTATION
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Email Attachments Scanning Details

Use the File Scanning Details page to view analysis information and malware behavior summaries for the
downloaded file. In the Email Attachments page, click on the File Signature to go to the File Scanning
Details page. This page is divided into several sections:

Report False Positives—Click the Report False Positive button to launch a new screen which lets you send
a report to Juniper Networks, informing Juniper of a false position or a false negative. Juniper will investigate
the report, however, this does not change the verdict. If you want to make a correction (mark system as
clean) you must do it manually.

Printable View—Click this link to organize the information into a print-ready format.

The top of the page provides a quick view of the following information (scroll to the right in the UI to see
more boxes):

• Threat Level—This is the threat level assigned (0-10), This box also provides the threat category and the
action taken.

• Top Indicators—In this box, you will find the malware name, the signature it matches, and the IP
address/URL from which the file originated.

• Prevalence—This box provides information on howoften thismalware has been seen, howmany individual
hosts on the network downloaded the file, and the protocol used.

File Summary

Table 78: General Summary Fields

DefinitionField

This is the assigned threat level 0-10. 10 is the most malicious.Threat Level

The action taken based on the threat level and host settings: block or permit.Action Taken

How often this file has been seen across different customers.Global Prevalence
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Table 78: General Summary Fields (continued)

DefinitionField

The time and date of the last scan to detect the suspicious file.Last Scanned

The name of the suspicious file. Examples: unzipper-setup.exe,
20160223158005.exe,, wordmui.msi.

File Name

The type of file. Examples: PDF, executable, document.Category

The size of the downloaded file.File Size

The target operating system of the file. Example. Win32Platform

If possible, Sky ATP determines the name of the malware.Malware Name

If possible, Sky ATP determines the type of threat. Example: Trojan, Application,
Adware.

Malware Type

If possible, Sky ATP determines the strain of malware detected. Example:
Outbrowse.1198, Visicom.E, Flystudio.

Malware Strain

One way to determine whether a file is malware is to calculate a checksum for the
file and then query to see if the file has previously been identified as malware.

sha256 and md5

In the Network Activity section, you can view information in the following tabs:

NOTE: This section will appear blank if there has been no network activity.

• Contacted Domains—If available, lists any domains that were contacted while executing the file in the
Sky ATP sandbox.

• Contacted IPs—If available, lists all IPs that were contacted while executing the file, along with the
destination IP’s country, ASN, and reputation. The reputation field is based on Juniper IP intelligence
data destination.

• DNS Activity—This tab lists DNS activity while executing the file, including reverse lookup to find the
domain name of externally contacted servers. This tab also provides the known reputation of the
destination servers.

In the Behavior Details section, you can view the behavior of the file on the system. This includes any
processes that were started, files that were dropped, and network activity seen during the execution of
the file. Dropped files are any additional files that were downloaded and installed by the original file.
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Email Attachments Scanning Overview | 299

Infected Hosts Overview | 288

HTTP File Download Overview | 293

SMTP Quarantine Overview | 297

File Scanning Limits | 303

IMAP Block Overview

The IMAP Blockmonitor page lists blocked emails with their threat score and other details including sender
and recipient. You can also take action on blocked emails here, including releasing them and adding them
to the blocklist.

Table 79 on page 302 shows information available from the Summary View tab.

Table 79: Blocked Email Summary View

DescriptionField

Select the registered Sky ATP realm from the list.Sky ATP Realm

Use the slider to narrow or increase the time-frame within the selected the
time parameter in the top right: 12 hrs, 24 hrs, 7 days or custom.

Time Range

This lists the total number of malicious emails scanned during the chosen
time-frame and then categorizes them into blocked, blocked and not allowed,
quarantined and allowed.

Malicious Email Count

This is a graphical representation of all scanned emails, organized by date.Emails Scanned

Table 80 on page 302 shows information available from the Detail View tab.

Table 80: Blocked Email Detail View

DescriptionField

Specifies the email address of the recipient.Recipient

Specifies the email address of the sender.Sender

ClickRead This to go to the Sky ATP quarantine portal and preview the email.Subject
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Table 80: Blocked Email Detail View (continued)

DescriptionField

Specifies the date the email was received.Date

Click on the attachment name to go to the Sky ATP file scanning page where
you can view details about the attachment.

Malicious Attachment

Specifies the size of the attachment in kilobytes.Size

Specifies the threat score of the attachment, in a scale of 0-10, with 10 being
the most malicious.

Threat Score

Specifies the type of threat found in the attachment, for example, worm or
trojan.

Threat Name

Specifies the action taken, including the date and the person (recipient or
administrator) who took the action.

Action

Using the available buttons on the Details page, you can take the following actions on blocked emails:

• Unblock Attachment for Selected User(s)

• Unblock Attachment for All Users

RELATED DOCUMENTATION

File Scanning Limits

There is a limit to the number of files which can be submitted to the cloud for inspection. This limit is
dictated by the device and license type. When the limit is reached, the file submission process is paused.

NOTE: This limit applies to all files, HTTP and SMTP.
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Limit thresholds operate on a sliding scale and are calculated within 24-hour time-frame starting "now."

Premium License (files per day)Free License (files per day)Perimeter Device

1,000200SRX340

2,000300SRX345

5,000500SRX550m

10,0002,500SRX1500

50,0005,000SRX5400

70,0005,000SRX5600

100,0005,000SRX5800

20025vSRX(10mbps)

1,000200vSRX(100mbps)

10,0002,500vSRX(1000mbps)

10,0002,500vSRX(2000mbps)

20,0003,000vSRX(4000mbps)

RELATED DOCUMENTATION

Infected Hosts Overview | 288

HTTP File Download Overview | 293

Email Attachments Scanning Overview | 299

All Hosts Status Details

Use the All Hosts Status page to view the enforcement status of infected hosts feeds. The supported host
feeds are custom and Sky ATP.
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By default, details for both custom and Sky ATP hosts are shown. You must select the required feed type
from the Feed Source column.

NOTE: To view the All Hosts Status page, you must have the Threat Management privileges or
predefined roles enabled.

To see the details of all hosts status:

1. SelectMonitor > Threat Prevention > All Hosts Status.

The All Hosts Status page appears.

2. Table 81 on page 305 shows the information provided on the All Hosts Status page.

Table 81: Fields on All Hosts Status Page

DescriptionColumn Name

Specifies the IP address of the feed.IP Address

Specifies the MAC address of the feed.MAC Address

Specifies the name of the feed.Feed Name

Specifies type of the feed source.Feed Source

Specifies the action of the infected host. For example: Block or Quarantine.Action

Specifies the enforcement status of the infected host.Enforcement Status

Specifies the name of the Juniper Networks switch used to monitor the feed.Switch Name

Specifies the interface on the switch where the user is connected to a network.Interface Name

Specifies the name of the associated threat prevention policy.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Policy Associated

Specifies the Policy Enforcement Group (PEG) associated with the policy.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

PEG Associated
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Table 81: Fields on All Hosts Status Page (continued)

DescriptionColumn Name

Specifies the subnet that is added as an endpoint for the PEG.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Matched Subnet

Specifies the type of connector used as an enforcement point.Connector Type

Specifies the name of the connector.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Connector Name

Specifies the type of endpoints added to a PEG.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Endpoint Address Space Type

Specifies the name of an endpoint.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Endpoint Address Space Name

You can click the filter icon to filter the data based on the following fields:

• Feed source type

• Action

• Enforcement status

• Connector type

RELATED DOCUMENTATION

Custom Feed Sources Overview | 240
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Device Feed Status Details

Use the Device Feed Status page to view the download status of feeds from various feed sources. You
can view the status of feeds for each device.

NOTE: To view the Device Feed Status page, you must have the Threat Management privileges
or predefined roles enabled.

To view the details of the device feed status:

1. SelectMonitor > Threat Prevention > Device Feed Status.

The Device Feed Status page appears.

2. Table 82 on page 307 shows the information provided on the Device Feed Status page.

Table 82: Fields on the Device Feed Status Page

DescriptionColumn Name

Specifies the name of the device.Device Name

Specifies the IP address of the device.IP

Specifies the model of the device mentioned in the Device Name column. For
example, vSRX.

Model

Specifies the name of the feed downloaded to the device.

This also shows the number of feeds downloaded. Click on the number to view
the names of the individual feeds.

Feed Name

Specifies the category of the feed. For example, CC.Feed Category

Specifies the last downloaded date and time of each feed.Last Downloaded

You can click the filter icon to filter the data based on the following fields:

• Device name

• IP address of the device

• Model of the device
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• Name of the feed

• Following feed categories:

• C&C

• Allowlist

• Blocklist

• Infected hosts

• Dynamic address

• DDoS

• GeoIP

RELATED DOCUMENTATION

About the Feed Sources Page | 241

DDoS Feeds Status Details

Use the DDoS Feeds Status page to view the enforcement status of Distributed Denial of Service (DDoS)
feeds.

In Sky ATP Only mode, you do not see the DDoS Feeds Status page under Monitor. An error message is
shown that the page is unavailable because the current threat prevention type is set to Sky ATP onlymode.

NOTE: To view the DDoS Feeds Status page, you must have the Threat Management privileges
or predefined roles enabled.

To view details of DDoS feeds status:

1. SelectMonitor > Threat Prevention > DDoS Feeds Status.

The DDoS Feeds Status page appears.

2. Table 83 on page 309 shows information provided on the DDoS Feeds Status page.
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Table 83: Fields on the DDoS Feeds Status Page

DescriptionColumn Name

Specifies the DDoS feed name to monitor the feeds.Feed Name

Specifies the associated site name with the DDoS feedsSite

Specifies the name of the MX router where DDoS is enabled.MX Name

Specifies the IP address of the MX router.MX IP

Specifies the status of the MX router.MX Status

Specifies the action taken for the DDoS profile

To filter the data based on a specific action, click the filter icon and select the required
DDoS profile action from the list.

Action

Specifies the enforcement status of the feed. Hover over the status to view the reason
for that particular status.

To filter the data based on a specific enforcement status, click the filter icon and select
the required enforcement status from list to monitor the feed.

Enforcement Status

Specifies the name of the associated threat prevention policy.Policy

Specifies the Policy Enforcement Group (PEG) associated with the policy.PEG

RELATED DOCUMENTATION

Custom Feed Sources Overview | 240
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Policy Enforcer Log File Locations

The following Policy Enforcer configuration settings files are located under /srv/feeder/etc/log:

NOTE: Do not edit these files unless instructed by the Juniper Networks Technical Assistance
Center (JTAC).

• controller_log.yml—Defines the format for the controller.log file. For example, message and date format
and maximum file size.

• feed_collector_log.yml—Defines the format for the feed_collector.log file. For example, message and
date format and maximum file size.

• feed_provider_log.yml— Defines the format for the feed_provider.log file. For example, message and
date format and maximum file size.

The following Policy Enforcer log files are located under /srv/feeder/log. By default, a maximum of 10
files are created for each log file. For example, controller.log, controller.log.1, controller.log.2, etc. After
10 files are created, the oldest file (in this example, controller.log) is overwritten next.

• controller.log—Contains log messages for the interaction of Security Director with Policy Enforcer.

• feed_collector.log—Contains log messages for the downloading of feeds.

• feed_provider.log—Contains log messages for distributing feeds to the SRX Series devices.

The following Policy Enforcer log files are located under /var/log:

• prepare_vm.log—Contains information about your Policy Enforcer software installation.

• pe_upgrade.log—Contains information about your Policy Software software upgrade.

Troubleshooting Common Policy Enforcer Problems

IN THIS SECTION

Troubleshooting Policy Enforcer Installation | 312

Troubleshooting Sky ATP Realms and Enrolling Devices | 313
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Troubleshooting Threat Policies and Policy Enforcement Groups | 313

HTTPS-Based Malware Not Detected | 314

This topic lists some common problem areas you may encounter and how to remedy them.

Troubleshooting Policy Enforcer Installation

Most common Policy Enforcer installation problems occur around creating and deploying the OVA file. If
you are not familiar with virtual machines or OVA files, please see VMware Documentation and select the
appropriate VMware vSphere version.

Other areas to look for include:

• Configuring the virtual machine with the correct network configuration. These values vary according to
your installation. When configuring the virtual machine network, you will need to know the following:

• Virtual machine hostname, IP address and network mask.

• Default gateway that connects your internal network to external networks.

• Primary and secondary DNS servers.

• (optional) NTP servers.

• Virtual machine IP address and ssh root credentials. When configuring the virtual machine, you must
identify and record the IP address and the ssh root password. In order for Security Director to
communicate with your Policy Enforcer virtual machine, youmust enter these values into the PE Settings
page (Administration > PE Settings) of Security Director.

If you forget the virtual machine IP address, log into the virtual machine again. The setup script
automatically runs each time you log in so that you can review your settings.

If you forget the root password, there is no way to retrieve it. You must instead reset your password.
Be sure to enter your newpassword into the PE settings page in SecurityDirector. To reset your password,
see CentOS root password reset instructions.
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Troubleshooting Sky ATP Realms and Enrolling Devices

Sky ATP has two service levels: free and premium. The free model solution performs basic malware
detection while the premium model solution offers more protection. For more information on Sky ATP
license types and the features for each type, see Sky Advanced Threat Prevention Licenses.

Some common problems areas with Sky ATP are:

• Trying to enroll devices that are not supported by Sky ATP. See the Sky ATP Supported Platforms Guide
for more information on supported devices.

• The Sky ATP file limit has been reached. Sky ATP has a maximum number of files per day that you can
submit to the cloud for inspection.When an SRX Series device has reached its maximum number of files,
it goes into a paused state and cannot submit files for inspection. The device automatically changes to
the allowed state when it once again is below the maximum limit. See Sky ATP File LImits for more
information on the maximum number of files per day per device type.

• The vSRX instance fails to enroll. Check tomake sure the proper Sky ATP license is installed. SeeManaging
the Sky ATP License for more information on license management with vSRX deployments.

Troubleshooting Threat Policies and Policy Enforcement Groups

This section lists some common issues found with threat policies and policy enforcement groups.

• You create a threat policy but don’t see the appropriate profiles to choose.

Select Administration > PE Settings and make sure the correct mode has been selected. You can only
change the mode in the follow order: Cloud Feed Only to SKY ATP to SKY ATP with PE.

• Assigning a threat policy to a policy enforcement group in the Sky ATP with PE mode.

Threat policies are enforced and pushed to devices that support the given profile. If a device is not
supported by a profile, it will be listed in the analysis results and in the Junos Space job details.

• You create a policy enforcement group with an IP address subnet but no IP addresses are listed in the
GUI.

Make sure that a switch is assigned to the site and that the L3 interfaces are configured on the aggregate
switch.
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HTTPS-Based Malware Not Detected

If your HTTPS-based malware is not detected by Sky ATP, the root certificate on your SRX Series device
(for HTTPS forward proxy) may be invalid. This may occur when the CA profile name is not correct. It must
be named policyEnforcer.

For example:

root@host# set security pki policyEnforcer ssl-inspect-ca ca-identity

ssl-inspect-ca

root@host# set security pki policyEnforcer ssl-ca ca-identity ssl-ca

Formore information on loading root certificates with Policy Enforcer, see “Loading a Root CA” on page 64.

Troubleshooting ClearPass Issues

IN THIS SECTION

Viewing Logs Files | 315

Configuration Issues | 317

Error Code 500 | 318

Unable to Block Infected Endpoint | 318

Unable to Quarantine Infected Endpoint | 319

Unable to Clear Blocked or Quarantined Endpoint | 319

This section describes general troubleshooting tips when dealingwith ClearPass issueswith Policy Enforcer.
For detailed information on troubleshooting ClearPass and ClearPass logs, see your ClearPass
documentation.
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Viewing Logs Files

Policy Enforcer writes third-party plug-in log information to /srv/3rd-party-adapter/logs/plugin_server.log
using the following format:

[<date><time>:<line number>:<function name>:<level>]<detailed message>

Three types of information are recorded in the logs:

• Application initialization information.

• Heart-beat with Policy Enforcer—communication status between Policy Enforcer and the third-party
plug-in.

• Application operations—for troubleshooting third-party plug-in functionality.

The default logging level is set to DEBUG.

The following is an example of a heart-beat message log:

[07/20/2017 04:21:59 PM:_internal.py:87:_log():INFO ] 10.92.82.125 - - [20/Jul/2017

 16:21:59] "GET /api/v1/adaptor/heartbeat HTTP/1.1" 200 -

[07/20/2017 04:22:29 PM:produces.py:117:wrapper():DEBUG ] Jsonifing 

http://10.92.82.125:8082/api/v1/adaptor/heartbeat

[07/20/2017 04:22:29 PM:parameter.py:90:wrapper():DEBUG ] Function Arguments: []

The following is an example of an application operation log:

[07/20/2017 05:45:52 PM:default_controller.py:228:adaptor_threats_post():DEBUG ] 

Incoming threat POST request: {u'action': u'block', u'threatType': u'InfectedHost',

 u'endpoint': {u'macAddress': u'unknown', u'ip': u'192.168.140.20', u'name': u'',

 u'tags': []}}

[07/20/2017 05:45:52 PM:track_endpoint.py:27:__init__():INFO ] Creating new infected

 host tracking DB.

[07/20/2017 05:45:52 PM:clearpass_agent.py:66:getApiAuthenticationToken():DEBUG ]

 Get Oauth2 access token for API client

[07/20/2017 05:45:52 PM:connectionpool.py:805:_new_conn():INFO ] Starting new HTTPS

 connection (1): 10.92.81.112

[07/20/2017 05:45:52 PM:connectionpool.py:401:_make_request():DEBUG ] "POST 

/api/oauth HTTP/1.1" 200 116

[07/20/2017 05:45:52 PM:clearpass_agent.py:73:getApiAuthenticationToken():INFO ] 

Successful get Oauth2 access token
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[07/20/2017 05:45:52 PM:thirdparty_controller.py:84:infectedHostNotif():DEBUG ] 

Validating endpoint [192.168.140.20] against Clearpass Endpoint DB

[07/20/2017 05:45:52 PM:clearpass_agent.py:80:getEndpointDataByIp():DEBUG ] Getting

 Endpoint detail by IP Address [192.168.140.20]

...

You can also access logswithin ClearPass PolicyManager and ClearPass Guest to assist in troubleshooting.

• Checking session logs

The Access Tracker window displays information of per-session access activity. To view this activity,
selectMonitoring > Access Tracker within ClearPass Policy Monitor. See Figure 82 on page 316.

Figure 82: Checking Session Logs

Click a session in the table to display the Request Details window with details about that session. Click
Show Logs to view the log details. Change your log level to view more or less session information.

• Errors reported by ClearPass
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To view events and messages generated by the ClearPass application, select Administration > Support
> Application Log within ClearPass Guest. See Figure 83 on page 317.

Figure 83: Viewing ClearPass Errors

Click an event to view details, such as possible causes for that error or a pointer for where to look for
more information.

Configuration Issues

The following are mandatory ClearPass information that must be passed to the Policy Enforcer third-party
plug-in to ensure proper communication:

• ClearPass IP address and port number.

• Client ID (clientId) for the API to access (configured with ClearPass Guest module).

• Client secret key, used together with clientId to obtain the access token for performing REST API calls
to the ClearPass server.

If you see a 404 error with “ClearPass configuration is missing” in the log file, then ClearPass is not
configured for Policy Enforcer. See “ClearPass Configuration for Third-Party Plug-in” on page 105 for
information on configuring ClearPass with Policy Enforcer.

Another method for checking whether ClearPass is configured for Policy Enforcer is to look for the
/srv/3rd-party-adapter/configuration.yaml file. If this file exists, then the configuration step has been
performed.
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Error Code 500

If you receive an error code 500 with the log message There are no sessions to display. You should enable
Insight on at least one node in Policy Manager: Administration > Server Manager > Server Configuration
then the configured ClearPass server does not have Insight enabled. ClearPass Insight is used by ClearPass
Policy Manager for in-depth reporting and enhanced analytics.

To enable ClearPass Insight, selectAdministration > ServerManager > Server Configuration fromClearPass
Policy Manager. Click the ClearPass server and enable Insight. See Figure 84 on page 318.

Figure 84: Enabling ClearPass Insight

Unable to Block Infected Endpoint

If you are unable to block an infected endpoint, perform the following tasks:

• Validate the IP address using ClearPass API Explorer: Insight API, Endpoint service, then issue GET
/insight/endpoint/ip/{ip}

• Validate the corresponding active session using ClearPass API Explorer: GuestManager API, ActiveSession
service, then issue GET /session with corresponding “framedipaddress” equals to the infected endpoint’s
IP address, and sorted by “accstarttime” in order to ensure that themost recent active sessions associated
with the IP are displayed first. If there is no current active session returned, the IP address passed down
to the plug-in to block is invalid or does not existed.

• If the IP address is valid, confirm that the custom attribute sdsnEpStatus has been set accordingly to
the value ‘blocked’, using ClearPass API Explorer’s Endpoint API, Managed Endpoint services by issuing
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the API GET /endpoint/mac-address/{mac-address} ,with {mac-address} of the endpoint obtained from
the output of the active session query issued earlier.

• Custom attribute sdsnEpStatus can also be verified looking into the corresponding session in ClearPass
Policy Manager’s Access Tracker, in Input tab, “Compute Attributes” section.

Unable to Quarantine Infected Endpoint

If you are unable to quarantine an infected endpoint, first validate the IP address of the infected host
following the same procedure as in the Unable to Block Infected Endpoint topic above. Next, verify that
the value of the custom attribute sdsnEpStatus has been set to quarantine.

Unable to Clear Blocked or Quarantined Endpoint

If you are unable to clear blocked or quarantined endpoints, it’s usually because the passing IP address
does not exist in the infected endpoint tracking database maintained by the plug-in. Infected hosts are
located in the /srv/3rd-party-adapter/infectedEndpointList file. It is expected that a clear request will
come with the same IP address of the endpoint as in the earlier blocked or quarantined endpoint request.
If the clear request arrives with a new IP address that is not in the infected endpoint tracking database,
the request fails.

Also, check the ClearPass application log for possible internal errors.
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Moving From Spotlight Secure to Policy Enforcer

IN THIS SECTION

Spotlight Secure and Policy Enforcer Deployment Comparison | 321

License Requirements | 322

Sky ATP and Spotlight Secure Comparison Table | 322

Migrating Spotlight Secure to a Policy Enforcer Configuration Overview | 323

Installing Policy Enforcer | 324

Configuring Advanced Threat Prevention Features: Spotlight Secure/Policy Enforcer Comparison | 330

The Spotlight Secure Threat Intelligence Platform aggregates threat feeds frommultiple sources to deliver
open, consolidated, actionable intelligence to SRX Series Devices across an organization. This product is
now superseded by the Juniper Connected Security Policy Enforcer. The Juniper Connected Security
framework delivers enhanced security from external as well as internal attacks by leveraging both security
as well as network devices as a coherent security system.

Policy Enforcer is an orchestration solution that orchestrates user intent policy enforcement for threat
remediation as well as micro-segmentation across the entire network. This document talks about the
logistics of migrating from Spotlight Secure to Policy Enforcer.

Spotlight Secure and Policy Enforcer with Sky ATP are two different platforms and therefore a direct
migration of threat policies from Spotlight Secure to Policy Enforcer is not supported. Instead it is
recommended that you remove Spotlight Connector from your Space Fabric and remove threat related
configurations on Security Director before you install Policy Enforcer. Then you will need to reconfigure
your data and threat feeds. The following sections provide an overview of the transition process from
Spotlight Secure to Policy Enforcer with Sky ATP.

Spotlight Secure and Policy Enforcer Deployment Comparison

The function of Spotlight Secure connector, to bring together all the available threat intelligence andmake
it available to security policies, is now done via Policy Enforcer with Sky ATP. In addition, Policy enforcer
is a key part of the Juniper Connected Security Solution.

Spotlight Secure was installed to a separate virtual machine and then added as a specialized node to the
Junos Space Fabric on Junos Space until version 15.1. Policy Enforcer is shipped as a virtual machine that
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is deployed independently. Instead of adding the new VM as a Junos Space node, the configuration has
been simplified with a workflow using the Security Director user interface.

NOTE: Spotlight Secure supported a HA deployment. The current version of Policy Enforcer is
supported only as a single stand-alone deployment.

License Requirements

For existing Spotlight Secure customers, no new additional license is needed. If you have a Spot-CC license,
it can be used with Policy Enforcer and Sky ATP as well. A Policy Enforcer license would only be needed
if youwant to use the complete set of Juniper Connected Security featureswith SkyATP. Juniper Connected
Security/Policy Enforcer features includes all threat prevention types: C&C, infected hosts, malware, GeoIP,
and policy management and deployment features such as secure fabric and threat prevention policies. See
“Features By Sky ATP Configuration Type” on page 36 for more details.

Sky ATP and Spotlight Secure Comparison Table

The following table provides a product comparison:

Table 84: SKY ATP and Spotlight support Quick Summary

Workflow using Sky ATP, Security
Director and Policy Enforcer

Support with Policy
Enforcer and SkyATP

Support in Spotlight
SecureFeature

• Create a Realm in Sky ATP if you do
not already have one

• Configure Policy Enforcer in Cloud
feed only or Sky ATP or Sky ATP with
Juniper Connected Security modes to
connect to the realm

• Configure a Threat Prevention Profile
using Command and Control options

• Use this Threat Prevention Profile in
Firewall Policy

Fully SupportedFully SupportedCommand andControl
Feed
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Table 84: SKY ATP and Spotlight support Quick Summary (continued)

Workflow using Sky ATP, Security
Director and Policy Enforcer

Support with Policy
Enforcer and SkyATP

Support in Spotlight
SecureFeature

• Create a Realm in Sky ATP if you do
not already have one

• Configure Policy Enforcer Setting in
Sky ATP mode

• Create a Custom Feed using Blocklist,
Allowlist or Dynamic address options
selecting static IP or file options

Blocklist, Allowlist,
Infected Host, and
Dynamic Address
features are fully
supported

Blocklist, Allowlist and
Dynamic Address
features are fully
supported.

Custom Feeds

Sky ATP supports an Infected Host feed,
natively integrated with Policy Enforcer
and Security Director.

Sky ATP supports an
Infected Host feed,
natively integrated with
Policy Enforcer and
Security Director.

Not directly
supported by
Spotlight. You must
create custom feeds

Infected Host

Sky ATP supports an Infected Host feed
which is natively integrated with Policy
Enforcer. Policy Enforcer can take
block/quarantine actions at the switch
port level.

Sky ATP supports an
Infected Host feed
which is natively
integrated with Policy
Enforcer. Policy
Enforcer can take
block/quarantine
actions at the access
network level.

NOTE: This requires a
Policy Enforcer license
and does not comewith
a SPOT_CC license.

Not supported using
Spotlight and Security
Director

Infected Host
Remediation at the
Access Network level

Migrating Spotlight Secure to a Policy Enforcer Configuration Overview

In this section, there is a side by side comparison of feature configuration for Spotlight Secure on Security
Director 15.1 and Policy Enforcer on Security Director 16.1 and higher to aid in re-configuring your threat
policies.
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This is an overview of the tasks needed to migrate:

1. Document the current data and feed configuration from current version of Security Director.

2. Remove Spotlight Connector from your Junos Space Fabric and remove the threat prevention
configuration.

3. Upgrade to the latest versions of Junos Space and Security Director.

NOTE: Since the underlying operation system is upgraded to Centos6.8 on Junos Space
version 16.1, first upgrade Junos Space and applications to 15.2R2 and then follow the
documentation to restore the database before deploying 16.1 or higher. Please refer to the
Junos Space 16.1 release notes for details.

4. Deploy the Policy Enforcer virtual machine. See instructions in the following section.

5. Deploy Security Director and install Policy Enforcer to Security Director.

6. Configure a Sky ATP realm and enroll SRX Series devices into the realm. For all deployment models, it
is necessary to configure a Sky realm and enroll firewalls.

7. Configure feeds and threat policies.

Installing Policy Enforcer

Policy Enforcer provides centralized, integrated management of all your security devices (both physical
and virtual), allowing you to combine threat intelligence from different solutions and act on that intelligence
from one management point. Using Policy Enforcer and the intelligence feeds it offers through Sky ATP,
you can create threat prevention policies that provide monitoring and actionable intelligence for threat
types such as known malware, command and control servers, infected hosts, and Geo IP-based server
data.
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Policy enforcer is shipped as a OVA file that should be deployed over VMware ESX.
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1. Download the Policy Enforcer virtualmachineOVA image from the JuniperNetworks software download
page. It is recommended to deploy Policy Enforcer on the same ESX server as Junos Space.
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NOTE: Do not change the name of the Policy Enforcer virtual machine image file that you
download from the Juniper Networks support site. If you change the name of the image file,
the creation of the Policy Enforcer virtual machine can fail.

Figure 85: Deploy Policy Enforcer OVF File 1

Figure 86: Deploy Policy Enforcer OVF File 2
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NOTE: See “Deploying and Configuring the Policy Enforcer with OVA files” on page 44 for
the complete Policy Enforcer installation documentation.

2. Initial configuration is done through the console. In addition to network and host configuration, you
must set a customer ID and reset the root password. The default login to Policy Enforcer is Username:
root,Password: abc123
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Figure 87: Policy Enforcer Configuration Summary

3. Once Policy Enforcer is deployed, it must be added to Security Director via Security Director User
Interface. From the Security Director UI, navigate to Administration > Policy Enforcer > Settings.

NOTE: Unlike Spotlight Secure, Policy Enforcer does not need to be added to Junos Space
Fabric. The addition is done only through the Security Director UI.

4. On the Settings page, there three Sky ATP Configuration Types to choose from.

• Sky ATP with Juniper Connected Security—All Policy Enforcer features and threat prevention types
are available

• Sky ATP—All threat prevention types are available: Command and control server, Geo IP, and Infected
hosts.

• Cloud feeds only—Command and control server and Geo IP are the only threat prevention types
available.

• No selection (No Sky ATP)—You can choose to make no selection. When you make no selection,
there are no feeds available from Sky ATP, but the benefits of Secure Fabric, Policy Enforcement
Groups, and Threat Prevention policies provided by Policy Enforcer are available. Infected hosts is
the only prevention type available
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NOTE: You can switch from Cloud feeds only to Sky ATP, or SKY ATP to SKY ATP with
Juniper Connected Security, but the reverse is not supported.

NOTE: If you upgrade fromCloud feeds only to SkyATP, you cannot roll back again. Upgrading
resets all devices previously participating in threat prevention, and you must re-enroll them
with Sky ATP. This is true for upgrading from Sky ATP to SKY ATP with Juniper Connected
Security. “SKY ATP with Juniper Connected Security” is for the Juniper Connected Security
solution and not covered in this section.

NOTE: See “Sky ATP Configuration Type Overview” on page 33 for the Policy Enforcer
documentation on this topic.

NOTE: Policy Enforcer with Sky ATP does not support a workflow for removing Policy Enforcer.
To switch to a different Policy Enforcer, replace the IP and login information in the Policy Enforcer
settings page.

ConfiguringAdvanced Threat Prevention Features: Spotlight Secure/Policy
Enforcer Comparison

The following section is a side by side comparison of how advanced threat prevention features were
configured on Spotlight Secure compared to how they are configured with Policy Enforcer.

Configuring Command and Control and Infected Host
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Spotlight Secure: C&C and Infected Host

This is how C&C and infected host feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Under Security intelligence > Information Source, click + to add a new information source. Select
Spotlight Secure Cloud as source.

Figure 88: Spotlight Secure: Add Information Source

2. Create a Security Intelligence profile from Security intelligence > Profiles . Choose Command and
Control as the feed category and set the Blocking threshold. Configure Block Options and Logging.
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Figure 89: Spotlight Secure: Create Security Intelligence Profile

3. Complete the workflow to create a profile.

Figure 90: Spotlight Secure: Create Profile

4. Create a security intelligence policy.

332



Figure 91: Spotlight Secure: Create Security Intelligence Policy

5. Apply the security intelligence policy to a firewall policy.

Figure 92: Spotlight Secure: Apply Security Intelligence Policy to Firewall Policy
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Policy Enforcer with Sky ATP: C&C and Infected Host

This is how C&C and infected host feeds are configured on Security Director 16.1 and higher with Policy
Enforcer:

NOTE: Policy Enforcer can be configuredwith Sky ATP or Cloud feeds only to enable Command
and Control feeds. The following instructions are for Cloud feeds only.

NOTE: In addition to the instructions provided here, Threat Prevention Guided Setup under
Configuration >Guided Setup >Threat Prevention can be leveraged for awizard drivenworkflow.

1. Configure a Sky ATP Realm by navigating to Configure > Threat Prevention > Sky ATP Realms. Click
+ to create a realm.

(You must have a Sky ATP account to configure a realm. If you do not have an account please click on
the link provided in the Sky ATPRealmwindow to create one at the Sky ATP account page. See “Creating
Sky ATP Realms and Enrolling Devices or Associating Sites” on page 159 for details).

NOTE: You do not need a Sky ATP premium license to create an account or realm.

2. Once the Sky ATP realm is created, add a policy by navigating to Configure > Threat Prevention >
Policies. Click + to create a policy. Enable the check box to Include C&C profile in policy and set threat
score thresholds, actions, and logging.
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Figure 93: Policy Enforcer: Create Threat Prevention Policy

Figure 94: Policy Enforcer: Create Threat Prevention Policy, Select Threat Score and Logging

3. Apply the threat prevention policy to a firewall policy.
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Figure 95: Policy Enforcer: Apply Threat Prevention Policy to Firewall Policy

4. Publish, verify the configuration and update to the firewall.

Figure 96: Policy Enforcer: Update Firewall Policy
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NOTE: If Sky ATP is chosen as the Sky ATP Configuration Type under Administration >
Policy Enforcer > Settings, theworkflow remains the same, but additional parameters become
available for configuring anti-malware.

Configuring Custom Feeds

Spotlight Secure: Custom Feeds

This is how custom feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Create an information source by navigating to Security Intelligence > Information Source . Click + to
add a source. (Note that WebApp Secure is no longer supported.)

Figure 97: Spotlight Secure: Add Information Source

2. Upload from a custom file. Select Source as Custom File Upload and point to a local file.
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Figure 98: Spotlight Secure: Configure Custom File Upload

3. Configure a periodic upload from a remote file server. Provide the full URL to the plain text file you
want to poll and enter server login information, Username and Password.

Figure 99: Spotlight Secure: Enter Server Login for Custom File Upload
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4. Create a dynamic object by navigating to Security Intelligence > Dynamic Address Group. Configure
the feed as the custom feed that was created in the previous step.

Figure 100: Spotlight Secure: Select Custom Feed in Dynamic Address Group

5. Use the dynamic object in a security policy.
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Figure 101: Spotlight Secure: Select Dynamic Address in Security Policy

6. Configure a custom feed as an allowlist or blocklist by navigating to Security Intelligence > Profiles.
Edit Global White List or Global Black List to add a custom feed created in the previous steps.

Figure 102: Spotlight Secure: Edit Global Whitelist or Blacklist
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Policy Enforcer with Sky ATP: Custom Feeds

This is how custom feeds are configured on Security Director 16.1 and higher with Policy Enforcer:

NOTE: In addition to the instructions provided here, Threat Prevention Guided Setup under
Configuration >Guided Setup >Threat Prevention can be leveraged for awizard drivenworkflow.

Policy Enforcer supports manually adding or uploading custom feed information from a file server. The
custom feed can be a dynamic object, infected hosts list, allowlist or blocklist which can then be used
within the match criteria of a firewall rule.

1. Create Custom Feeds by navigating to Configure > Threat Prevention > Custom Feeds. Click + to
create a new feed.

2. Provide a Name and Description for the custom feed and choose the tab for the type of feed:Dynamic
Address, Blacklist,Whitelist or Infected Host.

Figure 103: Policy Enforcer: Configure Custom Feed

3. Manually configure the IP list or upload it from a local file. The IP list can be defined as individual IP
addresses, IP address ranges, or subnets. See “Creating Custom Feeds” on page 219 for complete details.

341



NOTE: Dynamic objects can be used within a firewall policy to match criteria as a source or
destination address object.

NOTE: Policy Enforcer supports only cloud based C&C feeds and not custom C&C feeds.
Policy Enforcer APIs can be used to extend this functionality.

4. Upload a local file. Select the Upload file option in the right corner of the page.

Figure 104: Policy Enforcer: Upload Custom File

5. If you have configured an allowlist, downloads from those IP addresses are considered trusted. For
blocklists, all downloads from those IP addresses are blocked. Dynamic objects can be used within a
firewall policy match criteria as a source or destination address object.

342



Figure 105: Policy Enforcer: Use Dynamic Addresses in Firewall Policy

Configuring Geo IP

Spotlight Secure: Geo IP

This is how Geo IP feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Create a GeoIP object under dynamic object by navigating to Security Intelligence >Dynamic Address
Group. Select the feed as GeoIP and pick the countries from the drop down list.
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Figure 106: Spotlight Secure: Create Geo IP with Dynamic Address Group

2. Use the Geo IP object in a firewall policy.

Figure 107: Spotlight Secure: Use Geo IP in Firewall Policy

344



Policy Enforcer with Sky ATP: Geo IP

This is how Geo IP feeds are configured on Security Director 16.1 and higher with Policy Enforcer:

1. Define GeoIP objects that can then be used within the match criteria of a firewall policy by navigating
to Configure > Shared Objects > Geo IP. Create a Geo IP feed and choose countries to include from
the list.(This feature requires a SecIntel or SKY ATP license.)

Figure 108: Policy Enforcer: Create Geo IP

2. Use the Geo IP feed you created as the source or destination address in a firewall policy.
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Figure 109: Policy Enforcer: Use Geo IP in the Firewall Policy
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